THE LITTLE MAC BOOK

Perfect Companion to Award-Winning The Big Mac Book, 2nd Edition!

Ideal Macintosh Pocket Reference Covers System 7
The Little Mac Book.

Copyright® 1991 by Que® Corporation.

All rights reserved. Printed in the United States of America. No part of this book may be used or reproduced in any form or by any means, or stored in a database or retrieval system, without prior written permission of the publisher except in the case of brief quotations embodied in critical articles and reviews. Making copies of any part of this book for any purpose other than your own personal use is a violation of United States copyright laws. For information, address Que Corporation, 11711 N. College Ave., Carmel, IN 46032.

Library of Congress Catalog No.: 90-063261
ISBN 0-88022-651-x

This book is sold as is, without warranty of any kind, either express or implied, respecting the contents of this book, including but not limited to implied warranties for the book's quality, performance, merchantability, or fitness for any particular purpose. Neither Que Corporation nor its dealers or distributors shall be liable to the purchaser or any other person or entity with respect to any liability, loss, or damage caused or alleged to be caused directly or indirectly by this book.

94 93 92 91 4 3 2 1

Interpretation of the printing code: the rightmost double-digit number is the year of the book's printing: the rightmost single-digit number, the number of the book's printing. For example, a printing of 91-1 shows that the first printing of the book occurred in 1991.

The procedures in this book apply to all Apple Macintosh computers.

Trademark Acknowledgments: Que Corporation has made every effort to supply trademark information about company names, products, and services mentioned in this book. Trademarks indicated below were derived from various sources. Que Corporation cannot attest to the accuracy of this information.

Aldus and PageMaker are registered trademarks and FreeHand is a trademark of Aldus Corporation. The following products are trademarks of Apple Computer, Inc.: AppleEvents, AppleScript, QuickDraw, ResEdit, SuperDrive, and TrueType. The following products are registered trademarks of Apple Computer, Inc.: Apple, AppleShare, AppleTalk, Font/DA Mover, HyperCard, HyperTalk, ImageWriter, LaserWriter, LocalTalk, Mac LC, Mac SE, Mac SE/30, Mac II, Mac IIx, Mac Plus, Mac IIgs, Mac IIci, Mac IIci, Mac IIx, Mac, Macintosh, MultiFinder, and the Apple logo. Claris, FileMaker, MacDraw, MacWrite, and MacPaint are registered trademarks of Claris Corporation. Classic is a registered trademark, licensed to Apple Computer, Inc. Microsoft Excel, Microsoft Word, and Microsoft Works are registered trademarks of Microsoft Corporation. PostScript is a registered trademark, and Adobe Illustrator, Adobe Type Manager, Photoshop, ATM, and Type Reunion are trademarks of Adobe Systems Incorporated. QuarkXPress is a registered trademark of Quark, Inc. SAM II and SUM II are trademarks and the Norton Utilities is a registered trademark of Symantec Corporation. SuperPaint is a trademark of Silicon Beach Software Incorporated, a subsidiary of Aldus Corporation. WordPerfect is a registered trademark of WordPerfect Corporation. WriteNow is a registered trademark of T/Maker Company.
Dedication

In memory of Betty Burglass with an appreciation for telling me the right thing to do.

Acknowledgments

I owe a great deal of thanks to Bill Gladstone and Karen Bluestein, both of whom gave me the opportunity to complete this project. I'm especially grateful to Cheri Robinson, Que Senior Production Editor, who took my words, and with great care and attention to detail, made them into a book.
# Table of Contents

## INTRODUCTION .................................................................................. 1
- How This Book Is Different .................................................. 1
- What’s In This Book ................................................................. 2
- How To Use This Book ............................................................... 3

## MACINTOSH TOPICS ................................................................ 4
- Alarm Clock ................................................................. 4
- Alert Boxes ................................................................. 5
- Alignment ........................................................................... 6
- AppleShare ........................................................................ 7
- AppleTalk .......................................................................... 8
- ATM .................................................................................. 9
- Backups ........................................................................... 10
- Battery .............................................................................. 14
- Beeps .................................................................................. 16
- Bulletin Boards ..................................................................... 18
- Buying Hardware ............................................................... 18
- Buying Software ................................................................. 20
- Calculator ........................................................................... 22
- CDEVs ............................................................................... 23
- Centering Text .................................................................. 25
- Chooser ............................................................................. 27
- Clip Art .............................................................................. 28
- Clipboard ........................................................................... 31
- Clock .................................................................................. 32
- Close Box ........................................................................... 33
- Color .................................................................................. 34
- Control Panel ..................................................................... 36
- Copying ............................................................................... 38
- Correcting Typos .................................................................. 40
- Crashes ............................................................................... 42
- Cutting ............................................................................... 46
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Conversion</td>
<td>47</td>
</tr>
<tr>
<td>Database Programs</td>
<td>48</td>
</tr>
<tr>
<td>Deleting Files</td>
<td>49</td>
</tr>
<tr>
<td>Desk Accessories</td>
<td>51</td>
</tr>
<tr>
<td>Desktop</td>
<td>53</td>
</tr>
<tr>
<td>Desktop Publishing</td>
<td>55</td>
</tr>
<tr>
<td>Dialog Box</td>
<td>56</td>
</tr>
<tr>
<td>Disk Drives</td>
<td>58</td>
</tr>
<tr>
<td>Disks</td>
<td>60</td>
</tr>
<tr>
<td>DPI</td>
<td>62</td>
</tr>
<tr>
<td>Draw Programs</td>
<td>62</td>
</tr>
<tr>
<td>Duplicating</td>
<td>63</td>
</tr>
<tr>
<td>Ejecting Disks</td>
<td>64</td>
</tr>
<tr>
<td>E-Mail</td>
<td>65</td>
</tr>
<tr>
<td>Erasing Disks</td>
<td>66</td>
</tr>
<tr>
<td>Error Messages</td>
<td>67</td>
</tr>
<tr>
<td>File Compression</td>
<td>67</td>
</tr>
<tr>
<td>File Formats</td>
<td>68</td>
</tr>
<tr>
<td>Files</td>
<td>72</td>
</tr>
<tr>
<td>Financial Programs</td>
<td>80</td>
</tr>
<tr>
<td>Find File</td>
<td>81</td>
</tr>
<tr>
<td>Finder</td>
<td>83</td>
</tr>
<tr>
<td>Fkeys</td>
<td>84</td>
</tr>
<tr>
<td>Folders</td>
<td>85</td>
</tr>
<tr>
<td>Font/DA Mover</td>
<td>87</td>
</tr>
<tr>
<td>Fonts</td>
<td>91</td>
</tr>
<tr>
<td>Games</td>
<td>95</td>
</tr>
<tr>
<td>Get Info</td>
<td>96</td>
</tr>
<tr>
<td>Graphics Programs</td>
<td>98</td>
</tr>
<tr>
<td>Help</td>
<td>99</td>
</tr>
<tr>
<td>Highlighting Text</td>
<td>101</td>
</tr>
<tr>
<td>HyperCard</td>
<td>103</td>
</tr>
<tr>
<td>Icons</td>
<td>104</td>
</tr>
<tr>
<td>ImageWriter</td>
<td>105</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Initializing Disks</td>
<td>106</td>
</tr>
<tr>
<td>INITs</td>
<td>108</td>
</tr>
<tr>
<td>Inserting a Disk</td>
<td>110</td>
</tr>
<tr>
<td>Installing Software</td>
<td>111</td>
</tr>
<tr>
<td>Keyboard</td>
<td>114</td>
</tr>
<tr>
<td>Keyboard Shortcuts</td>
<td>115</td>
</tr>
<tr>
<td>Key Caps</td>
<td>116</td>
</tr>
<tr>
<td>LaserWriter</td>
<td>117</td>
</tr>
<tr>
<td>Launching Applications</td>
<td>119</td>
</tr>
<tr>
<td>Locking</td>
<td>120</td>
</tr>
<tr>
<td>Macintosh Systems</td>
<td>121</td>
</tr>
<tr>
<td>Macros</td>
<td>126</td>
</tr>
<tr>
<td>Mail Order</td>
<td>127</td>
</tr>
<tr>
<td>Maintenance</td>
<td>128</td>
</tr>
<tr>
<td>Menus</td>
<td>129</td>
</tr>
<tr>
<td>Modems</td>
<td>132</td>
</tr>
<tr>
<td>Monitors</td>
<td>133</td>
</tr>
<tr>
<td>Mouse</td>
<td>134</td>
</tr>
<tr>
<td>Mouse Pads</td>
<td>139</td>
</tr>
<tr>
<td>MultiFinder</td>
<td>139</td>
</tr>
<tr>
<td>Networking</td>
<td>144</td>
</tr>
<tr>
<td>Note Pad</td>
<td>144</td>
</tr>
<tr>
<td>OCR</td>
<td>146</td>
</tr>
<tr>
<td>Opening Files</td>
<td>147</td>
</tr>
<tr>
<td>Orientation</td>
<td>148</td>
</tr>
<tr>
<td>Page Setup</td>
<td>149</td>
</tr>
<tr>
<td>Paper</td>
<td>151</td>
</tr>
<tr>
<td>Pasting</td>
<td>152</td>
</tr>
<tr>
<td>Peripherals</td>
<td>153</td>
</tr>
<tr>
<td>PMMU</td>
<td>154</td>
</tr>
<tr>
<td>PostScript</td>
<td>155</td>
</tr>
<tr>
<td>Print Monitor</td>
<td>156</td>
</tr>
<tr>
<td>Print Spooler</td>
<td>156</td>
</tr>
<tr>
<td>Printers</td>
<td>157</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Printing</td>
<td>158</td>
</tr>
<tr>
<td>Programmer's Switch</td>
<td>163</td>
</tr>
<tr>
<td>QuickDraw</td>
<td>163</td>
</tr>
<tr>
<td>Quitting</td>
<td>164</td>
</tr>
<tr>
<td>RAM</td>
<td>165</td>
</tr>
<tr>
<td>RAM Cache</td>
<td>167</td>
</tr>
<tr>
<td>Rebuilding the Desktop</td>
<td>169</td>
</tr>
<tr>
<td>Recovering Data</td>
<td>170</td>
</tr>
<tr>
<td>ResEdit</td>
<td>171</td>
</tr>
<tr>
<td>Restarting</td>
<td>173</td>
</tr>
<tr>
<td>Saving</td>
<td>174</td>
</tr>
<tr>
<td>Scanning</td>
<td>176</td>
</tr>
<tr>
<td>Scrapbook</td>
<td>177</td>
</tr>
<tr>
<td>Screen Dump</td>
<td>179</td>
</tr>
<tr>
<td>Screen Saver</td>
<td>180</td>
</tr>
<tr>
<td>Scrolling</td>
<td>181</td>
</tr>
<tr>
<td>SCSI</td>
<td>182</td>
</tr>
<tr>
<td>Searching</td>
<td>183</td>
</tr>
<tr>
<td>Set Startup</td>
<td>184</td>
</tr>
<tr>
<td>Shut Down</td>
<td>185</td>
</tr>
<tr>
<td>SIMMs</td>
<td>186</td>
</tr>
<tr>
<td>Size Box</td>
<td>188</td>
</tr>
<tr>
<td>Special Characters</td>
<td>189</td>
</tr>
<tr>
<td>Spreadsheet Programs</td>
<td>192</td>
</tr>
<tr>
<td>Startup Screen</td>
<td>193</td>
</tr>
<tr>
<td>System</td>
<td>194</td>
</tr>
<tr>
<td>Telecommunications</td>
<td>197</td>
</tr>
<tr>
<td>Trash Can</td>
<td>198</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>201</td>
</tr>
<tr>
<td>Undo</td>
<td>206</td>
</tr>
<tr>
<td>Upgrading</td>
<td>207</td>
</tr>
<tr>
<td>Utilities</td>
<td>208</td>
</tr>
<tr>
<td>Viewing Files</td>
<td>208</td>
</tr>
<tr>
<td>Virtual Memory</td>
<td>210</td>
</tr>
</tbody>
</table>
Viruses .......................................................... 211
Windows .............................................................. 213
Word Processing Programs .......................... 215
Zoom Box .............................................................. 216

SYSTEM 7 FIRST LOOK ........................................... 217
What's New With System 7 .......................... 217
Should You Get System 7? .......................... 218
How Do You Get System 7? .......................... 219
What Do You Need to Run System 7? .................. 220
System 7 vs. System 6 ........................................... 220

SYSTEM 7 TOPICS ..................................................... 223
Aliases ................................................................. 223
Apple Menu .......................................................... 224
AppleScript .......................................................... 225
CDEVs ................................................................. 225
Control Panels ..................................................... 226
Database Access Manager ......................... 228
Desk Accessories ................................................. 228
Desktop ............................................................... 229
Empty Trash .......................................................... 230
Extensions ............................................................ 230
FileShare ............................................................... 230
Finding Files .......................................................... 231
Finder ................................................................. 233
Folders ................................................................. 233
Font/DA Mover ....................................................... 235
Fonts ................................................................. 235
Help ................................................................. 236
IAC ................................................................. 237
Installation ......................................................... 237
Labels ................................................................. 239
All the neat things you can do with your Mac can become overwhelming at times! How can you possibly remember everything from how to type a • (bullet) to what's the difference between the Save and Save As commands?

How often do you ask yourself...

How do I get my document to print... Do I check the Control Panel? Is it the Chooser that affects printing...How do I copy a new typeface onto my system? Should I use the Font/DA Mover? How do I save that make-or-break-my-career document to a floppy disk to take home? What is data conversion? I keep hearing about it. Is it something that I should know about? And System 7. Should I avoid it like the plague? Should I wait?

You can wait. Or, you can read The Little Mac Book.

What you're looking for is right here at your fingertips. No more dragging out the documentation or seeking out the company Mac-head. No more scary trial-and-error attempts. OK, well maybe some trial-and-error, but less of it...

---

How This Book Is Different

The Little Mac Book is unique for several reasons:

- It's little.
- It's convenient.
- It's concise.
- It's versatile.
- It's task-oriented.

Never mind bits and bytes—how do you make things happen?
The Little Mac Book is a quick reference guide to the Macintosh family of computers. This book helps you learn the skills you need to get more out of any Mac. Because this book is organized alphabetically, it enables you to locate information quickly on many aspects of the Macintosh computer.

The Little Mac Book is organized into five parts.

- The first section, "Macintosh Topics," discusses important terms and concepts so that you can get your Mac to do what you want it to do.

- The second section, "System 7 First Look," gets you started with Apple's new operating system.

- The third section, the "Quick Key Guide," tells you how to make all those neat characters—from bullets to shadow boxes. The guide then lists the important keyboard shortcuts for some of the major Macintosh applications.

- The fourth section contains an informative glossary of common Macintosh terms.

- The final section, the index, provides an extensive cross-reference of topics.
Introduction

How To Use This Book

The Little Mac Book is organized so that you easily can find the topic you want. Entries appear in alphabetical order. If you have a topic such as copying, look under C. For startup screen, look under S. (You get the idea.) To find out what System 7 brings, refer to the second part of the book. To create a registered trademark symbol, ®, consult the Special Characters section of the “Quick Key Guide.” To see how to align text using Filemaker Pro, look under Program-Specific section of the “Quick Key Guide.” As you read this book and find terms with which you are not familiar, consult the glossary. The comprehensive index provides a further detailed guide to the topics contained in this book.

Using a Macintosh computer is easy, and the conventions chosen for this book reflect the ease of operation.

Keystrokes you must type and menus you select appear in boldfaced blue type. With many Macintosh commands, you press and hold one key and then press another key. For example, you press and hold the Command key (⌘) and press the S key to save. In this book, the operation is presented as ⌘-S.

Almost everything you read about in this book applies to every Macintosh. To learn more about any feature or topic in this book, consult The Big Mac Book, 2nd Edition, also published by Que Corporation.

Good luck, take your time, and have fun!
MACINTOSH TOPICS

The following section contains a listing of major topics related to owning and operating a Macintosh computer. The topics are listed alphabetically so that you easily can find the information you need. In addition, cross-references are provided so that you can find information of additional interest. Although you may want to browse through this entire section, feel free to start with any topic.

Alarm Clock

Located under the Apple ⌘ menu, this desk accessory displays an on-screen clock. The Mac retains Alarm Clock information when you turn off the power as long as you have a working battery in your computer. The clock provides the time, the date, and an alarm. Like other desk accessories, the Alarm Clock is available at any time while you are using your Mac.

To change the Alarm Clock settings

1. From the Apple ⌘ menu, select Alarm Clock.

2. Click on the toggle switch on the right side of the Alarm Clock (see fig. A.1). (The toggle switch opens a closed box and closes and open box.)

3. Click on the appropriate icon for the clock, the alarm, or the date.

4. Click on a specific time, date, or alarm setting in the middle panel. A small set of arrows appears to the right of the current setting.

5. Click the up arrow to advance the setting or the down arrow to retard it. You also can type any new information.
6. To activate the alarm setting, click on the switch to the left in the middle panel. The alarm clock should resemble the flashing alarm clock in Figure A.1.

7. When you finish changing the settings, click the small toggle lever to the right in the top panel and click the close box.

**Notes**

You can set only one alarm. If the time set for the alarm passes when your Mac is turned off, you hear the alarm beep the next time you turn on your Mac. If the sound is set to zero, the menu bar flashes. The apple in the menu bar flashes until you open the Alarm Clock from the Apple menu.

See also *Clock* and *Desk Accessories*.

### Alert Boxes

You will make mistakes, but your Mac does everything it can to prevent you from making them. The Alert Box warns you when you are about to do something risky. You find Alert Boxes throughout Macintosh activities. Alert Boxes contain the following elements:

- A question asking if you really want to proceed with a particular action.
• A button that enables you to complete the procedure (see fig. A.2).
• A button that enables you to cancel the procedure.
• Some other option, depending on the part of the system with which you are working.

![Alert Box]

Fig. A.2. An Alert Box.

To respond to an alert
Click OK if you are ready to take the plunge
or
Click Cancel to re-evaluate the situation.

Notes
To select the default (the button with the dark border), you also can press the Return or Enter key.
To cancel certain operations, you also can try pressing . (period).
If in doubt, the safest response to most Alert Boxes is to select the default.
See also Dialog Box.

Alignment

An alignment setting determines how the left and right margins of text line up on a page.
The term “alignment” also is used in drawing programs to refer to objects lining up in relation to each other across a horizontal or vertical grid.

Most programs provide a particular set of menu commands or keystrokes that align text. Many word processing programs enable you to align text or graphics using more than one technique, such as selecting alignment or justification under the Format menu or selecting an alignment box on the ruler line (see figs. A.3 and A.4).

This text is left-justified. This text is left-justified. This text is left-justified.

This text is right-justified. This text is right-justified. This text is right-justified.

This text is centered. This text is centered. This text is centered.

This text is justified. This text is justified. This text is justified.

Fig. A.3. Four different types of alignment.

Microsoft Word alignment options appear on the ruler line.

Fig. A.4. Selecting alignment options from the ruler.

See also Centering Text and the “Quick Key Guide.”

A network is a group of computers that can share information and equipment. For example, a network enables three PCs to use one printer. For your network to work, you need software to coordinate the communications among different devices along the network.
AppleShare is a network operating system developed by Apple Computer, Inc. that transforms a Macintosh computer into a centralized file server for an AppleTalk network. A file server is a computer that cannot be used for anything other than supporting the network.

AppleShare offers unique features, such as file locking, speed, and the capability to restrict access to certain parts of the network.

See also *AppleTalk* and *Networking*.

---

AppleTalk is a local area network standard developed by Apple Computer, Inc. AppleTalk combines hardware and software so that a Macintosh computer can communicate with other computers. LocalTalk is the hardware, and AppleTalk is the set of software network protocols that run over the LocalTalk cables.

AppleTalk is priced right, because every Mac includes an AppleTalk network port. The only hardware requirement for an AppleTalk network is a set of connectors and cables. The physical connections among the computers and peripherals are made by Apple's LocalTalk hardware or third-party hardware such as PhoneNet (from Farallon Computing).

If you are considering AppleTalk, you can save money and extend an AppleTalk network's capabilities by using PhoneNet hardware. After equipping each node with a PhoneNet connector (instead of a LocalTalk connector), you can wire the network using ordinary telephone cables, considerably cheaper than LocalTalk cable. In some circumstances, you can use existing telephone wiring to create the network. A PhoneNet
network can transmit data three thousand feet—three times the distance of a LocalTalk network.

AppleTalk networks are slow compared to high-speed systems like EtherNet. However, AppleTalk's simplicity and low cost make it an attractive option for networks of modest size and use.

See also AppleShare and Networking.

Adobe Type Manager (ATM) is a Macintosh utility from Adobe Systems that displays outline fonts without distortion. This combination control panel device and INIT is useful especially for large type (greater than 12 point—the text in this paragraph is 10 point) because it gets rid of the dreaded jaggies (see fig. A.5).

Without ATM
With ATM

Fig. A.5. A line of type without ATM (top) and with ATM (bottom).

Normally, the Macintosh uses bit-mapped fonts for the screen display. For desktop publishing applications, however, this display technique has drawbacks. If you try to display a font in a size not matched by a complete set of bit-mapped characters in the System Folder, you see grossly distorted characters on-screen. ATM tackles this problem by using outline font technology to display fonts. Because outline fonts are constructed from mathematical formulas, they can be scaled to any size without distortion.
Notes

ATM has its drawbacks. The program affects the appearance of Adobe fonts only. Even Adobe fonts are not affected unless you have (in the System Folder) a special screen display file for each font you want to display. The program comes with Times Roman and Helvetica; the user must purchase an expensive add-in program to obtain screen fonts for the rest of the typefaces normally included with PostScript laser printers.

See also Fonts, PostScript, Printing, and System.

Backups

According to Paul Mace, backup guru, there are two types of people: those who have lost their data and those who will. Regardless of how competent you are with your Macintosh, you may someday lose your data. You may inadvertently delete an important file or suffer from a hardware failure. In any case, be prepared for any catastrophe by establishing a regular backup procedure.

Backup procedures

The simplest backup procedure involves nothing more than copying files to a floppy disk. This procedure requires no special software, and you can perform it at the end of your work session.

You can make a backup of your entire hard disk, but when you finish, you do not want to repeat this time-consuming task. Routine backups generally fall into two categories. A differential backup includes all files that have changed since the last time you did a backup. An incremental backup includes all files that you have changed since a certain date.
**Backup programs**

You also can use one of the many software programs available, such as Fastback, Redux, or CAT•BACK. These programs permit you to define certain parameters you want to apply to your backup—such as files changed today, or those files beginning with a certain name. These programs also permit you to set an automatic backup so that you can back up your entire hard disk on a regular basis. You determine the time increment. You can back up your data to a variety of media including floppy disks, tape, hard drives, and optical drives.

Finally, some backup software compresses a file while it saves, and therefore can place two, three, or even five times more information on a disk or tape.

**To back up a file by copying it from a hard disk to a floppy disk**

1. Insert a floppy disk into the floppy drive slot.
2. Select the file on the Desktop that you want to copy.
3. Drag the file icon on top of the destination floppy disk icon.
4. When the destination icon reverses color, release the mouse button.

**To back up more than one file by copying them from a hard disk to a floppy disk**

1. Insert a floppy disk into the floppy drive slot.
2. Open the folder or window on the desktop containing the file(s) you want to copy.
3. Press ⌘-A to select all the files in the active window
   
   or

   Click on one of the files you want to copy. Press and hold the **Shift** key and click on
another file. Continue until you select all the files you want to copy.

4. Point to one of the highlighted file icons and press the mouse button and drag it on top of the destination floppy disk icon.

5. When the icon of the destination disk reverses color, release the mouse button.

To back up the contents of a floppy disk to another floppy disk using only one floppy drive (method 1)

1. Insert the disk containing the files you want to copy.

2. Press ⌘-E to eject the original disk but leave the icon of that disk on the desktop.

3. Insert the disk you want to copy the files to.

4. Drag the gray disk icon over the icon of the disk you want to copy the files to.

5. When the icon of the destination disk reverses, release the mouse button.

6. Select Yes to the prompt that asks if you are sure (are you?) that you want to replace the contents of the destination disk with the contents of the source disk.

To back up the contents of a floppy disk to another floppy disk using only one floppy drive (method 2)

1. Insert the floppy disk containing the files you want to copy.

2. Press ⌘-N to create a new folder on your hard drive.

3. Double-click on the icon of the floppy disk containing the files you want to copy and select all files by pressing ⌘-A.

4. Drag these files to the new folder. When the icon of the new folder reverses, release the
mouse button. The files copy to the new folder on your hard disk.

5. Drag the icon of the floppy disk to the trash can to eject it (it's safe—trust me).

6. Insert the disk you want to copy the files to.

7. Double-click on the new folder on your hard disk to open it.

8. Press **⌘-A** to select all the files in the new folder.

9. Point to one of the highlighted icons and press the mouse button. Drag the highlighted icon on top of the icon of the disk you want to copy the files to. (The rest of the selected files move with the one you drag.)

10. When the icon of the floppy disk highlights, release the mouse button.

You may then throw away the new folder you created on your hard disk and drag the floppy disk icon to the trash to eject it. Put the floppy disk away for safekeeping.

**To back up the contents of a floppy disk to another floppy disk using two floppy drives**

1. Insert the floppy disk you want to copy from into a floppy drive slot.

2. Insert the floppy disk you want to copy to into the other floppy drive slot.

3. Drag the icon of the disk containing the files you want to copy from on top of the icon representing the disk you want to copy to.

4. Select **Yes** to the Alert Box prompt asking if you are sure (are you?) that you want to replace the contents of the destination disk with the contents of the source disk.
Notes

It doesn’t matter which floppy disk you insert in which slot. The important thing is to be certain you’re dragging the correct source floppy on top of the correct destination floppy.

Make sure that you lock your source disk by sliding the black square in the corner of the floppy disk to the open position. Then, if you inadvertently err, you do not erase the original disk containing your valuable data.

Be cautious as you copy disks. When you drag one disk icon over another, the contents of the source disk completely replace the existing contents of the destination disk. (This contrasts with sliding individual files from one disk to another, which does not replace data on the destination disk unless the files have the same name in both locations.)

See also Copying, Disks, Ejecting Disks, and Files.

Battery

Many people don’t even know that there’s a battery in their Mac. They should, because it plays an important role. The battery is what keeps all the system settings (such as time, date, and the desktop pattern) in force. All of this information (and more) is stored in what the Mac calls parameter RAM (PRAM). When the battery goes, you can still use your Mac, but you will have to adjust Control Panel settings each time you power up if you want the proper date/time information recorded in your files.
To check to see if you need a new battery

If everything works fine on your Mac except for incorrect date and time settings, you may need to replace the battery. Reset the clock to the correct date and time. If the date and time are still incorrect after time passes, try replacing the battery.

To replace the battery in a Mac 128K, 512K, 512Ke or Plus

1. Shut down your machine.
2. Remove the battery cover located on the back of the machine.
3. Replace the battery and then replace the battery cover.

The battery should last two years.

To replace the battery in a Mac Classic, LC, Si, IICx, IIci, and IIfx

The battery pops in a logic board inside the machine and is relatively easy to replace. Follow these steps:

1. Shut down your machine and unplug it.
2. Open the system case by removing the retaining screw located in the center of the back panel. Press the tabs on each side of the panel and lift gently. Lift the front edge of the cover away from the base of the Mac.
3. Replace the battery located on the logic board.
4. Close the system and replace the screw.

The battery should last two years.

To replace the battery in a Mac SE, SE/30, II, IIx

If you own an SE, SE/30, II, or IIfx, the battery must be soldered onto the logic board. Therefore, if you own one of these models, you must go to your nearby certified Apple dealer for battery replacement. A soldered battery lasts about five years.
Note: Your Apple dealer may not be able to perform this operation. The dealer may want to replace the entire motherboard.

**To replace the battery in a Mac Portable**

The battery in the portable Macintosh is similar to the battery in the Plus. Simply replace it by taking out the old battery from the compartment located on the bottom of the unit and snap in a new 9-volt battery. The battery should last about two years.

**Notes**

You can use your Mac without the battery, but you have to go to the Control Panel to set things such as the time and date each time you boot up.

If you do want to start fooling around with the inside of your Mac and change the battery, remember, you may be voiding your warranty. So, *read the fine print* and proceed with caution.

See also *Clock, Control Panel, and RAM.*

**Beeps**

The Macintosh alerts you in a variety of ways that it is operating and all is well (or isn't well!). An audio signal is just one of the ways in which a Mac alerts you that an event has taken place, or that the computer requires an action before it can continue. A beep tells you that your Macintosh needs attention.

You control both the type of beep and volume setting for the beep via the Control Panel desk accessory.

**To adjust the beep volume**

1. From the Apple menu, select *Control Panel* (see fig. B.1).
2. Select the **General** icon (scroll if necessary).

3. Press and drag the speaker volume bar to the desired volume. A setting of zero causes the menu bar to flash rather than sounding a beep.

4. Click the close box to register the new settings.

---

**To change the beep sounds**

1. From the **Apple** menu, select **Control Panel**.

2. Select the **Sound** icon (scroll if necessary).

   A selection of sounds appears that includes such beep selections as boing, a monkey screech, or a clink-clank sound.

3. Click on the sound you want.

4. Change the beep volume, if you want.

5. Click the close box to register the new settings.

---

**To eliminate the beep sounds**

The easiest way to eliminate sounds is to set the volume control to 0. Whenever your Mac needs to communicate with you, it will flash the menu bar to
get your attention. You also can insert a headphone jack into the audio port on the back of your Mac to turn off the beep without fussing with the control panel.

See also CDEVs, Control Panel, and Scrolling.

---

**Bulletin Boards**

A bulletin board system (BBS) is a messaging system that is maintained on a computer and can be accessed through a modem. You can use bulletin boards to disperse information, receive information, download public domain and shareware programs, or have interactive chats. For example, the WELL (Whole Earth Lectronic Link) has forums on topics such as the Mac, Computers, Writing, Baseball, Politics, plus more than 50 other topics. Larger, commercial bulletin boards, such as CompuServe, have over 500,000 subscribers.

See also Modems and Telecommunications.

---

**Buying Hardware**

How in the world can you decide which Mac model to buy? The following is a list of questions you should try to answer before you go shopping:

- What do you plan to do with your Macintosh?
- What types of software do you intend to buy (word processing, financial, page layout, and so on)?
- What are the system requirements of the software you want to use?
• How much money do you have available for the complete system purchase?

• What is the most important feature to you? Speed? Expandability? Reliability?

• Do you need color?

• What types of printing will you be doing? Drafts? Finished work? Envelopes? Mailing labels?

• How much disk storage do you need? What will you be saving, and for how long?

• How much money can you afford to spend on your backup system?

• What kind of storage device do you need? Do you need a hard disk?

• Do you plan on telecommunicating? Will you need a modem? What speed and features do you need?

• How flexible do you want your Macintosh to be? As hard as it is, try to buy a Macintosh that can grow with your needs.

• What about memory? 1M is a safe minimum, but 2M may more realistic for memory-intensive programs.

When you are ready to make a purchase, remember the following guidelines:

• Make sure you understand the terms of your warranty and any service contract you sign.

• Inquire about who to call for help if you have a problem or question with your new equipment.

• Check to see if free training is available with your purchase.

Remember that people are an important resource. Talk to friends, clients, and neighbors, and attend a
local Macintosh user group to talk to some unbiased (and some quite biased) Mac experts. There are dozens of Macintosh-related magazines in your nearby bookstore. Many magazines contain articles and informative advertisements that will help you in your search.

It also is important to try a piece of equipment before you buy it. Test the software to see that it is truly "user-friendly" and compatible with your other software.

*The Big Mac Book*, 2nd Edition, also by Que Corporation, contains many tables comparing and contrasting Macintosh hardware and software. The book also contains an extensive vendor list and information about user groups.

See also *Macintosh Systems, Maintenance, Peripherals, and Upgrading.*

---

**Buying Software**

Whether you are in the market for an inexpensive utility program or an expensive page layout program, you should follow some purchasing guidelines in order to select software that will meet your needs. Although these guidelines cannot guarantee that you will not make a mistake, they can help. Before you purchase any software, follow these guidelines:

- Know what you need before you start looking. Do your homework and list the features and functions you want. Then consult a person who currently uses that program to see whether the program suits your needs.

- Read reviews in popular periodicals of both the software you think you want and its competitor's products.
• Make sure that you have the hardware to run the program (such as a hard drive or sufficient memory). If your local dealer does not know what you need, call the manufacturer or a computer consultant.

• If possible, try the package before you buy it. Any reputable dealer should permit you to sit down and work with the software.

• Review the documentation that comes with the software to ensure that the instructions are understandable.

• Inquire about the software vendor's technical support and update policies. Does the manufacturer have a toll-free telephone support? Can you purchase subsequent upgrades to the software for a nominal fee?

• Make sure that you purchase the latest version of the software. Call the manufacturer if you are in doubt. Be sure that a major version release (from 4.0 to 5.0, as opposed to a minor release from 4.1 to 4.2) isn't right around the corner.

• Be wary of large price cuts in software. Such cuts may indicate that a new version of the product is imminent or already released, and the vendor is trying to sell the old product inventory. You may find, however, that sometimes it is cheaper to buy the old version and then buy an upgrade.

Notes

Be sure to investigate public domain software, shareware, and freeware. There are thousands of programs available for little more than the cost of a floppy disk. Many are free! Check magazines and your local user group for more information.

See also Database Programs, Desktop Publishing, Financial Programs, Graphics Programs, Spread-
sheet Programs, Utilities, and Word Processing Programs.

Calculator

This standard desk accessory functions as a handheld calculator. Like other desk accessories, you may access the Calculator whenever you need it.

You can type the calculations directly from your numeric keypad, regular alphanumerical keypad, or use the mouse to click on the desired buttons on-screen.

<table>
<thead>
<tr>
<th>Key(s)</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Add</td>
</tr>
<tr>
<td>-</td>
<td>Subtract</td>
</tr>
<tr>
<td>*</td>
<td>Multiply</td>
</tr>
<tr>
<td>/</td>
<td>Divide</td>
</tr>
<tr>
<td>,</td>
<td>Decimal point</td>
</tr>
<tr>
<td>=, Enter</td>
<td>Equals</td>
</tr>
<tr>
<td>c, Clear</td>
<td>Clear</td>
</tr>
</tbody>
</table>

To use the calculator

1. From the Apple menu, select Calculator.
2. Type the numbers and operands you want to calculate

or

Click on the calculator buttons (see fig. C.1). For example, enter 85/96.

3. Type =, click on the equal sign, or press Enter for the result.
Fig. C.1. The Calculator desk accessory.

Notes

You can cut or copy the computed value into any other application using the standard Cut, Copy, and Paste features.

See also Copying, Cutting, Desk Accessories, and Pasting.

CDEVs

A Control Panel Device (CDEV) is a utility set, and is invoked and controlled through the Control Panel desk accessory under the Apple menu. The standard CDEVs supplied by Apple are as follows:

- General
- Keyboard
- Mouse
- Sound
- Color
- Monitor

Although the preceding devices are standard, hundreds of other devices are available that range from mini word processors to games.
The following chart describes the function of each device:

<table>
<thead>
<tr>
<th>CDEV</th>
<th>What it sets</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Desktop pattern</td>
</tr>
<tr>
<td></td>
<td>Rate of insertion point blinking</td>
</tr>
<tr>
<td></td>
<td>Time and date</td>
</tr>
<tr>
<td></td>
<td>Rate of menu blinking</td>
</tr>
<tr>
<td></td>
<td>Speaker volume</td>
</tr>
<tr>
<td></td>
<td>Size of RAM cache</td>
</tr>
<tr>
<td>Keyboard</td>
<td>Repeat rate for keys; delay between pressed key repeat</td>
</tr>
<tr>
<td>Mouse</td>
<td>How quickly mouse tracks or the cursor follows mouse movement, and how long your Mac waits between clicks when double-clicking</td>
</tr>
<tr>
<td>Sound</td>
<td>Speaker volume; type of sound (Beep, Boing)</td>
</tr>
<tr>
<td>Startup Device</td>
<td>Sets which SCSI drive the Mac boots from (not available on the Plus)</td>
</tr>
<tr>
<td>Color</td>
<td>Hue, saturation, and brightness of selected color</td>
</tr>
<tr>
<td>Monitor</td>
<td>Number of colors or shades of gray that appear on the monitor</td>
</tr>
</tbody>
</table>

To change a CDEV setting
1. From the Apple menu, select Control Panel.
2. Select the icon that represents the device you want to change (scroll if necessary).
3. Make your changes.
4. Click the close box to register the new settings.

To copy a new CDEV to your system
1. Insert the floppy disk containing the new CDEV into the floppy drive.
2. Double-click on the icon of the floppy disk to reveal the icon of the CDEV you want to transfer to your system.

3. Drag the icon of the CDEV you want to copy on top of the icon of the System Folder on your hard disk or startup disk.

4. When the System Folder icon reverses, release the mouse button.

**Note**

The initial set of CDEVs are installed with your system. Depending on the nature of the device, you may have to restart your Mac for the CDEV to be operational.

See also *Control Panel, Copying, Desk Accessories*, and *INITs*.

---

### Centering Text

There are several ways to center text. Usually, once you begin typing a letter or creating a report, you may decide to center a line of text. All you have to do is click somewhere on the line you want to center. Then, you can center the text from the ruler, from a menu selection, or from the keyboard using a keyboard shortcut. In Microsoft Word and PageMaker, you can use the following keyboard equivalents to control alignment:

<table>
<thead>
<tr>
<th>Keys</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘-L</td>
<td>⌘-Shift-L</td>
</tr>
<tr>
<td>⌘-C</td>
<td>⌘-Shift-C</td>
</tr>
<tr>
<td>⌘-A</td>
<td>⌘-Shift-A</td>
</tr>
<tr>
<td>⌘-J</td>
<td>⌘-Shift-J</td>
</tr>
</tbody>
</table>
To center a line of text

1. With your word processing document open on-screen, press \-R to reveal the ruler, or look for a Show Rulers command from one of the menus. You see a ruler like the one in Figure C.2.

![Fig. C.2. Centering text using a ruler.](image)

2. Click anywhere on the line you want to center.

3. On the ruler bar, look for the little icons representing alignment options, and click on the icon with the centered lines or press \-Shift-C.

Unselected paragraphs remain unchanged.

To uncenter a line of text

Repeat the preceding steps. Click on a different alignment icon in the menu bar, or choose an alternate alignment selection from the Format menu.

Notes

Some programs will center the entire paragraph containing the selected line; others will center just the line you select.

You may want to insert a hard carriage return to divide one paragraph into two, so that you can center one of them.

See also Alignment and the “Quick Key Guide.”
The Chooser desk accessory permits you to select the printer and other network devices that you use with your Macintosh.

Many printing problems can be traced to the settings in the Chooser dialog box (see fig. C.3). You must select all the appropriate items in order to print.

**Important:** all three items must be highlighted in order for you to print. If you are on a network, you also must select an AppleTalk Zone.

**To select a printer or to change printers**

1. From the Apple 🍎 menu, select **Chooser**.
2. Click on the icon for the printer driver you want to use.
3. Click on the printer name in the dialog box to the right of the icon box.

If no name appears, you may want to check cable connections and power supply, or reinstall your printer resource from your original Apple disk.

If you are part of an active network, you also will see an AppleTalk Zone section in the
lower left corner of the dialog box. Select a zone if this box appears.

4. Click the Close box.

**When to check the Chooser settings**

You must go through the Chooser to make changes at certain times. You should check your Chooser settings at the following times:

- When you print from your Mac for the first time.
- When you have problems printing.
- When you change from one printer type to another.
- When you want to select a device other than a printer, such as a plotter.
- When you reconnect your printer cable to a different port on the back of your Mac.
- When you want to become part of an active network. You will see an additional AppleTalk Zone section in the lower left corner of the Chooser dialog box.

**Notes**

You must select a printer through the Chooser before you can print your first document.

See also *Control Panel, Networking, Peripherals,* and *Printing.*

---

**Clip Art**

One of the reasons that the Mac is so popular is the ease with which you can use graphics, including all kinds of charts and images. But because most of us are
not Leonar dos, Renoirs, or Picassos, much of our “art” simply doesn’t do the job.

That’s where clip art comes in. Clip art is a collection of images on disk that save you the time and trouble of creating your own drawings. The term “clip art” originated more than 20 years ago. Designers and typesetters clipped the drawings they needed out of books and then pasted the art into the document.

The selection of available clip art these days is staggering, from subjects as diverse as athletics and education (see fig. C.4). Inexpensive clip art is available through shareware libraries such as International Datawares. Other more expensive (and sometimes better quality) clip art is available, such as Cliptures™ (Dream Maker Software). Cliptures are Encapsulated PostScript (EPS) files, making them ideal for high quality desktop publishing work.

You usually can get clip art as regular Paint files, PICT files, or EPS (Encapsulated PostScript) files, which allow you to modify the image without losing any detail.
To use a clip art illustration

1. Launch your favorite paint application (such as SuperPaint or MacPaint) by double-clicking on the icon of the application on the desktop.

2. From within the paint program, open the clip art file containing the graphic you want to use.

3. Using the lasso tool, draw a line around the graphic you want to use.

4. From the Edit menu, select Copy.

5. From the File menu, select New.

6. From the Edit menu, select Paste.

7. Save your new file with any modifications you want to make.

You are now ready to copy the graphic to the Clipboard or Scrapbook for use in another document.

To copy artwork to the Scrapbook for future use

1. Launch your favorite paint application.

2. Open the clip art file containing the artwork you want to copy.

3. Using the lasso tool, draw a line around the item you want to copy.

4. From the Edit menu, select Copy.

5. From the Apple menu, select Scrapbook.

6. Scroll to the desired location in the Scrapbook where you want to place the artwork.

7. From the Edit menu, select Paste.

8. Click the close box.

The item is now in the Scrapbook for future use.

Notes

Always copy artwork from a clip art file rather than cut. This ensures that your original file remains intact.
for future use. Also, it is always a good idea to make copies of your original disks and work from the copies.

See also Clipboard, Copying, Cutting, Pasting, Desktop Publishing, Graphics Programs, and Scrapbook.

---

**Clipboard**

The Clipboard is a buffer (temporary storage place) in which the last cut or copied text or graphics temporarily is stored. After you turn off a Macintosh, however, the contents of the Clipboard are lost.

You use the Clipboard primarily to copy something from one location in a file to another (when you cut and paste and rearrange a letter, for example). Another common use is copying something from one file and inserting it into another file, whether or not you have changed applications. Some applications, such as Microsoft Word, have a Show Clipboard command, which you can use to examine the contents of the Clipboard.

Although the Clipboard holds only one item at a time, several commercial products, such as MultiClip, enable you to hold as many different items as you want. To save items from the Clipboard for reuse, you can paste text and graphics into the Scrapbook. The Scrapbook saves your work between sessions, and you can place more than one item in the Scrapbook at a time.

You cut or copy to the Clipboard by pressing ⌘-X or ⌘-C (respectively). To paste the Clipboard's contents, use ⌘-V (“V” for “Paste”—of course!)

See also Copying, Cutting, Pasting, and Scrapbook.
Clock

Your Mac has an internal clock that is controlled by instructions contained in the memory of your computer. After you set the clock, the time setting remains until the battery runs down or you remove the battery.

To change the clock setting

1. From the Apple menu, select Control Panel.

2. Select the General icon (scroll if necessary).

3. Click on the setting you want to change. Change the hour, minute, second, and AM/PM distinction by using the arrow keys to increase or decrease the current setting. You can also highlight what you want to change and type a new value.

4. Click to select either the traditional 12-hour setting or the 24-hour military time option.

5. Click on the Close box to exit the Control Panel and register the new settings.

Notes

SuperClock is a popular time-keeping tool. SuperClock places a clock in the upper right corner of your screen, displays the time and date, and sets an alarm. It also sets the type of display you want to use. Unlike the regular Macintosh clock feature, you must purchase SuperClock separately.

See also Alarm Clock, Battery, CDEVs, and Control Panel.
**Close Box**

The close box is the small box in the upper left corner of the window that closes the window (see fig. C.5).

The close box is available in all Macintosh applications, from the desktop to alarm clock to individual document files.

**To close the active window**

Click the small white box in the upper left corner of the window or press ⌘-W.

**To close an inactive window**

1. Click on the window you want to make active.
2. Click the close box in the upper left corner of that window.

**To close all of the open windows on the desktop**

1. Press and hold the Option key.
2. Click the Close box in the upper left corner of the active window.
   
   or

   Press ⌘-Option-W.
Notes

You do not have to close all of the open windows on the desktop in order to shut down your Mac. Whichever windows you leave open on the desktop will be open the next time you start up your Mac.

If you close all your documents and want to return to the desktop, but find yourself in limbo instead, try selecting Quit from the File menu.

See also Quitting, Shut Down, and Windows.

Color

To use color with your Macintosh, you must have a color monitor and the appropriate system hardware to support that monitor. You also need to tell your Mac that you will be using a color monitor by selecting the Colors option from the Monitor device on the Control Panel. Finally, you need to use the Color device (also on the Control Panel) to set the colors you want.

To change the color of the desktop background

1. From the Apple menu, select Control Panel.

2. Select the General icon (scroll if necessary).

   The General dialog box appears (see fig. C.6).

3. In the Desktop Pattern box, there are two screens. Click on the left screen to edit the individual pixels. Notice the right screen has two tiny arrows at the top of the shaded box. Click on an arrow in the right screen to view other screen patterns.

   Click anywhere on the right screen to apply the new background pattern.
On color monitors, another Desktop Pattern option appears: colors. Change colors by double-clicking on a color box.

4. Click the close box when you finish your selections.

**To switch from color to black and white**

1. From the Apple ⌘ menu, select **Control Panel**.
2. Select the **Monitor** icon (scroll if necessary).
3. Click on **Black & White**.
4. Click the close box.

To switch from black and white to color, repeat the process, but click the setting for the number of colors you want, e.g. **Colors, 256**.

**To change the hue, saturation, and brightness**

1. From the Apple ⌘ menu, select **Control Panel**.
2. Select the **Color** icon (scroll if necessary).
3. Click on **Change Color**. The Color Picker dialog box appears.

Change the hue by clicking around the edge of the Color Picker. Change the saturation by clicking from the outside of the wheel toward the center of the reverse. Change the brightness by dragging the scroll box located on the right side of the Color Picker dialog box.

4. When you like what you see, click **OK**, then click the close box to register the new settings.

See also **Control Panel**, **Dialog Box**, and **Scrolling**.

---

**Control Panel**

The Control Panel is a desk accessory that serves as your Mac's central device controller. With the Control Panel, you can change many of the settings that determine how your Macintosh operates (see fig. C.7).

![Control Panel](image)

*Fig. C.7. The Control Panel.*
You can change the following settings in the Control Panel:

- Pattern of the screen background
- Colors displayed
- Speaker volume
- Time
- Date
- Cursor blink rates
- Keyboard responsiveness
- Mouse responsiveness
- RAM cache
- Beep sounds

The icons that you see along the left side of the screen when you select the Control Panel represent the control panel devices (CDEVs) in your System Folder.

You change all the Control Panel settings in a similar way. The following steps provide an example of how to change a setting on the Control Panel.

**To change the menu blink rate**

1. From the Apple menu, select **Control Panel**.

2. Select **General** from the list of devices. You may need to use the scroll bar to find the device that you want.

3. In the **Menu Blinking** box, click the various settings to select the blink rate you prefer.

   Notice that the little blinking menu corresponds to the setting you select.

4. Click the **Close** box when you are finished changing the settings.
Notes
The Control Panel in System 7 will be significantly different in appearance and operation from the panel in previous systems.

See also Beeps, CDEVs, Clock, Color, Desktop, Icons, INITs, Monitors, Mouse, RAM Cache, Scrolling, and System.

Copying

You find the Copy command on the Edit menu. The Copy command copies text or graphics from one location to another without affecting the copied material.

To copy text or graphics
1. Highlight the text or select the graphic you want to copy.

2. From the Edit menu, select Copy
   or
   Press ⌘-C.

3. Scroll to the new location for your copied text, and click to tell the Mac where to place the copied item(s).

4. From the Edit menu, select Paste
   or
   Press ⌘-V.
To copy an item between applications

1. Highlight the text or select the graphic you want to copy.

2. From the Edit menu, select Copy
   or
   Press ⌘-C.

3. Quit (don’t forget to save!) your current application, and open the application in which you want the copied material placed.
   If you are operating under MultiFinder, switch to the new location.

4. Locate the area where you want to paste the copied materials and click.

5. From the Edit menu, select Paste
   or
   Press ⌘-V.

Notes
You do not need to leave blank spaces to be filled by pasted text. The text inserts automatically. New text does not overwrite the existing text, unless you highlight the text you want the pasted text to replace.

All copied material remains in the Clipboard until you replace it by copying another selection, or when the Mac loses power. When material is copied, the original stays intact in the current location. When a copy and paste operation is complete, two copies of the information exist.

See Clipboard, Cutting, Highlighting Text, Keyboard Shortcuts, Pasting, and Scrapbook.
Correcting Typos

You can use several basic Macintosh techniques to correct typographical errors.

**To correct typos as you type**

1. Press the **Delete** or **Backspace** key to erase the character you just typed.

2. Type the new text.

**To correct typos**

1. Highlight the characters you want to delete.

   Click at the beginning of an area of text, press and hold the mouse button, and drag the mouse until the very last word in your selection is highlighted. Then, release the mouse button.

   You also can double-click to select words and shift-click to select areas of text.

2. Type the new text.

   You do not need to delete the incorrect text first; you just need to replace it with something.

**To delete text**

1. Highlight the characters you want to delete.

2. Press **Delete**.

   There are two delete keys on the extended keyboard; either key will work. On older keyboards, the delete key is labeled “Backspace.”

**To delete text for use again**

1. Highlight the character you want to cut.

2. From the **Edit** menu, select **Cut**.
The text is now in the Clipboard. You may go to where you want the cut material to be placed, or you may store it in the Scrapbook for safekeeping.

**Notes**

When you press the Delete/Backspace key, the character to the left of the blinking cursor disappears. If you highlight a character or set of characters, pressing the Delete/Backspace key removes all the highlighted characters.

You can highlight a word in most Mac applications by double-clicking on the word. Triple-clicking sometimes highlights a paragraph.

To highlight a line in Microsoft Word, place the arrow pointer to the left of the line and click once. To select a paragraph, place the pointer to the left of the paragraph and double-click.

You can also simply press and hold the mouse button, then drag the cursor over the text you want to highlight. Note that these procedures work in Word, but not necessarily in other word processors, which contain their own shortcuts.

Whenever you highlight text, the next keyboard action completely replaces the highlighted text. Therefore, be cautious about leaving text highlighted. If you should accidentally delete text, you can usually undelete it using the `Undo` command found under the `Edit` menu of most Macintosh applications.

See also *Cutting, Highlighting Text,* and *Undo.*
Crashes

Ouch! What could hurt more than to see that dreaded Bomb on your screen along with the message that a system error has occurred? (See fig. C.8.) When you're running MultiFinder, you may see a different alert: The application...has unexpectedly quit.

\[\text{Fig. C.8. A crash alert.}\]

Sometimes a crash will come as an error message; sometimes your system will “freeze,” “lock up,” “hang,” or otherwise ignore you. You can tell your system has locked up if your pointer refuses to move when you move your mouse.

**Causes for a crash**

Your machine may crash for any of the following reasons:

- RAM overload
- Corrupted software (including incompatible applications/utilities, corrupted Desktop file, corrupted System file, corrupted PRAM, and corrupted application)
- More than one System file
- Bugs in a software program
- Conflicting INITs
- Heap size too small
- Virus
If a particular action seems to cause your system to crash (for example, when you select the Print command), you probably have corrupted software.

**What to do if your system suddenly crashes**

Occasionally, even though your mouse has no effect, the keyboard may still work. Press ` ESC - S` to save whatever document you are working on. This rarely works, but it's worth a try.

If your system locks up, you may have no choice but to turn the machine off and then restart it. Sometimes the alert box contains a Continue or Resume button which you can try clicking first. The alert box also may contain a Restart button that enables you to restart without flicking any switches. Some of these buttons may be dimmed (depending on the mood of your computer). If the Restart button works, try to do an official Restart from the Special menu on the desktop as soon as possible to make a fresh start.

**What to do if your system frequently crashes**

If you find that your system is crashing a lot (you determine how much is “a lot”), you may suspect a computer virus. If you do not frequently download files from a bulletin board or exchange disks from other machines or networks, however, your problem may not be a virus. Remember, system crashes have been around a long time—long before viruses ever surfaced.

The following techniques may help you isolate the problem behind the crashes. After trying each procedure, operate your machine the way you usually do to see if it still crashes.

- If a particular application crashes, you may want to reinstall the application from the original program disks.
• If you’re running MultiFinder and crashing, and you switch to the Finder and don’t crash, try allocating more memory to each of the applications you run under MultiFinder.

• Rebuild the invisible Desktop file by holding down the ⌘ and Option keys upon starting up. Remember, doing so removes any information you may have entered in Get Info boxes.

• Scan for viruses using a virus detection program such as Virex (from Microcom). Follow the Virex instructions to eradicate any virus(es).

• If you have a system overload because of the number of fonts, INITs, desk accessories, and CDEVs, you may not have enough memory to run applications on top of all your “extras.” In this case, you may need to enlarge the memory allocation.

At the desktop level, from the Apple ⌘ menu, select About the Finder. If the light area of the System bar represents less than 25% of the entire bar area, you may need to enlarge your system heap. To enlarge your system heap, you should purchase HeapFixer (from CE Software).

• Zap the parameter RAM. Press ⌘-Option-Shift while selecting the Control Panel from the Apple ⌘ menu.

• Use the Find File desk accessory under the Apple ⌘ menu to find all the System files on your startup disk, and then delete all but the one you want to use (probably the latest version). Multiple copies of the System—no matter where they are located—will cause problems.

• Remove all the INITs from your System Folder. Put them all in a new folder somewhere else.
on the hard disk—you don't have to remove them completely from your hard disk. If the machine operates nicely, drag an INIT from your INIT folder into the System Folder and Restart. If your Mac doesn't crash, add one INIT at a time to sort out the bad INITs.

- Install a new System file. To do so, boot up from a floppy disk and use your original system installation disk labeled “System Tools” from Apple.

**To remedy a crash using the Programmer's Switch**

When your system does crash, short of resetting and rebooting, try the following steps to restore it.

1. Click on the **Continue** button (if one is showing on the message box with the bomb). If this works (it generally doesn't), select **Restart** from the **Special** menu and resume your work.

2. Push the **Interrupt** button on the **Programmer's Switch**, provided you installed the Programmer's Switch. When you press this button, you see a large box with a > in the upper left corner of the screen.

3. Type `sm fa700 a9f4`.

4. Press **Return**.

5. Type `pc fa700`.

6. Press **Return**.

7. Type `g`.

8. Press **Return**.

This procedure may or may not work (*now* you tell me!). If the Interrupt button yields no success, push the **Reset** button. The Reset button, located next to the Interrupt button on the Programmer's Switch, restarts your Mac.
See also Error Messages, INITs, Maintenance, Programmer's Switch, System, and Troubleshooting.

**Cutting**

Cut is a standard Macintosh operation that removes information (text or graphic) and puts it on the Clipboard. You can paste the contents of the Clipboard onto another location, if you want. The new location can be within the same document, the same application, or an entirely new application.

*To cut*

1. Select the element you want to cut.
2. From the **Edit** menu, select **Cut**
   
   or
   
   Press **⌘-X**.

*To cut and paste*

1. Select the element you want to cut.
2. From the **Edit** menu, select **Cut**
   
   or
   
   Press **⌘-X**.
3. Go to the new location where you want to paste the material, and click.
4. From the **File** menu, select **Paste**
   
   or
   
   Press **⌘-V**.
Notes

The cut item remains in the Clipboard until you cut or copy a new item, or until you shut down your Mac. Unlike the Copy command, where copied material remains in the original location as well as the new location, material that is cut is removed from the original location.

See also Clipboard, Copying, Deleting Files, Highlighting Text, Mouse, and Pasting.

Data Conversion

Glasnost isn’t the only thing bringing different worlds together. More and more, different computing platforms (such as Mac and IBM) are used in the same location, and people need to share information across these platforms. Applications such as MacLink Plus/PC (from DataViz) and LapLink (from Traveling Software) can translate Macintosh files to DOS files and back again (see fig. D.1).

![MacLink Plus/PC data conversion](image-url)
In addition, most new Macs available today come with a SuperDrive. A SuperDrive is a high density floppy drive (FDHD) which uses 1.44M floppy disks. What's especially neat about this drive is that it can read 3 1/2-inch disks formatted on IBM PC-compatible computers. The only thing you need to perform a conversion is the translation software that comes with your system disk.

As the use of Macs and PC-compatible machines in the same setting becomes more common, these translation programs can do more as well. For example, the latest version of MacLink Plus/PC can convert DOS-created graphics into a Macintosh-compatible environment.

See also *File Formats*.

### Database Programs

A database program provides a listing of information organized in functionally related files that enable you to manipulate and retrieve information as needed. A database created using a database management system (DBMS)—such as FileMaker Pro or 4th Dimension—consists of files, records, and fields.

*Field* is a unique piece of information common to all records. A *record* is a collection of fields, and, in turn, a *file* is a collection of records. For example, you can think of the phone book as a file, each listing as a record, and each record containing the fields “name,” “address,” and “phone number.”

In Figure D.2, you can see a FileMaker Pro record consisting of eight fields. Databases can be relational, in which records relate to one another through common fields, or flat, in which records have common fields but do not integrate with one another.
Deleting Files

Deleting a file from a disk or a folder removes the file from that disk or folder. When you drag an icon into the Trash Can, the file isn’t *completely* gone until the trash is emptied. If you want to clear up space on a disk, you can drag icons to the trash. However, the files you drag to the trash will still take up disk space until the trash is emptied.

The trash empties itself when you launch an application, shut down your Mac, eject a disk, copy or duplicate a file, or select the Empty Trash command.

To delete a file
1. On the desktop, select the file you want to delete.
2. Drag the file icon to the Trash Can.
3. When the Trash Can icon reverses, release the mouse button.
**To empty the trash**
On the desktop, from the Special menu, select **Empty Trash**.

**To delete an application without getting an alert message**
1. On the desktop, select the file you want to delete.
2. Press and hold the **Option** key.
3. Drag the file to the Trash Can.
4. When the Trash Can icon reverses, release the button and the key.

**To delete a locked file**
1. On the desktop, select the file you want to delete.
2. Press and hold the **Option** key.
3. Drag the file to the **Trash Can**.
4. When the Trash Can icon reverses, release the button and the key.

**Notes**
If you are in an application and you want to delete a file, you must return to the desktop.

If you delete a file inadvertently, you may be able to undelete the file by using utilities such as SUM II or Norton Utilities (from Symantec). In the meantime, whatever you do, do not write more data to that disk! Immediately run an “undelete” program, such as Norton Undelete, to restore deleted files.

See also Desktop, Ejecting Disks, Files, Quitting, Shut Down, Trash Can, and Undo.
Desk Accessories

Your operating system comes with a set of tools that are available whenever you use your Mac—regardless of the application you use. These tools are called Desk Accessories (DAs). The standard set of accessories includes the Alarm Clock, Calculator, Chooser, Control Panel, Find File, Key Caps, Note Pad, and Scrapbook.

Although the standard DAs are quite handy, they are, by far, not the only DAs available. As your Mac now stands, you are limited to fifteen DAs. With so many good DAs are on the market, you may find it difficult to select which ones to install on your system.

You can use a utility such as Suitcase II (from Fifth Generation Software), which enables you to install an unlimited number of DAs. Some software programs come as both an application and a DA, such as Deneba Software’s Canvas and Zedcor’s DeskPaint. Although the DA version is usually not as powerful as the full-blown application, imagine how easy it is when you need to draw a line, or color in a shape, and you can simply go to the Apple menu rather than quitting the current application.

You must install each desk accessory (prior to System 7) using the Font/DA Mover. Figure D.3 illustrates the installation of a new desk accessory into the System file of the active hard disk.
Preparing to install a DA

To install a DA, you must have the DA you want to install on disk, either on your hard disk or on a floppy disk. You also need the Font/DA Mover application, and you need to be able to access your hard disk or the startup disk on which you want to install the DA.

To install a new DA

1. Launch the Font/DA Mover application. You do this by either double-clicking on the Font/DA Mover application icon, or double-clicking on a Font/DA Mover file.

   The Font/DA Mover dialog box appears.

2. Click on the radio button for Desk Accessory.

3. On one side of the dialog box, click Open to open the file that contains the new DA you want to transfer. On the other side, click Open to open the System file in your System Folder on your hard disk or startup disk.

4. Click to select the DA you want to transfer and click Copy. Shift-Click to select more than one DA.

5. After the file transfers, click Quit.
Notes

To automatically select "Desk Accessory," press and hold the **Option** key while the Font/DA Mover opens.

You can transfer DAs from left to right or from right to left in the Font/DA Mover dialog box.

See also *Alarm Clock, Calculator, Chooser, Control Panel, Find File, Font/DA Mover, Key Caps, Note Pad, Scrapbook,* and "SYSTEM 7 FIRST LOOK."

---

**Desktop**

Just as the surface of an office desk is a work surface, so too is the Macintosh desktop. The desktop is made up of the screen, disk icons, trash can, and menu bar (see fig. D.4).

![Image of the Macintosh desktop](image)

*Fig. D.4. The Macintosh desktop.*

The desktop is the work area that the Finder creates on your screen. You open, close, copy, move, and delete files on the desktop. The desktop is the first screen you see when you boot up your Mac, and the last screen you see before you shut down.
If you think of the desktop as an actual desk, you can better understand how the Mac enables you to move (place this set of files over there) and discard (put this junk in the trash) just as you would if you were actually sitting at a desk.

Desktop is also the name of the invisible file your Mac creates to keep track of housekeeping information, such as storing the information you see when you issue the Get Info command from the File menu.

You can rebuild the Desktop file if your Mac is abnormally slow in starting up, or if you get a message that a disk is damaged. Rebuilding the Desktop takes little time and is often a miracle cure! (Best of all, it doesn’t damage anything.)

_to rebuild the Desktop file_

1. Shut down the Mac.
2. Press and hold the ⌘ and the Option keys.
3. Restart the Mac (on the Mac II series, press the power key).
4. When the desktop appears, release the keys.
5. Click OK to respond to the confirmation message.

The rebuilding process may take a few minutes. If the problem is here, however, rebuilding the Desktop is a simple fix.

Notes

Caution: Rebuilding the Desktop file removes notes in the Get Info section of each file. You can see the information for a particular file by selecting the file and then selecting Get Info from the File menu. Get Info, updated as you work, helps organize and track the creation of files.
You cannot rebuild the Desktop file while running MultiFinder.

See also Control Panel, Copying, Crashes, Deleting, Finder, Folders, Font/DA Mover, Get Info, Menus, Rebuilding the Desktop, Restarting, Shut Down, Startup Screen, Trash Can, and Windows.

**Desktop Publishing**

One of the hottest topics in personal computing, desktop publishing is the application of personal computer systems to all phases of the publication process—from entering text and drawing graphics to producing a final report, pamphlet, or book.

Besides the basic equipment, such as hardware and page layout software (such as PageMaker, Quark Xpress, or Publish It!), you need some basic skills to begin desktop publishing. For instance, you need a knowledge of basic design principles and some understanding of typography. (Most major cities offer classes, and many books are available on the subject.)

You may only need a good word processor since many high-end word processors such as Microsoft Word, Nisus, and WordPerfect offer much of the same features as a desktop publishing program.

*The Little Mac Book* was produced via desktop publishing. The text was composed in Microsoft Word, and the screenshots were created using Capture and MacPaint. The text and graphics were combined using PageMaker (see fig. D.5).
Desktop publishing enables you to combine text and graphics on one page. You can combine a spreadsheet created in Excel, with several documents created using WordPerfect Mac. Add to that document a photograph retouched using Photoshop. You can produce sophisticated output, including items such as color separations.

See also Buying Hardware, Buying Software, Clip Art, Draw Programs, File Formats, Fonts, Graphics Programs, Page Setup, PostScript, and Special Characters.

**Dialog Box**

Your Mac is so friendly that when it needs information from you, it doesn’t just wait for you to provide it; the system prompts you through a dialog box like the one you see in Figure D.6. After you provide information and click **OK**, the settings you select take effect.
A dialog box has a selection with a dark border (the default) that is usually your "OK" button. Pressing Return or Enter selects that default. Also, you have a Cancel button, so you can exit the dialog box without changing settings.

Some dialog boxes, such as the Save, Open, and Print dialog boxes, are similar to one another across applications (which really helps when learning new programs).

Fig. D.6. A dialog box.

**Components of a dialog box**

A dialog box contains the following elements:

- Round Radio buttons—mutually exclusive of one another; you can select only one at a time.

- Check boxes—not mutually exclusive; you can select and check as many as you want.

- Option boxes—require you to enter information.

- Menus—like those that appear in many different Mac applications, from which you can select a command or an option.

See also Alert Boxes, Opening Files, Page Setup, Printing, and Saving.
Disk Drives

A disk drive is the mechanism that spins a hard or floppy disk, reads information from the disk, transfers the data to your computer, and writes information from your computer onto the disk. In general, there are two kinds of disk drives: floppy disk drives and hard disk drives.

Floppy drives
Floppy disk drives are unsealed drives that use 3 1/2-inch flexible disks (within unfloppy shells) that hold 800K (double density) or 1.44M (high density) of information. An 800K disk holds about 200 pages of plain text; a 1.44M disk holds about 360 pages of plain text. Your Mac comes with at least one internal floppy drive and other drives can be added easily.

Hard drives
Hard drives are sealed units made of steel or glass. Hard disk platters are coated with the same magnetic material as floppies, contain enormous storage capacity, and operate quickly (spinning at 3,600 revolutions per minute). Hard drives can be internal or external, and some drives use removable cartridges (great for security). Storage capacities are always increasing with the upper limit now reaching more than 2.2G (gigabytes).

Drive speed
The speed of a hard drive (something to consider along with capacity) is measured in three ways:

- The average access time—the amount of time it takes for the computer to find the information for which it is searching. Access time is usually expressed in millionths of a second (ms), also called nanoseconds (ns).
• The transfer time—the time it takes for the hard drive to transfer data from the hard disk to the computer’s memory.

• The track-to-track access time—the speed with which the read/write heads can jump from track to track on the disk to find the necessary information.

**Hard drive purchase considerations**

Hard drives usually come initialized (formatted). They also generally come with software for organizing and managing created files and optimizing the space that’s used on the drive.

When evaluating a hard drive for purchase, inquire about the following items:

• What is the cost per megabyte?

• Does the hard drive automatically “park” the heads (safety feature) when it is turned off?

• Does the hard drive have an external switch for changing the SCSI address? (Especially important if you have several peripheral devices connected to your Mac.)

• Does any software come with the hard drive? If so, what is the purpose of the software?

• Will the drive fit physically with the rest of your Mac equipment?

• What cable(s) do you need?

Finally, determine what your storage needs are and buy the most storage you can afford. Even though it may seem impossible to you now, almost everyone runs out of hard disk storage eventually. The larger the disk capacity, the cheaper the per-megabyte costs.

See also *Buying Hardware, Disks, Initializing Disks,* and *SCSI.*
The function of a disk is to store data. Disks store the Mac's operating system, your programs, and your data. You cannot save your valuable creations without disks. There are two basic types of disks: floppy disks and hard disks. Floppy disks fit in your shirt pocket, are lightweight, and are relatively inexpensive. Hard disks are housed in sealed chambers and can hold far more data (up to 2000 times as much!).

**Not-so-floppy floppy disks**

You're probably wondering why a floppy disk isn't floppy. The disk itself is housed within a protective plastic shell. If you slide the metal shutter on a disk, you will see the floppy magnetic media used to store your data (don't touch!).

**DS-DD, MFD-2HD—what does it mean?**

Floppy disks for use on Macintosh systems come in one size: 3 1/2-inch, and two storage densities. High density (HD) holds 1.44M of data; double density (DD) holds 800K (approximately 200 pages of plain text). The density of a disk refers to the amount of information that can be stored in a given space.

DD drives cannot read HD disks, but HD drives can read both DD and HD disks.

Most floppy (a.k.a. micro floppy, MF) disks are double-sided (DS). "Double-sided" means that both sides of the floppy disk are certified safe to store data. Only the floppy disks used on the original Macs are single-sided. You can format a single-sided disk as double-sided, but you risk losing some data, because the second side has not been verified as "safe" to store data.
Caring for floppy disks
Because floppy disks are unsealed, you need to pay special attention to their care. Some general disk-handling guidelines follow.

- Keep disks away from all sources of heat (they melt before the paper labels on them burn!).
- Keep disks away from magnetic fields that disrupt the alignment of electrical impulses on the disk (translation—you lose your data). Magnetic fields are everywhere: the ringing telephone, a paperclip holder, your monitor, and your floppy drive. (Do not put floppies on top of your monitor or external floppy drive.)
- Store all disks in a safe place and in a closed container to avoid dust contamination.
- Keep the outside of the floppy disk clean.
- Keep Fido, junk food, cigarettes, liquids, and little greasy fingers away at all times!

Hard disks
Hard disks, also called “hard drives,” are physically different in shape from floppy disks, can hold anywhere from 10 megabytes to more than a gigabyte of information, can be internal or external, and are available in removable cartridges. Both floppy and hard disks are coated with magnetic material. The major difference between the two is that a floppy disk is a flexible disk within a protective shell and used in an unsealed disk drive, while a hard disk is rigid and is contained in a specially-sealed unit. The sealed unit enables the sensitive hard drive to run in a more protected, maximum-performance environment.

Caring for your hard disk
Hard disks don’t need as much direct care as floppy disks, but should not be exposed to excessive mois-
ture or heat and not moved or bumped abruptly, even while not active.

Make sure your hard disk operates on a steady surface, and that it has room to breathe. Don’t forget to back up your data regularly.

See also Backups, Disk Drives, Ejecting Disks, and Maintenance.

---

Dots per Inch (DPI) is a measure of the resolution of a character as it is printed or as it appears on the monitor screen. DPI is the number of dots in a one-inch-long line and is often a measure of the quality of a printer or monitor device. The higher the DPI, the better the quality of the finished product. The ImageWriter II prints at 72 DPI and the standard Mac monitor displays characters at the same level of resolution. The LaserWriter family of printers has a resolution of 300 DPI. Other laser printers come in at 1000 DPI and professional, top-of-the-line printers go all the way up to 2740 DPI.

See also ATM, Desktop Publishing, Fonts, and Printers.

---

Draw programs are applications that enable you to create and combine objects, rather than bit-mapped images. Draw programs which allow you to create layers and then superimpose them on one another, form the basis for many of the Computer-Aided Design (CAD) programs that are currently available.
Generally, good drawing programs—such as MacDraw II, Freehand, and Illustrator—provide the following:

- Intuitive drawing tools so that you know the purpose of the tool just by looking at the icon.
- Alignment of objects with one another.
- Change the order in which objects appear (front to back or reverse).
- Treatment of bit-mapped images created with paint programs as a single object.
- Gray scaling.
- Data saved to different file formats.
- Font, style, and size control.

See also *File Formats* and *Graphics Programs*.

**Duplicating**

You easily can duplicate an existing file from the desktop. This procedure is useful if you want a backup copy of a particular file to keep in a different folder on your hard disk, or if you want to modify an existing file, yet keep the original file intact.

To duplicate a file from the desktop

1. Click on the file you want to duplicate.
2. From the **Edit** menu, select **Duplicate**
   or
   Press **⌘-D**.

   A new file appears with the name “Copy of originalfilename.”
3. If you want a name other than “Copy of...,” type the name for the new file.
See also *Copying* and *Files*.

## Ejecting Disks

You may need to eject a floppy disk from a disk drive before you are ready to turn off your Mac. Following are different ways to eject a floppy disk:

**To eject a disk from the desktop**

1. Point to the icon of the disk you want to eject.
2. Press and drag that icon to the Trash Can (trust me).
3. When the Trash Can icon reverses, release the mouse button.

**To eject a disk from within an application**

1. From the *File* menu, select *Save As*....
2. At the Save dialog box, click *Drive* if the name of the disk you want to eject doesn’t appear in the dialog box.
3. Click *Eject*. The floppy disk pops out.
4. Click *Cancel* to return to your application.

**To eject a disk from an internal floppy drive at any time**

Press *⌘*-Shift-1.

**To eject a disk from an external floppy drive at any time**

Press *⌘*-Shift-2.

**To eject a disk when you’re done with your Mac session**

1. From the *File* menu, select *Quit* to quit whatever application you are using and return to the desktop.
2. From the **Special** menu, select **Shut Down**.

Your Mac ejects any floppy disks and shuts down.

**To eject a stubborn disk that refuses to come out**

1. Unbend a paper clip and push the straight edge into the little hole to the right of the floppy drive opening.

2. Give a quick push when you feel some resistance. Your disk should pop out.

Use this procedure only as a last resort!

**Notes**

Ejecting a disk by sliding its icon to the Trash Can clears the disk from the Mac's memory. If you eject a disk by pressing `⌥-E`, don't be surprised if your Mac asks you to perform the dreaded disk-swapping ritual (Please insert the disk...). Try pressing `⌘-.` to get rid of this message.

An internal drive appears as a slot on the front of your machine. An external drive is a separate little box attached to your machine with a cable.

See also **Disk Drives, Disks, and Keyboard Shortcuts**.

---

**E-Mail**

Electronic Mail (E-Mail) is a messaging system that permits users to send and receive "mail" electronically to and from other people on the same network. You can send E-Mail through local area networks or use it with information services (such as CompuServe and Prodigy) to connect with other users. These systems usually give you a message when you sign on if someone has sent you mail.

See also **Bulletin Boards, Networking, Modems, and Telecommunications**.
Erasing Disks

When you *erase* a disk, all files and data contained on the disk disappear and the disk is left entirely blank.

**To erase a disk**

1. From the desktop, select the disk you want to erase.

2. Under the *Special* menu, select *Erase Disk*.

You will see an alert box (see fig. E.1).

![Erase Disk alert box](image)

*Fig. E.1. The Erase Disk alert box.*

>Note: When you erase a hard disk, there are only two buttons: Cancel and Initialize.

3. Confirm that you want to completely erase this disk by clicking *Two-Sided* (or One-Sided, if necessary). If, at this point, you’re not sure what you’re doing, click *Cancel*.

4. Respond to the on-screen prompts.

**Notes**

Be very, very careful. Make sure you really want to erase the disk before completing this procedure.

Reformatting a disk erases data on that disk.

See also *Deleting, Disks*, and *Initializing Disks, Recovering Data*. 
Error Messages

Things don’t always run as smoothly as you might like. When something goes wrong with your Mac, your program, or your data, you probably will see an error message. Error messages usually appear as alert boxes. The messages result from sophisticated diagnostics that your Mac runs when you start up the computer and an ongoing set of tests it runs as you work.

For example, if you have a problem during the startup, you see a sad Mac face with a code underneath, rather than the usual happy face Mac. These characters represent the type of startup error that has occurred.

Codes that start with the characters OF, denote software failure (perhaps a corrupted system). When the first two characters are something other than OF, the error is usually a hardware startup error. Other errors that can occur are system errors when the Mac freezes, or ROM errors resulting from software problems.

See also Crashes, Maintenance, Recovering Data, and Troubleshooting.

File Compression

How to get more from less? Generally, the more space you have on your hard disk, the more you use. And eventually, you’ll run out of room. When you do, you don’t necessarily have to get a bigger hard disk, when you can use a variety of utilities to compress the disk information. When this information is compressed, it requires as much as twenty to fifty percent less space, thereby increasing the amount of information your disk can hold. This is great for archival backups.
Compressing files also greatly reduces the time it takes to transfer files over a modem, and therefore telecommunication charges. Stufflt (Aladdin Systems) is the industry standard for file compression, and now Stufflt Deluxe offers even more features. Disk-Doubler (Salient Software) also is a handy compression tool that, when installed, becomes an option on the Main menu.

Remember, once a file is compressed, you must decompress it before you can use it.

---

**File Formats**

File formats refers to the structure used to record information on a disk. Different applications create files in different file formats. As with foreign languages, different applications speak in their own dialects.

There are a variety of formats that Macintosh applications use to save files. Following is a brief description of each format.

- **DIF** (data interchange format) is used for saving numbers in each cell in a spreadsheet without transferring formulas.
- **RTF** (rich text format) is a special exchange format used to transfer data between Microsoft applications.
- **SYLK** (symbolic link) allows numerical data and formulas to be transferred.
- **Text/ASCII** converts files created with a particular application into text-only generic files based on ASCII codes. Text files are easily read by and transferred from program to program across different computer platforms.
• WKS (worksheet) is used to transfer files to Lotus 1-2-3 and Symphony on PC-compatible machines.

• EPS (encapsulated Postscript) is part PICT in how it displays a drawing and part Postscript code in how it prints a drawing. EPS files can be gray-scale or colored.

• PICT, PICT1, and PICT2 are image-saving picture formats usually used by object-oriented draw programs such as MacDraw II. PICT images can be in color. PICT was created for the purpose of exchanging pictures between applications.

• PNTG is the most common image-saving format used by paint programs such as MacPaint. It stores only black and white bit-mapped images, and is limited in size and resolution. PNTG images usually appear jagged when printed.

• TIFF (tagged image file format) are bit-mapped files which can vary in resolution (DPI). TIFF is usually used for black and white scanned images.

Most programs provide for the importing of, and the exporting to, different file formats. Unlike PC files, the Macintosh file format is not contained in a file name.

**Graphic formats**

Graphics programs include painting, drawing, and page layout software such as MacPaint, PageMaker, and Illustrator. Format, however, refers to the recording of images. For example, MacPaint files are created in the file format known as PICT. Mac applications also use several other formats such as TIFF, EPS, and PICT2.
Before you begin using one application to create a graphic to use in another application, be sure that the two applications are compatible. The best way to check compatibility is to consult the application manual or call the company’s technical support. Most applications are moving toward full compatibility, and many can convert “foreign” formats into usable, application-specific formats.

**Text formats**

In text and spreadsheet applications such as Microsoft Excel and Microsoft Word, (and “foreign” applications such as Lotus 1-2-3), format refers to recording characters, usually represented by a string of single digits.

Most word processors provide a full range of file format options that enable you to save a file in the format that another word processor uses. For example, Microsoft Word permits you to save a file in your choice of format—even Microsoft Word for the PC (see fig. F.1). Most spreadsheets allow the same flexibility. For example, Excel permits you to save files in the formats of DIF, SYLK, WKS, CSV, and, of course, text.

The universal file format is text or ASCII (American Standard Code for Information Interchange), the plain Jane of file formats. This format contains only text itself—no fancy format codes or other application-specific changes. ASCII is reliable and is the most available code.
Fig. F.1. Microsoft Word saves files to a variety of file formats.

**To save a file to a different file format**

1. With your file open on-screen, from the **File** menu, select **Save As**.

2. If you see a file format selection button, select the format you want to save to—for example, **Text Only**. If you do not see a selection, look for a button that will provide you with such a list, such as a Format or Options button.

3. Type a name for your new file. Keep in mind that files on a PC are limited to eight characters with a three letter extension, such as LETTER12.DOC.

4. Click **OK**, or press **Return** or **Enter**.

**To open a file in a different file format**

1. Launch the application you want to use as the new file format. For example, double-click on the icon for Microsoft Word.

2. From the **File** menu, select **Open**.

3. Double-click on the name of the file you want to open. You may have to scroll or change to a different disk or folder to find the file.
In some programs, you may have to select a button such as **Show All Documents** to view files saved to a different format.

4. Answer any on-screen prompts, if necessary.

5. When the translated document appears on-screen, from the **File** menu, select **Save (⌘-S)**.

6. Type a name for your new file and press **Return**.

See also *Data Conversion, Opening Files,* and *Saving.*

### Files

A file is a set of information stored on a disk under a unique name. On the desktop, files are represented by icons (if that’s how you choose to view them) and organized according to the Mac’s Hierarchical Filing System (HFS). File names are limited to 31 characters (including spaces), and may contain any character except the colon.

**To create a file**

Generally, new files are created and named within applications, however, there are several ways to create a file:

- Launch the application you want to use to create your file. For example, double-click on the MacDraw II icon to create a drawing, or double-click on the WriteNow icon to type a letter.

- Open a document similar to the one you want to create. For example, to write a report, double-click on the icon for the report you created last time. To create a logo using Freehand, double-click on the icon of another Freehand document.
• Select the icon of a document similar to the one you want to create and duplicate that icon. For example, find the icon for your resume created in WordPerfect and select it. Under the File menu, select Duplicate. Double-click on the icon of the file you just created entitled, “Copy of filename.”

Once you have a document open on-screen, you can do one of three things:

• Close the document. From the File menu, select Close. Then, open a new blank document. Under the File menu, select New.

• Save the open document to a new name. From the File menu, select Save As.

• Select everything on-screen and delete it. From the Edit menu, select Select All. Then press Delete. You also can delete everything by dragging the I-beam to highlight all the text, or by drawing a marquee around a group of items to select them, and then press Delete.

Don’t forget to save your new work!

To create a file from within an application

1. Launch the application that you want to use. For example, double-click on the icon for MacWrite II.

2. In most applications, you will see a blank document appear in front of you. If all you see is the menu bar, from the File menu, select New (⌘-N).

Your file is officially “created.” You may start typing or working on your document, or may choose to save your file right away.

Don’t worry, your Mac won’t let you quit without first reminding you to save your work.
To open an existing file from the desktop
Double-click on the icon of the file you want to open.

To open an existing file from within an application
1. From the File menu, select Open (⌘-O).
   If the Open selection is gray, you may first have to close your current file. From the File menu, select Close.

2. Select the disk or folder in which the file resides. Select a new disk by clicking on the Disk button. Select a new folder by clicking on the folder name above the file listing.

3. Scroll through the file list until you find the file you want.

4. Double-click on the name of the file you want to open, or select the name and click Open.

To save a file
1. With the document you want to save open on-screen, from the File menu, select Save (⌘-S).

2. Type a file name.

3. Click OK, or press Return or Enter.

To save a file to another folder
1. With the document you want to save open on-screen, from the File menu, select Save (⌘-S).

2. Select the folder you want to contain the saved file. Click on the folder names in the Save dialog box to open them. Click on the folder button above the file listing to go up to a higher level of organization.

3. Type a file name.

4. Click OK, or press Return or Enter.
To save a file to another disk
1. With the document you want to save open on-screen, from the File menu, select Save (≡-S).
2. Click the Drive button in the Save dialog box until the name of the disk to which you want to save the file appears.
3. Type a file name.
4. Click OK, or press Return or Enter.

To print a file from the desktop
1. Click to select the icon of the document you want to print.
2. From the File menu, select Print (≡-P). Make changes in the Print dialog box, if desired.
3. Click OK, or press Return or Enter.
If the application that created the document is available, the file prints. If the application is not available, your Mac tells you so.

To print a file from within an application
1. With your document open on-screen, from the File menu, select Print (≡-P).
2. Make changes in the Print dialog box, if desired.
3. Click OK, or press Return or Enter.

To print multiple files created using the same application
1. On the desktop, using the shift-click technique, select the files you want to print.
2. From the File menu, select Print (≡-P).
3. Click OK, or press Return or Enter.
To rename a file from the desktop
1. At the desktop, click on the file name. If the pointer doesn't turn into an I-beam, click again.
2. Type the new name for the file.
3. Click OK, or press Return or Enter.

To rename a file from within an application
1. With the file you want to rename open on-screen, from the File menu, select Save As.
2. Type the new name for the file.
3. Click OK, or press Return or Enter.

This procedure creates a second file; it doesn't overwrite the first file. You may want to throw away the original file when you return to the desktop.

To move a file from one folder to another on the same disk
1. On the desktop, open the folder containing the file you want to move and the window containing the folder to which you want to move the file.
2. Drag the icon of the file you want to copy to the folder window.
3. Release the mouse button.

To copy a file from one disk to another
1. On the desktop, select the icon of the file you want to copy.
2. Drag the icon of the file you want to copy to the icon of the disk you want to copy to (the destination disk).
3. When the icon of the destination disk reverses, release the mouse button.
To accomplish this procedure from within an application, use the Save As command, and select the appropriate drive using the Drive button.

*To copy several files from one disk to another*
1. At the desktop, press and hold the Shift key.
2. Click to select an icon of a file you want to copy. Repeat to select all the icons you want to copy.
3. After you select all the icons you want to copy, release the Shift key.
4. Point to any one of the highlighted icons. Press and hold the mouse button.
5. Drag that icon on top of the icon of the destination disk.
6. When the icon of the disk reverses, release the mouse button. All the files copy.

This technique is called shift-clicking. An alternative to shift-clicking is to draw an imaginary box—a marquee—(using your pointer) around the files you want to include.

*To copy a file from one folder to another folder on the same disk*
1. Press and hold the Option key.
2. Drag the icon of the file you want to copy to the destination folder.
3. When the icon of the destination folder reverses, release the mouse button.

*To duplicate a file from the desktop*
1. At the desktop, select the file you want to duplicate.
2. From the File menu, select Duplicate (⌘-D).

An exact copy of the file is created and named Copy of original filename, where original filename is the
name of the original file. The original file remains unchanged.

To duplicate a file from within an application
1. With the file you want to duplicate open on-screen, from the File menu, select Save As.
2. Type a new name for the file.
3. Click OK, or press Return or Enter.

This procedure creates a second file; it doesn’t overwrite the first file. The original file remains intact.

To delete a file
1. At the desktop, point to the icon of the file you want to delete.
2. Press and hold the mouse button.
3. Drag the icon to the Trash Can, located in the lower right corner of the desktop screen.
4. When the Trash Can icon reverses, release the mouse button.

To delete several files, use the shift-click technique, or draw a marquee.

To empty the trash can of all the files you deleted
From the Special menu, select Empty Trash.

To view a listing of files
At the desktop, under the View menu, select the type of listing you want.

You can view by icon, small icon, name, date, size, or kind. On color monitors, you also have the option of viewing a listing sorted by color.

To lock a file
1. At the desktop, select the icon of the file you want to lock.
2. From the File menu, select Get Info (⌘-I).
3. Click in the **Locked** box in the upper right corner. ✗ means the file is locked.

When a file is locked you can view and copy the contents, but you cannot alter the contents or throw away the file.

---

**To place a file on the desktop**

1. At the desktop, open the folder containing the file you want to put on the desktop.

2. Select the icon of the file, and drag it to the desired location on the desktop.

*Note:* You cannot do this under System 7.

---

**To put back to its original location a file that appears on the desktop**

1. Select the icon of the file on the desktop you want to put back.

2. From the **File** menu, select **Put Away**.

---

**To recover a file name that you inadvertently changed**

1. Before you perform any other action, backspace until all of the characters in the file name are deleted.

2. Press **Return** or **Enter**.

---

**To get information about a file**

1. Select the file or application that you want information about.

2. From the **File** menu, select **Get Info** (⌘-I).

3. Type comments in the info box, if you want.

4. Click the close box.

The Get Info window contains file information such as the kind, size, version number, location, date created, and date last modified.
Notes

The Save As command enables you to save an active file under another name. This command is useful when you want to use the same file over (such as a letter) with some slight modification.

See also Copying, Deleting Files, Duplicating, Folders, Get Info, Locking, Printing, Saving, Scrolling, and Trash Can.

Financial Programs

Financial programs fall into general categories such as accounting, tax preparation, financial forecasting, business planning, personal finance planning, and financial analysis. Accounting applications are by far the largest group of financial programs available; these programs range from basic applications such as a simple checkbook (see fig. F.2) or general ledger, to complex and sophisticated accounting packages that are relational databases disguised as seamlessly integrated modules.

Fig. F.2. Using Quicken to keep track of expenses.
Because the push for these high-level packages has left many small businesses in the gap between simple applications (which are easy to use but incomplete) and complex programs (which offer far too much for the small business operator), many developers have offered middle-of-the-road packages. These packages have a lot of power, but don’t require a high level of understanding of accounting principles.

**Find File**

You may not believe it now, but sooner or later your hard disk (if you have one) will be filled with hundreds of files. With all those files, how can you find the one you need, especially if you forgot what folder you placed it in? The Find File desk accessory searches through any folder or disk, and can locate a file by name—even an incomplete name.

Figure F.3 shows the results of a search for files that contain the letters “sys” in the file name. Notice that Find File searches for all occurrences of the name; it doesn’t stop after finding the first one. You can click on a file icon in the listing to see where that particular file is located.

![Find File](image)

**Fig. F.3. Using Find File to search for a file.**
To find a file

1. From the Apple menu, select Find File.

2. Type the name (or partial name) of the file you're looking for in the Search for: box.

3. Click on the icon of the little person on the right side of the window.

   Find File searches the disk and lists the files containing the letters you specified.

4. To find out how to access the listed files, click on the name of one of the files listed in the center of the window.

   In the lower right corner of the window, you see a listing of the folders you need to open to get to that particular file.

   In the lower left corner of the window, you see information related to that particular file.

5. To move a file temporarily to the desktop, from the Find File menu, select Move to Desktop (⌘-M).

6. Click the close box to exit Find File.

To search for files on a different disk

1. From the Apple menu, select Find File.

2. From the Find File menu, select Search Here.

3. Indicate where you want Find File to search.

4. Follow the procedures to find a file.

You also can click on the disk icon in the upper left corner of the Find File window until you see the name of the disk you want to search.
Find File doesn't take you to the file you're looking for. It doesn't open the file up. It only tells you where to find the file. You still need to return to the desktop and open the necessary folders to get to the file you want.

See also Desk Accessories, Files, and Get Info.

The Finder is an important part of Macintosh system software and is the control center for the Mac desktop. The Finder is a file (and an application) that provides you with the tools to manage how the files are organized and manipulated on the desktop. The Finder performs the following tasks:

• Manages documents and applications.
• Ejects disks.
• Initializes and erases disks.
• Opens, closes, copies, moves, renames, and deletes desktop elements.
• Organizes the desktop.
• Provides information from the Info box.
• Starts up and shuts down your Mac.

Because your Mac looks to the Finder for instructions on organizing the desktop when it starts, it's important that you only have one Finder on any one disk (floppy or hard).

You may find that you need to organize your desktop according to the "instructions" contained in an alternate Finder. For example, you may be using more than one hard disk and the non-dominant disk (the
one whose System is not active) contains fonts or desk accessories you need to access.

To “mount” a new Finder

1. Open the file containing the new Finder.
2. Press and hold the Option key and the 3€ key.
3. Double-click on the Finder icon.

Notes

The dominant Finder is always represented by the icon in the upper right corner of the desktop.
The Finder is inactive when MultiFinder is running.
See also System.

Fkeys

Fkeys are short programs you define to perform a specific task so that you don’t have to enter all the keystrokes. You invoke an Fkey by pressing the 3€ and the Shift keys in combination with a number (1 through 9, or 1 through 12, depending on the keyboard you use). Fkeys are stored in the System Folder.

Predefined Fkeys

<table>
<thead>
<tr>
<th>Keys</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>3€-Shift-1</td>
<td>Ejects a floppy disk from the internal disk drive.</td>
</tr>
<tr>
<td>3€-Shift-2</td>
<td>Ejects a floppy disk from the external disk drive.</td>
</tr>
<tr>
<td>3€-Shift-0</td>
<td>Ejects a floppy disk from the third disk drive (if you have one).</td>
</tr>
<tr>
<td>3€-Shift-3</td>
<td>Creates and saves a MacPaint file from whatever is on the screen.</td>
</tr>
</tbody>
</table>
(This combination does not work with all applications.)

⌘-Shift-4  Prints the contents of the active window (on ImageWriters only).

---

**Notes**

If you hold down the **Caps Lock** key when you press ⌘-Shift-3, you get a screen dump of just the active window.

Thousands of Fkey utilities are available through public domain sources (check the listings in the back of your favorite Mac magazine). As new utilities are created and the limit for the number of desk accessories is eliminated with System 7, however, Fkeys may become a thing of the past.

See also **Desk Accessories**, **Font/DA Mover**, **Macros**, **System**, and "**SYSTEM 7 FIRST LOOK**."

---

### Folders

Just like the folders you have in your file cabinet, Macintosh folders hold related information in one location. A folder can contain files, other folders, graphics documents, or any type of information.

One of the strong points of the Mac's hierarchical filing system is its capability to store files within folders and folders within other folders. You can have as many folders as there is room on your disk. A good rule of thumb for organizing your work is to have only folders, and no files, on the desktop at the root (the first level) of your filing system.

You can rename folders just as you can rename files or other icons. Be careful not to rename application folders because other utilities and programs often require a specific name to do their job.
The following tasks occur at the desktop.

**To create a new folder**
1. From the **File** menu, select **New Folder (⌘-N)**.
   
   A new folder labeled "Empty Folder" appears on your desktop.

2. Type a name for the folder.
   
   You now may slide items into your new folder.

**To open a folder**

Double-click on the icon of the folder you want to open.

**To move a folder**

1. Point to the icon of the folder you want to move.

2. Press and hold the mouse button.

3. Drag the folder to the new location.

4. Release the mouse button.

**To place an item into a folder**

1. Point to the item (file, folder, etc.) you want to place in your folder.

2. Press and hold the mouse button.

3. Drag the item onto the desired folder.

4. When the folder icon reverses, release the mouse button.

**To remove an item from a folder**

1. Double-click on the folder that contains the item you want to remove.

2. Drag the icon you want to remove out of the folder and to the new location.

3. Release the mouse button.
To rename a folder

1. Double-click on the folder name if the name is only one word, or drag the I-beam over the text if the folder name is more than one word.

2. Type the new name.

Notes

If your cursor does not change to an I-beam, and you are unable to rename a particular folder, the folder may be locked. To check a folder’s status, from the File menu, select Get Info. A locked file/folder has a 1:8:1 next to the box marked “Locked.” To unlock a locked file, click on the 1:8:1, then click the close box.

To get rid of a folder, slide the icon to the trash. Be sure to check the contents first!

See also Files.

Font/DA Mover

The Font/DA Mover is the Apple utility that installs fonts and desk accessories. Installation involves moving files from one location (usually a floppy disk) into the active System on your hard disk or startup disk.

Preparing to use the Font/DA Mover

In order to install a new font or desk accessory successfully, you must have the following:

• The Font/DA Mover application. If you do not have this application on your hard disk or startup disk, you can find the Font/DA Mover on one of the Utilities disks that came with your Mac.

• A source file. A source file (usually on a separate floppy disk) contains the font or desk accessory you want to install.
• A destination file. A destination file is the file you want to contain the new font or desk accessory. This file is usually the System file contained in the System Folder, or on your hard disk or startup disk.

**To install a new font**

1. Double-click on the **Font/DA Mover** icon (see fig. F.4).

![Font/DA Mover](image)

*Fig. F.4. The Font/DA Mover icon.*

2. Insert your source disk into the floppy drive.

3. On one side of the dialog box, click the **Open** button to select the location of your source file. Click **Drive** if necessary. Double-click on the file when you find it.

4. On the other side of the dialog box, click the **Open** button. Double-click on the System file when you find it. If you make a mistake or change your mind, click the **Close** button. The Close box then turns back into an **Open** button for you to indicate your new selection.

5. Select the font that you want to copy from the source disk list (see fig. F.5). Scroll if necessary. Shift-click to select more than one font.

As you select an individual font, a sample of the typeface appears at the bottom of the window. If you select more than one font, the typeface does not appear.

6. Click the **Copy** button to install the font(s).

7. Click **Quit** to exit the Font/DA Mover program.
To install a new desk accessory
1. If you already activated the Font/DA Mover, click the Desk Accessory button to see desk accessories rather than fonts.

2. Insert the DA source disk into the floppy drive.

3. Click one of the Open buttons in the window to reveal the contents of the DAs on the source disk.

4. Click the other Open button to find and open your System file (the destination).

5. From the list on your source disk, select the DA(s) you want to install on the System. Shift-click to select more than one.

6. Click Copy.

7. Click Quit to exit the Font/DA Mover program.

To install a new font or desk accessory directly into a specific application
1. Launch the Font/DA Mover in the usual fashion (see preceding instructions).

2. Before you click one of the Open buttons to select a destination file, press and hold the ⌘ key.
3. Click one of the **Open** buttons on the window to select a destination file.

At this point, you will see a list of applications, rather than a listing of just document files.

4. Select the application into which you want to install a font or desk accessory, and continue with normal Font/DA Mover procedures.

**To remove a font or desk accessory**

1. Double-click on either the **Font/DA Mover** application icon or any Font/DA Mover file in your System Folder.

   The Font/DA mover opens with the Font option selected.

2. Click the **Desk Accessory** button to view the list of desk accessories.

3. Highlight the item you want to remove.

4. Click **Remove**.

**Caution:** Copy the unwanted font or desk accessory to another file (or create a new file to contain that item) prior to removing the item from your System. Who knows? You may want it later.

**Notes**

You can launch the Font/DA Mover application by double-clicking on the application icon or by double-clicking on any Font/DA Mover file.

You are limited to fifteen desk accessories in your System file. Each one takes up RAM, so be selective as to which ones you install.

If you think that using the Font/DA mover is too much trouble, be patient. System 7 will enable you to install fonts and desk accessories simply by dragging files into a folder.
See also Desk Accessories, Fonts, and "SYSTEM 7 FIRST LOOK."

**Fonts**

A font is a collection of letters, punctuation marks, numbers, and symbols that appear in the same typeface, style, and size. Because each font conveys a message, selecting and using a font impacts the effectiveness of a document.

With fonts you can be classy: you can use " instead of ", enhance text with italic rather than underline, and add *Style* to your *substance*.

Your Mac's System Folder contains some standard fonts including Chicago, Helvetica, Monaco, New York, Geneva, Times, Courier, and Symbol (see fig. F.6). More fonts can be added using the Font/DA Mover.

**Chicago, Courier, Geneva, Helvetica, Monaco, New York, Times, Ψμβολ (Symbol)**

*Fig. F.6. Standard Macintosh fonts.*

In addition to standard typewriter letters and symbols, you can generate special characters such as ® and ¯ by using the **Option** and **Shift** keys in combination with standard alphanumeric keys. You can view these special symbols by using the Key Caps desk accessory.

**Points, picas, and styles**

Fonts are made up of type. A type size is expressed in picas and points. Six picas equal one inch and 12 points equal one pica (72 points equal one inch).
Type weight refers to the heaviness on the letters. Type angle refers to the slant or degree of rotation of type. Type style refers to\textbf{boldface}, \textit{italic}, outline, shadow, \underline{underline}, and other style options that come with most Mac applications.

**Types of fonts**

The two types of fonts are bit-mapped fonts (also called screen fonts) and outline fonts (also called PostScript fonts). A bit-mapped font is created when a particular pattern of dots or pixels (picture elements on your monitor screen) is filled in. The shape of the character depends on the pattern of dots on the screen; therefore, each sized character requires a separate pattern of dots. An outline font, however, is stored as a mathematical expression that generates the outline of the font, rather than as a pattern of filled-in pixels. With an outline font, a new size of a particular font is generated by changing the equation, rather than generating a new pattern of dots as with bit-mapped fonts.

**Bit-mapped fonts**

A bit-mapped font is a font in which the characters in the set are composed of a pattern or a matrix of dots. Because each dot represents an individual piece of information, bit-mapped fonts can take up lots of room, especially the larger point sizes.

Bit-mapped fonts are designed for dot-matrix (the ImageWriter line) printers. Bit-mapped fonts are usually named after a city such as Geneva, Venice, or Monaco. The icon for a bit-mapped screen font is shaped like a suitcase (see fig. F.7). You install bit-mapped screen fonts on your System using the Font/DA Mover.
Fig. F.7. The icon for a bit-mapped font (left) and an outline font (right).

Because bit-mapped fonts consist of dots arranged in a pattern, they don’t look terrific when printed on a laser printer, which accentuates the dots. The jaggies or staircase effect is especially apparent with type over 18 points in size (see fig. F.8).

**Chicago and Monaco**

**Helvetica** and **Times**

Fig. F.8. Bit-mapped fonts (top) vs. outline fonts (bottom).

Although you cannot get rid of these jaggies entirely, utilities such as Adobe Type Manager help smooth the appearance of the type. You also can select the **Smoothing** option from the **Page Setup** dialog box, which helps remove some of the roughness.

**Outline fonts**

When laser printers came along, the demand for high-quality fonts became tremendous. The old, bit-mapped fonts that were acceptable on the ImageWriter just couldn’t do the job when the resolution was increased to 300 dpi.

Now, thousands of fonts can be downloaded to your printer and programs such as Fontographer, TypeAlign, and SmartArt, are available to help you design and manipulate fonts to suit your particular needs.
To change a font selection

1. Highlight the text you want to change.

2. From the Format, Font, or Type menu (depending on the application), select the name of the font and/or the font size.

As long as your text is highlighted, you can reapply different fonts until you find the font you want to use.

You can select the font and font size before or after you enter the text.

To change a font size or style

1. Highlight the text you want to change.

2. From the Format, Font, or Type menu (depending on the application), select the font size and style you want to apply to your highlighted text.

Most programs have keyboard equivalents you can use to apply styles and increase/decrease point sizes. Check your on-line help screens or the documentation that came with the software.

Notes

Two different fonts within a given document are plenty. The same is true for font sizes and styles. Don’t go nuts just because you can!

If you are going to download fonts to your printer, be aware that each font has its own identification number and new fonts are assigned a number. If the font you download has the same ID number as one already present, you will not get the printed font that you expect.

See also Font/DA Mover, ImageWriter, Key Caps, LaserWriter, Points, Special Characters and the “QUICK KEY GUIDE.”
The great graphics that the Mac brings to personal computing and the creative genius of the people who work with the Mac have produced some absolutely addicting games. There are software programs that resemble common games, from Yahtzee to Solitaire; baseball to hockey. There's something for everyone. As Macs get faster and have more memory available, increasingly sophisticated games appear (see fig. G.1).

The best games (of which there are many shareware versions—check your Mac magazine) should fulfill the following criteria:

- Provide entertainment and enable you to do things you could not otherwise do, such as play one-on-one with Michael Jordan or fly an F-16 jet.
- Permit you to save your game so that you can pick up where you left it.
- Keep track of the highest scores.

![Fig. G.1. The game Tesserae (Inline Design).](image-url)
• Contain on-line help.

• Provide engaging visual and sound effects that make you feel as if you are right in the race car or in the baseball stadium.

• Provide hints along the way if you need them so that the frustration does not get intolerable.

• Enable you to change the characteristics of the game, such as the speed and shape of the target, the point values, or the consequences.

• Come from a company that offers technical support and some type of update to the game.

See also *Bulletin Boards* and *Buying Software*.

---

**Get Info**

The Get Info box provides you with detailed information about a file or a folder. You access the Get Info box from the File Menu on the desktop. The following information is available:

• File kind
• File size
• File location
• Date of file creation
• Date of last modification
• Version of the application (if appropriate)
• Locked status of the file
• Suggested Memory Size
• Application Memory Size

You also can enter comments about the file at the bottom of the Get Info box (see fig. G.2). Note that you can enter more comments than the size of the box seems to allow—use the arrow keys to scroll through the comment.
To view information about a file or a folder
1. At the desktop, select the icon for the file or folder you want information on.

2. From the File menu, select Get Info (⌘-1).

3. Click the close box to close the Get Info box.

To attach a comment to a file or folder
1. At the desktop, select the icon for the file or folder you want information on.

2. From the File menu, select Get Info (⌘-1).

3. Type your comments. Comments are saved automatically.

4. Click the close box to close the Get Info box.

To lock a file or folder
1. At the desktop, select the icon for the file or folder you want to lock.

2. From the File menu, select Get Info (⌘-1).
3. Click in the Locked box.的设计ates "locked."

4. Click the close box to close the Get Info box.

To unlock a file or folder

1. At the desktop, select the icon for the file or folder you want to unlock.

2. From the File menu, select Get Info (⌘-I).

3. Click in the Locked box. The "X" disappears.

4. Click the close box to close the Get Info box.

See also Files and Locking.

Graphics Programs

You could consider every Mac application to be a "graphics" application. In addition to the newer graphics applications such as presentation graphics and multimedia, the Mac has graphics programs for a wide range of uses—everything from producing a newsletter to creating an organizational chart.

Graphics programs represent a general class of applications that fall into two major categories: paint programs and draw programs. The primary distinction between the two is how they create graphic images.

Paint programs, such as MacPaint, use bit-mapped images by darkening screen pixels to create the pattern that forms the object. You can manipulate the shape of a paint object by using tools to add or delete individual bits. This flexibility is an advantage of paint
programs. A disadvantage is that the resolution of these bit-mapped paint images may not be high enough for finished art work, although there are paint programs (such as SuperPaint) that can produce paint images with a resolution of 300 dpi.

Draw programs are object-oriented and, therefore, do not create an item as a configuration of dots. Instead, draw programs generate a mathematical expression that produces the outline of the drawn object. Each mathematical expression is represented as a separate physical layer so that you can draw one object and then place it over another without a conflict between the two. Because you are dealing with intact objects, the individual objects cannot be manipulated to the same degree as bit-mapped images, although they can be resized.

The major advantage of draw programs is the high degree of precision with which you can create images and the smooth edges that characterize the finished graphic when printed. Draw programs were (and still are) the basis for the Computer-Aided Drafting/Drawing programs, such as AutoCAD and Generic CADD.

See also Desktop Publishing, DPI, and Draw Programs.

---

**Help**

The quality of help varies tremendously among applications. Some applications offer terrific on-screen help, while others offer nothing more than a sentence or two of copyright information.

There are two types of on-line help: help as a menu item and context-sensitive help. The first allows you
to select Help as an item on the main menu or Apple menu. The second type of help provides you with a directory from which you select a topic. For example, in Figure H.1, “Borders” was selected from the main Help list, and Microsoft Word produces a sizeable amount of information about the particular feature, including the page number in the manual where you can find more information.

The second type of help is called context-sensitive help. You don’t have to go to a separate menu item to access context-sensitive help. Usually a keystroke combination produces a help screen about a particular topic or menu item. With Microsoft Word, for example, when you press the ⌘-? key combination or press the Help key, the mouse pointer takes the shape of a question mark. Use this new mouse pointer to select a feature when you want help.

See also Balloon Help in “SYSTEM 7 FIRST LOOK.”
Highlighting Text

To make any changes to text, you first need to highlight it. After you highlight text, you can change the font, point size, and style; you can delete it, replace it with other text, cut it and paste it somewhere else, or copy it and paste it somewhere else.

The I-beam is the tool with which you select text. At the desktop, the mouse pointer automatically turns into an I-beam when you click on a file name.

In some programs, including most graphics programs, you must select the text tool prior to manipulating text.

To highlight a word

1. Point to any character in the word you want to highlight.
2. Double-click the mouse button and the word highlights (see fig. H.2).

To highlight part of a word

1. Place the mouse pointer to one side of the first word you want to highlight.
2. Press and hold the mouse button.
3. Drag the I-beam in the direction opposite where you first clicked, to highlight the desired letters.
4. Release the mouse button.

Fig. H.2. Double-clicking to highlight a word.
To highlight several words

1. Place the mouse pointer to the left of the first word you want to highlight.
2. Press and hold the mouse button.
3. Drag the I-beam to the right to highlight the desired words.
4. Release the mouse button (see fig. H.3).

Fig. H.3. Highlighting several words.

To highlight a portion of text

1. Click at one end of the section you want to highlight.
2. Press and hold the **Shift** key.
3. Drag the I-beam across the characters you want to highlight.
4. Release the mouse button and the **Shift** key.

To highlight a large portion of text

1. Click at one end of the section you want to highlight.
2. Scroll to the other end of the selection you want to highlight.
3. Press and hold the **Shift** key.
4. Click the mouse button at the end of the text you want to highlight.
5. Release the **Shift** key.
Notes

When highlighting text, you can drag left to right or right to left. You can start highlighting at the bottom of a document and drag up, or vice-versa.

If you have an extended keyboard, you can highlight text without using your mouse. Use the arrow keys to position the I-beam at one end of the text you want to highlight. Press and hold the **Shift** key. Use the arrow keys and the **Home**, **End**, **Page Up**, and **Page Down** keys to select text.

You can triple-click to highlight a paragraph in Microsoft Word.

See also **Copying**, **Cutting**, **Mouse**, and **Pasting**.

---

**HyperCard**

HyperCard is best described by the author of the original program, Bill Atkinson, as a software erector set. HyperCard literally lets you create anything from a simple phone directory to a complex program including animation and sound. HyperCard consists of several different building blocks, using the Metaphor of the library index with cards at the most basic level.

A card is one screen's worth of information, and the basic unit of any HyperCard stack. A stack is a collection of cards. On any one of the cards, you can have a variety of information, such as text and graphics, charts, access to sounds, and even animation.

Each card in a stack contains a background that holds text fields, buttons, and graphics. Figure H.4 shows a typical HyperCard application. The background is the information common to all cards in this stack,
such as the lines separating months and the spiral down the middle of the date book.

Fields contain text, such as dates or the names of months. You use buttons to travel from stack to stack. A script controls the action of each button. You can edit the script using HyperTalk's simple English commands.

![Date Book Image]

**Fig. H.4. A HyperCard application.**

HyperCard started a revolution because it enabled non-programmers to work with a sophisticated set of commands which produce effects that otherwise require extensive programming skills. As with all good applications, HyperCard has inspired competition. Other software developers are vying for the attention of HyperCard fans, and some are succeeding. SuperCard has made in-roads into HyperCard's market and Spinnaker PLUS, which aims at the business community, is also an attractive alternative.

**Icons**

An icon is a graphic representation of a file, folder, disk, or application. For example, disk icons look like floppy disks and folder icons look like file folders. Icons are the medium through which you work to select, move, copy, and delete files.
Applications create files with distinct icons, yet it is not just the application’s icon that is visually different. Data files (those you create) are distinct as well (see fig. 1.1).

![Application Icons](image)

**Fig. 1.1. Icons for applications and documents.**

See also *Files, Opening Files, ResEdit,* and *Viewing Files.*

**ImageWriter**

In the early Apple days, the ImageWriter line of printers was IT if you wanted to print anything. The first day you got your printer, you thought it was the greatest, right? Then you saw other printers that could print high quality work—faster. Still, because of its price, the ImageWriter remains the printer most commonly used with Macintosh computers. The original Imagewriter (*without* the capital “W”) was relatively inexpensive (about $400 retail) and very reliable. Although Apple no longer manufactures this model, you can still rustle up a used one for about $150.

The redesigned ImageWriter II replaced the old Imagewriter. The new printer offers basically the same features for about $600 retail. The newest ImageWrit-
er is the ImageWriter LQ, with the LQ standing for "letter quality" (although some people swear it stands for "large quantity"). The LQ is cumbersome, weighing-in at about 60 pounds. However, the LQ offers some outstanding features that make it a serious contender for those who need more than the ImageWriter II, but less than a LaserWriter. Some of the LQ features include the following:

- A wider carriage
- An envelope feeder
- Three levels of print quality
- Printing resolution of 216 dpi
- Four resident fonts
- Several paper paths and sheet bins for feeding everything from certificates to mailing labels

The LQ lists for about $1,400, although you can get it for about $1,000. This price is not much cheaper than many of the new laser printers available today. Even ribbons run about $20. For good, low-cost printing, you're not limited to an ImageWriter. GCC Technologies and Brother both offer compatible impact printers that produce an image as good as the LQ for about one-half the price.

See also Buying Hardware, LaserWriter, Peripherals, and Printing.

---

Initializing Disks

When you purchase new floppy disks, they are not ready to use. Think of a new disk as a parking lot on which the lines have not yet been painted. The cars (like the data) have no place to go. When the disk is initialized (the lines painted), the data (like the cars)
know where to park themselves, and your Mac knows where to find the data.

Most hard disks are initialized (formatted) when you purchase them. If your hard disk is not, use the software that came with the drive to complete the initialization process.

You don’t have to remember whether a floppy disk has been initialized or not. Your Mac tells you if the disk you insert is unreadable—it asks you to initialize it (see fig. 1.2).

![This disk is unreadable: Do you want to initialize it?](image)

**Fig. 1.2. Inserting a new floppy disk.**

If you insert a DOS-formatted 3 1/2-inch disk into your floppy drive, your Mac may tell you it's not a Macintosh disk. It then asks you if you want to initialize it. Be careful! Initializing a disk erases any data contained on that disk.

**To initialize a disk**

1. Insert the disk into a floppy drive.
2. At the alert box, click **Two-Sided**.
   - If you have a SuperDrive, click **Initialize**. If you are using old single-sided disks, click **One-Sided**.
3. Click **Erase**. (If you’re not sure about what’s on the disk, click **Cancel**.)
4. Type a name for the disk and click **OK** (or press **Return** or **Enter**).
If you prefer, you can just click **OK** and name the disk later.

**To reinitialize a disk**

1. On the desktop select the disk you want to reinitialize.
2. From the **Special** menu, select **Erase Disk**.
3. Proceed with Steps 2–4 as described in the preceding entry.

This procedure is useful for deleting all data on a disk.

**Notes**

Initializing, formatting, or erasing a disk is serious business and is not the same as deleting all the files on the disk. Initializing removes all the information on that disk, including special disk tables that enable the Mac to resurrect files that may be deleted inadvertently.

If you are going to erase, initialize, or format a disk, think twice about clicking that final **OK** in the dialog box. After you click the mouse button, any data is wiped off the disk! Some utilities (such as Norton Utilities or SUM II) can recover some files from a crashed or formatted disk, but as good as the programs are, there is no guarantee.

Some companies sell initialized disks.

See also *Disks, Erasing Disks* and *Recovering Data*.

---

**INITs**

INITs are small utility programs that add functionality to your system. When placed in your System Folder, INITs load automatically and become active each time you start up your Macintosh. Like any other program, INITs take up a certain amount of RAM and the more INITs you have in your system, the less RAM is available for other Macintosh activities.
Popular INITs

Following is a short list of typical INITs available today:

<table>
<thead>
<tr>
<th>INIT</th>
<th>What It Does</th>
</tr>
</thead>
<tbody>
<tr>
<td>AfterDark</td>
<td>Uses everything from fish to lightning to save your screen from burning in.</td>
</tr>
<tr>
<td>AutoMac</td>
<td>Creates macros to automate keystrokes.</td>
</tr>
<tr>
<td>Cheshire</td>
<td>Creates a variety of graphs based on data within an application.</td>
</tr>
<tr>
<td>DiskTop Express</td>
<td>Enables you to copy, delete, etc., from within an application.</td>
</tr>
<tr>
<td>Image Grabber</td>
<td>Captures screen images as Paint files.</td>
</tr>
<tr>
<td>MultiClip</td>
<td>Creates multiple clipboards.</td>
</tr>
<tr>
<td>SuperClock</td>
<td>Places a clock in the upper right corner of the menu.</td>
</tr>
<tr>
<td>Type Reunion</td>
<td>Organizes similar families of type on the Font menu.</td>
</tr>
<tr>
<td>Virex</td>
<td>Scans your system and disks (inserted in your floppy drive) for viruses.</td>
</tr>
</tbody>
</table>

To install an INIT

1. Insert the floppy disk that contains the INIT you want to install.

2. At the desktop, double-click on the icon of the floppy disk to view its contents.

3. Drag the icon of the INIT you want to install on top of the System Folder on your hard disk or startup disk. **Shift-click** to select more than one INIT.
4. When the System Folder icon reverses, release the mouse button.

5. Under the **Special** menu, select **Restart**.

**To deactivate an INIT**

1. At the desktop, double-click on the System Folder icon.

2. Scroll to find the INIT you want to remove.

3. Drag the INIT out of the System Folder to the desktop or to another folder.

4. Under the **Special** menu, select **Restart**.

**Notes**

When you have several INITs, they may clash, causing a system crash or nullifying one another. If your INITs clash, you must selectively remove INITs from the System Folder or change the order in which they load. INITs load in alphabetical order, so you also can change the order in which INITs load by changing the name of an INIT (from “OnCue” to “zOnCue,” for example). You also can change the INIT loading order through the use of a commercial product such as INITPicker.

See also **CDEVs**, **Crashes**, **System**, and **Utilities**.

---

**Inserting a Disk**

A 3 1/2-inch floppy disk is the only size disk you can insert into a floppy drive on your Mac. The disk you insert must be the same density or lower than the density of your disk drive. For example, a SuperDrive can read a high-density disk, a double-density disk, and a single-density disk. A regular double-density drive can read a double-density or single-density disk; it cannot read a high-density disk. A single-density drive can read only a single-density disk.
To insert a floppy disk

1. Hold the disk with the label facing up and the metal circular piece facing down. Look for the arrow on the floppy disk (see fig I.4). Point the metal shutter toward the drive.

![Fig. I.4. A floppy disk.](image)

2. Gently insert the disk into the drive. You should feel it catch and your Mac will do one of the following things:

- Accept the disk and display a disk icon in the upper right corner of the desktop. Double-click on the icon of the disk to view the disk contents.
- Determine that the disk is “not a Macintosh disk” and ask whether you want to initialize it. If it’s blank, go ahead and initialize it.
- Spit the disk out. The machine is looking for a startup disk. Insert a disk containing a System and Finder, or startup from the hard disk.

See also Disk Drives, Disks, Ejecting Disks, and Initializing Disks.

---

Installing Software

You can install software in a variety of different ways, depending on its type (desk accessory, INIT, and so on) and size. Most software can run off of a floppy disk. But more and more applications, because of their complexity, need to be installed on a hard disk.
Applications installed on a hard disk run much faster and are readily available.

To install desk accessories, use the Font/DA Mover. To install control panel devices (CDEVs) and INITs, drag their icons into the System Folder.

The simplest way to install software on a hard disk is to drag the application icon into a folder you create for that application. Some software applications, however, are larger than the 800K a typical floppy disk holds. These larger applications must be installed or restored using the program that comes with the application. This method requires you to double-click on the installation program (usually named Install) and then follow the on-screen instructions.

**Before you install new software...**

Whenever you have a disk containing new software, the first thing you should do is lock that disk. Locking the disk prevents you from writing new material on top of existing material.

Second, you should make backup copies of each disk(s). Use only the backup copies of original disks—never the originals. Store the originals in a safe off-site location.

**To install new software onto your hard disk (method 1—formal installation)**

1. Insert into your floppy drive the disk containing the software you want to install.

2. On the desktop, double-click on the icon of the floppy disk to view the disk contents.

3. If you see a file labeled “Read Me,” double-click on it. If you see a file labeled “Install,” double-click on it and follow any screen prompts.

   If neither a “Read Me” file nor an “Install” file is present, follow Method 2.
To install new software onto your hard disk (method 2—copying files)

1. At the desktop, from the File menu, select New Folder.

2. Insert the floppy disk containing the application you want to install.

3. Double-click on the icon of the floppy disk to view its contents.

4. If you see a file labeled “Read Me,” double-click on it.

5. From the Edit menu, select Select All (⌘-A) to select all the icons on the floppy disk. Drag the icons from the floppy disk on top of the New Folder icon on the desktop.

6. When the folder icon reverses, release the mouse button. The files copy to the hard disk.

7. Double-click on the icon of the new folder to view the contents.

8. After checking to see that all files copied to the hard disk, drag the icon of the floppy disk to the Trash Can to eject it.

Notes

Some applications come on multiple disks. These programs may need to be installed using the Install procedure. When copying files, be sure to copy all files from all floppy disks into one folder on your hard disk.

Some applications must be unstuffed or decompressed using StuffIt or DiskDoubler prior to use. These files will not work by merely copying the files to your hard disk.

See also Copying, File Compression, Files, and Font/DA Mover.
Besides the mouse, the keyboard is your main communications link to your Macintosh. Keyboards are as personal as any other part of the Mac, and even more so because a keyboard that fits your way of working can make the difference between work and pleasure. The original keyboard came with a total of 58 keys, was small, and didn't have extras such as a numeric keypad or function keys. Today, you can get keyboards with up to 105 keys. You even can purchase modular keyboards that assemble to fit your needs.

Good keyboards have the following characteristics:

• A solid, not a mushy, feel when you press the keys.

• An ergonomic design so that the face of the board is slightly tilted in your direction.

• Optional audio feedback (clicking) when you press the keys.

• Keys that are large enough for moderately large fingers.

• Numeric keypad for fast data and financial entry.

• Programmable function keys.

• Adjustable key resistance.

• Macro software for automating keyboard activities.

Notes

A handy way to make the most out of your extended keyboard is to purchase a program such as QuicKeys² (from CE Software). QuicKeys² enables you to assign several procedures to a particular key. For example,
you can tell your Mac to make highlighted text 14 point, bold, italic, Helvetica—all with the press of one button! You also can insert the current date in a document simply by pressing **Control-D**, for example. Such macro-defining software can save you time and frustration.

See also *Keyboard Shortcuts* and *Macros*.

**Keyboard Shortcuts**

Keyboard shortcuts are key combinations you can press to issue commands, rather than selecting commands from a menu. The commands are identical to those you issue from a menu.

Keyboard shortcuts are available in all Macintosh programs. When you pull down a menu, you notice the menu commands. Do you notice also the frequently overlooked keyboard equivalents listed next to those commands (see fig. K.1)?

![Keyboard equivalents](image)

Fig. K.1. *Keyboard equivalents appear next to menu commands.*

Most keyboard shortcuts use the Command key in combination with character keys. The Command key contains the `&` and `©` symbols. Following are some key combinations that are common to most Mac applications.
### Key(s)

<table>
<thead>
<tr>
<th>Key(s)</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘-C</td>
<td>Copies text or graphics to the Clipboard.</td>
</tr>
<tr>
<td>⌘-F</td>
<td>Finds a word or phrase.</td>
</tr>
<tr>
<td>⌘-N</td>
<td>Creates a new file or folder.</td>
</tr>
<tr>
<td>⌘-O</td>
<td>Opens an existing file.</td>
</tr>
<tr>
<td>⌘-P</td>
<td>Prints an existing file.</td>
</tr>
<tr>
<td>⌘-Q</td>
<td>Quits an application.</td>
</tr>
<tr>
<td>⌘-S</td>
<td>Saves a file.</td>
</tr>
<tr>
<td>⌘-V</td>
<td>Pastes text or graphics from the Clipboard.</td>
</tr>
<tr>
<td>⌘-W</td>
<td>Closes the active window.</td>
</tr>
<tr>
<td>⌘-X</td>
<td>Cuts text or graphics and copies it to the Clipboard.</td>
</tr>
<tr>
<td>⌘-Z</td>
<td>Undoes the most recent command or action.</td>
</tr>
</tbody>
</table>

- - Selects Cancel in a dialog box; cancels a procedure.

- Enter
  - Selects the default in a dialog box.

- Return
  - Selects the default in a dialog box.

- Shift-
  - Moves to the previous field in a dialog box.

- Tab
  - Moves to the next field in a dialog box.

See also the "QUICK KEY GUIDE."

---

**Key Caps**

There are times when you want to change fonts, but you are not sure how the particular font may look. At these times you can use the Key Caps desk accessory. You can select a font on the Key Caps menu and then
see exactly how the fonts in your system will appear in your documents.

**To view font characters**

1. From the Apple menu, select **Key Caps**.

2. From the **Key Caps** menu, select the font you want to view (see fig. K.2).

3. Press and hold the **Option** key, or the **Shift-Option** key-combination, to see which characters are available using a particular font in conjunction with either of these key combinations.

4. Click the close box to exit Key Caps.

See also **Desk Accessories, Fonts, and Special Characters**.

---

**LaserWriter**

The LaserWriter family of printers helped to bring the Mac into the high-tech world of desktop publishing. First came the LaserWriter, then the LaserWriter Plus,
and now a selection of LaserWriters that fits every printing need.

**LaserWriter SC**

Fast on the heels of the LaserWriter Plus (which is no longer manufactured) was the first QuickDraw printer developed by Apple, the LaserWriter SC. This non-PostScript printer was fairly inexpensive (about $2,800), but it still had a good deal to offer such as 1M of RAM, four resident fonts, and a relatively cheap and easy upgrade to the next printer level. Apple no longer manufactures SCs, but you can still find them in the used-computer market.

**LaserWriter IINT**

The LaserWriter IINT is a true PostScript printer, offering a larger range of fonts and sizes. The IINT can be networked with non-Macintosh printers and non-Macintosh computers.

**LaserWriter IINTX**

The top-of-the-line LaserWriter is the LaserWriter IINTX. Its sizeable RAM can be upgraded to 12M—enough to download a large number of fonts. You can store these fonts on the hard disk that attaches to the printer through the printer's SCSI port; you do, however, pay for this convenience.

**Personal LaserWriter SC**

The competition from other companies (such as GCC Technologies and Texas Instruments) has forced Apple to come up with two less-expensive printers: the Personal LaserWriter SC and the Personal LaserWriter NT. The new SC is like the discontinued LaserWriter SC. The new SC is a QuickDraw printer that can't be shared with other computers. At $2,000 retail, however, the new SC is much less expensive than the old SC. The new SC is still not as cheap as other non-PostScript Mac printers, but it is a step in the right direction.
**Personal LaserWriter NT**

The new Personal LaserWriter NT, though not networkable, is a true PostScript printer and costs almost $2,000 less than the original NT. It weighs only about 30 pounds (15 pounds less than the old NT); fits in small spaces; is fast, and is open to adding more memory; and has emulation modes so you can make your Mac think that it is printing to a LaserJet or a Diablo 630 daisy wheel printer—all for less than $3,500 retail.

See also *Buying Hardware, ImageWriter, PostScript, Printing, and QuickDraw.*

---

**Launching Applications**

Launching an application means starting a software program. If you want to write a letter, you launch a word processing program. If you want to create an illustration, you launch a draw or paint program.

**To launch an application**

At the desktop, double-click on the icon of the application you want to launch.

**To launch an application by opening an existing document**

At the desktop, double-click on the icon of the document you want to work on.

The application that created that document launches automatically, and the document appears on-screen.

**Notes**

Several products are available that to help your launching efforts, such as On Cue (from ICOM Simulations) or DiskTop (from CE Software). On Cue creates a pop-up menu of applications in the upper right corner of your screen. You simply select the application you want to use. With DiskTop, you
simply double-click on the DiskTop icon and the application launches.

See also Files, Mouse, Opening Files, and Startup Screen.

**Locking**

Sometimes you may want to safeguard data by locking the floppy disk containing the data. When a disk is locked, you can view the contents, but you cannot change the contents. You can’t even rename a file on a locked disk. You can, however, copy files from a locked disk to an unlocked disk, and then make changes to the copies.

It is good practice to lock all new application disks. For example, when you take out your new PageMaker installation disks, the first thing you do is lock these disks.

**To lock a floppy disk**

Slide open the little plastic switch on the upper corner of the disk so that you can see through the hole.

**To unlock a locked floppy disk**

Slide shut the little plastic door on the upper corner of the floppy disk so that you *cannot* see through the hole.

**To lock an individual file or application**

1. At the desktop, select the file or application you want to lock.
2. From the File menu, select Get Info (⌘-I).
3. Click the box ☐ at the upper right corner of the Get Info screen. ☐ means “locked.”
4. Click the close box.
To unlock a locked file or application

1. At the desktop, select the locked file or application you want to unlock.

2. From the File menu, select Get Info (⌘-I).

3. Click on the box ⌔ at the upper right corner of the Get Info screen. □ means “unlocked.”

4. Click the close box.

See also Files and Get Info.

Macintosh Systems

This section provides a chronological listing of Macs currently available. Although Apple no longer manufactures some of these models, they are available in the used-computer market. Refer to Table M.1 for a comparison of system specifications.

**Mac Plus (discontinued)**

The Mac Plus is no longer manufactured, but can be found in many homes and offices today. The Plus is slower than the rest of the Macs and has some limitations, such as no internal hard disk and limited memory (1M of RAM, expandable to 4M), but Mac Plus is the ideal place to begin.

Introduced in October, 1985, this machine has been the standard for thousands of Mac users, and you can do a great deal with it, including word processing and desktop publishing.

The Mac Plus is especially cost-effective if you need to set up several Macs.

**Mac SE (discontinued)**

Although the SE uses the same CPU as the Plus, and runs at the same clock speed, due to design en-
hancements, the SE runs more than 20 percent faster than the Plus.

The SE has an expansion slot (the Plus does not) so you can use various upgrade cards. You also can upgrade an SE to an SE/30, which you cannot do with a Plus. The Mac SE has plenty of room inside for two floppy drives or an internal hard drive and a floppy drive. This Mac also has been taken out of production.

**Mac II (discontinued)**

The Mac II, introduced in May, 1986, was the top of the line until Apple introduced the IIx series. The Mac II has six slots for expansion and color capabilities, and supports monitors much larger than the SE's display. What the Mac II offered most was increased speed (four times as fast as an SE), which was welcomed by many, but the Mac II's lack of portability made it less attractive. The II was the first Mac to have a 68020 processor, which proved inferior to the 68030 processor.

**Mac IIx (discontinued)**

The Mac IIx has six expansion slots—twice the number of expansion slots as the newer Mac IIs, but it takes up more desk space. The IIx supports two floppy drives (or a floppy drive and a hard drive) rather than one.

**Mac SE/30**

The SE/30 combines the best of the SE (like the Super-Drive) with some features of the higher-end Macs, such as the Mac II's higher processing speed.

Most notably, the SE/30 has a faster 68030 central processor, which enables you to speed up your work greatly—up to four times the speed of an SE.

Probably the nicest thing about the SE/30 is that it's the same size as the original SE. The Mac II family
## Table M.1.
Macintosh Specifications

<table>
<thead>
<tr>
<th>Model</th>
<th>Max. RAM</th>
<th>Proc.</th>
<th>Speed (MHz)</th>
<th>No. Slots</th>
<th>Floppy Drive</th>
<th>Built-in Video</th>
<th>Retail Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>128K</td>
<td>128K</td>
<td>68000</td>
<td>8</td>
<td>0</td>
<td>400K</td>
<td>b/w</td>
<td>$400*</td>
</tr>
<tr>
<td>512K</td>
<td>512K</td>
<td>68000</td>
<td>8</td>
<td>0</td>
<td>400K</td>
<td>b/w</td>
<td>$500*</td>
</tr>
<tr>
<td>512Ke</td>
<td>512K</td>
<td>68000</td>
<td>8</td>
<td>0</td>
<td>800K</td>
<td>b/w</td>
<td>$600*</td>
</tr>
<tr>
<td>Plus</td>
<td>4M</td>
<td>68000</td>
<td>8</td>
<td>0</td>
<td>800K</td>
<td>b/w</td>
<td>$700*</td>
</tr>
<tr>
<td>SE</td>
<td>4M</td>
<td>68000</td>
<td>8</td>
<td>1</td>
<td>800, 1.4M</td>
<td>b/w</td>
<td>$1,200*</td>
</tr>
<tr>
<td>II</td>
<td>32M</td>
<td>68020</td>
<td>16</td>
<td>6</td>
<td>800K</td>
<td></td>
<td>$3,400-4,700*</td>
</tr>
<tr>
<td>SE/30</td>
<td>32M</td>
<td>68030</td>
<td>16</td>
<td>1</td>
<td>1.4M</td>
<td>b/w</td>
<td>$4,100-5,800</td>
</tr>
<tr>
<td>IIx</td>
<td>32M</td>
<td>68030</td>
<td>16</td>
<td>6</td>
<td>1.4M</td>
<td></td>
<td>$2,500*</td>
</tr>
<tr>
<td>IIcx</td>
<td>32M</td>
<td>68030</td>
<td>16</td>
<td>3</td>
<td>1.4M</td>
<td></td>
<td>$4,700*</td>
</tr>
<tr>
<td>IIci</td>
<td>32M</td>
<td>68030</td>
<td>25</td>
<td>3</td>
<td>1.4M</td>
<td>color</td>
<td>$7,200-7,900</td>
</tr>
<tr>
<td>Portable</td>
<td>9M</td>
<td>68000</td>
<td>16</td>
<td>1</td>
<td>1.4M</td>
<td>b/w</td>
<td>$4,800-5,500</td>
</tr>
<tr>
<td>IIfx</td>
<td>32M</td>
<td>68030</td>
<td>40</td>
<td>6</td>
<td>1.4M</td>
<td></td>
<td>$10,800-12,800</td>
</tr>
<tr>
<td>Classic</td>
<td>4M</td>
<td>68000</td>
<td>8</td>
<td>0</td>
<td>1.4M</td>
<td>b/w</td>
<td>$999-1,500</td>
</tr>
<tr>
<td>LC</td>
<td>10M</td>
<td>68020</td>
<td>16</td>
<td>1</td>
<td>1.4M</td>
<td>color</td>
<td>$2,500</td>
</tr>
<tr>
<td>IIisi</td>
<td>17M</td>
<td>68030</td>
<td>20</td>
<td>1</td>
<td>1.4M</td>
<td>color</td>
<td>$4,900-5,700</td>
</tr>
</tbody>
</table>

*Discontinued; the price shown is for a used system.

The following models are currently available: SE/30, IIci, Portable, IIfx, Classic, LC, and IIisi. The rest of the models are no longer manufactured, but you may still find new SEs and IIcx$s on retailers’ shelves.

All machines above the 512Ke have a minimum RAM of 1M, with the exception of the Portable, LC, and IIisi, which have a minimum of 2M.

Retail Price ranges from minimum system configuration to maximum system configuration, as of January, 1991.
The Little Mac Book

(which you have to move up to for more processing power and speed), on the other hand, is larger (25 pounds for the central unit alone), and you need to purchase the monitor separately. Because the SE/30 has room for expansion, there are expansion cards available that enable you to use external color monitors, connect with IBM mainframe computers, and take advantage of networking options.

**Mac Portable**

The Portable offers all the features that make a Mac a Mac and does so at the convenience of transportability and long battery life (six to twelve hours compared to other portables' two or three). It comes with standard Mac ports and an optional internal hard drive. But the highlight of the portable is its clear, crisp Active Matrix Liquid Crystal Diode display. The Portable does have some shortcomings: absence of color, weight (16 pounds), and only one source for batteries (Apple). However, it is a Mac!

There are, however, alternative laptops such as the Colby Systems SE-30 and Dynamac's SE-30 (which comes with a built-in modem). A real contender is the 10-pound Outbound portable, which is much cheaper (about $2,500) than the other portables.

Apple and Sony plan to introduce a tiny notebook Mac late in 1991, which may please those looking for a portable portable.

**Mac IIcx (discontinued)**

The first thing you notice about the Mac IIcx is its size. The footprint is noticeably smaller than the other Mac IIs, so the entire system fits neatly under a standard monitor. The IIcx is smaller because it has only three expansion slots, a smaller power supply, and a condensed motherboard (the main logic board). The Mac IIcx has the speed and power you need if you want to enter the world of more powerful Macs.
Mac IIci

The IIci offers everything that the IIcx has to offer, only the newer Mac is faster (50% faster than the IIcx) and has built-in color video capability. Number crunchers love the addition of the co-processor, which processes instructions when mathematical and other large “thinking” operations take place. Many users (and reviewers) think that this model is the best Mac available, given its modular design in combination with the aforementioned features.

Mac IIfx

Vroom! This is about as far as you can go right now with the Mac. Speed, speed, and more speed is what distinguishes the IIfx from the other high-end Macs. In fact, with its special architecture, the IIfx runs 70 to 100 percent faster than the IIci. The IIfx uses static RAM (SRAM), an especially efficient way to process information. Not that you will need it, but the IIfx also can create 16.7 million colors. At a retail price of about $9,000, this Mac does not come cheaply, but if you must have the best, look no further.

Mac Classic

Available since November, 1990, this new Mac is destined to replace the Plus and the SE. It offers a SuperDrive and 1M of RAM, and a microphone for audio input. The Classic is compact and has limited expandability. With this machine, Apple is targeting people who want to get into the Mac scene for less than $1,000.

Mac LC

This new Mac (LC for low cost color) is the first low-cost color Mac available. The LC comes with 2M of RAM, and voice input capability, easily surpassing the old Mac II in power, speed, and usability. Weighing in at only 8 pounds, the LC is almost portable. The LC offers color capability and an emulation card so that
it can run Apple IIe software. Apple is aiming the LC, along with the Classic, at the educational and home market.

**Mac IIsl**

The Mac IIsl is the third of the new Macs recently released. A modularly designed color Macintosh, the IIsl uses the same CPU as the IICx and runs about four times faster than the Plus. It also has sound capability, and is almost twice as fast as the SE/30, yet sells for $3,800 list (almost $1,000 less than the SE/30). The IIsl is the fastest Mac available, following only the IIfx and IIci.

**Macros**

A macro is a series of keystrokes that you define and save as a set for later use. After you press the key combination that you assign to a macro, all the keystrokes that are part of that macro execute. Macros are time-saving tools that can perform tasks ranging from underlining a word to generating a complex format for a newsletter.

Two types of tools are available for creating macros: those that come as part of applications and those that are separate utilities that operate regardless of the application. WordPerfect, for example, comes with a powerful macro language which provides editing plus a variety of macro functions. You can create a simple macro by selecting the Macro command from the Special menu, defining the macro, and then entering the keystrokes. Once you define the macro, WordPerfect remembers the keystrokes and executes them on your command.

The second type of macro is generated by utilities such as QuicKeys² (from CE Software) and Tempo II
(from Affinity). These utilities are macro generation tools that are installed as part of your System and are always available when you need them. An important advantage of using these independent utilities is their flexibility across applications. You also can use MacroMaker, which comes as part of Apple's system software.

See also System.

---

**Mail Order**

Should you buy through the mail? You see advertised tempting prices offered by one of the thousands of third-party (Apple is the first party, and you are the second) vendors. You see these advertisements in a periodical such as *MacUser, MacWeek, MacWorld,* and the Sunday *New York Times.* How good are the prices?

You can expect to pay about 40-50 percent below list price for software and about 40 percent below list price for hardware purchased through a mail-order vendor.

When contemplating buying software or hardware through the mail, keep the following questions in mind:

- How long has the company been in business?
- Is there an in-house service department?
- When do they charge your credit card (upon receipt of your order or upon shipment)? Using a charge card always gives you some recourse (a chargeback or credit) if you are dissatisfied for just reasons.
- When can you expect to receive your order?
- What are the return policies?
• Is there a toll-free technical support hot-line?

Do you need technical support? If the answer is yes, you may want to purchase from a local dealer rather than through the mail.

See also Buying Hardware and Buying Software.

Maintenance

You can prevent both minor and major Macintosh repairs—and the accompanying bills—by remembering the following maintenance guidelines:

• Keep your computer and peripherals clean and free of dust by vacuuming (the outside!) and wiping down the surfaces using a mild liquid detergent, not alcohol. Don’t clean color monitor screens with anything other than a product designed for that use. Dust covers are an inexpensive, but worthwhile, investment.

• Keep food and drinks away from your work area.

• If you smoke, do it away from your machine. Smoke particles can get on the head of a floppy drive and wreak havoc.

• Clean your mouse by turning the ring on the underside counter-clockwise. Use alcohol (unplug your mouse first) and cotton swabs to get out the gunk. Several commercial mouse cleaning products are available as well. Also, replace your mouse pad every year or so to make sure that you track on a clean surface. You can clean mouse pads made of cloth.

• Store your disks in a cool, dry area away from your Mac or external floppy drives.

• Minimize the heat to which your computer is exposed.
• Vacuum the inside of your ImageWriter to get rid of the little paper bits. Use alcohol (unplug the machine first) or a commercial platen cleaner to remove old ink. Also, always use paper that is under 20 lbs.

• Use light sewing machine oil on the moving parts of your ImageWriter every six weeks.

Notes
Make backups of all your data as frequently as you can stand to. Have several different backup sets that you rotate. Keep your backups at a different location.

Remember to check warranty information to find out which activities void your warranty. If you take apart your Mac and try to fix something yourself, you may void your warranty.

See also Backups, Disk Drives, Disks, Mouse, and Troubleshooting.

Menus
A menu is a listing of commands that you activate by using the mouse or keyboard to select an item from the list. Every Macintosh application works through a series of menus that appear across the top of the screen. Many menu items are similar across applications.

The opening Mac desktop screen shows the Main menu bar including the Apple ⌘, File, Edit, View, and Special menu (see fig. M.1). Macs that contain color capabilities also have a color menu option.

Each of these menus has a list of commands from which you can select. The five menus that you see on the opening screen are standard for the desktop. Each Macintosh application, however, has a different
set of menus that are designed to fit the particular features of the program. For example, within different applications, the File menu may contain slightly different commands.

To select a command from a menu

1. Position the mouse pointer on the name of a menu at the top of your screen.

2. Press and hold the mouse button. You can see the commands available from that particular menu.

3. While pressing the mouse button, drag the pointer down to the menu command you want to select.

4. Release the mouse button to activate the highlighted menu command.

The menu item flashes to tell you that it has been activated.

To move from one pull-down menu to another

1. Position the mouse pointer on a menu.
2. Press and hold the mouse button. You see the commands that are available on that particular menu.

3. Move the mouse pointer to the right or left to point to a different menu.

**To browse through a menu listing**

1. Point to the menu you want to view.

2. Press and hold the mouse button.

3. Drag the pointer down to view specific commands.

4. To stop viewing the menu without selecting any commands, simply drag your pointer off the menu, and release the mouse button.

**Notes**

Commands that appear dimmed are not active menu items and have no effect if chosen. For example, you can’t *open* a file until you first *select* a file.

Keyboard shortcuts appear next to many menu items. These key combinations accomplish the same task as selecting that particular command from a menu. For example, if you want to save a file, you can select the *Save* command from the *File* menu or use the ⌘-S keyboard shortcut.

Some applications have menu customization options. For example, with Microsoft Word you can add commands to an existing menu by using the *Commands* option from the *Edit* menu. With FileMaker Pro, you can make frequently used procedures menu items.

You also can change the way menus appear by using the programming tool ResEdit.

See also *Keyboard Shortcuts, ResEdit, and the “QUICK KEY GUIDE.”*
Modems

A modem is a basic part of any telecommunications system because it enables you to transmit and receive computer-generated data over the telephone. The incoming phone line plugs into one modem jack, and then a phone line is connected from the second modem jack to a telephone. A modem is the hardware that lies at both ends of the transmission. The phone line links the two modems together. The modems modulate and then demodulate basic signals so that the computers on each end can “talk” with one another.

Types of modems

Modems can be internal or external, and come in a variety of speeds, measured in baud rates. A baud is a measure of how fast information goes from digital to audio and back again. The higher the baud rate, the faster the modem. A baud rate of 300 was the standard, then 1200, 2400, and now baud rates of 9600 are available. Current modem prices range from $89 to thousands of dollars.

Purchase considerations

If you plan to purchase a modem, consider the following suggestions:

• Be sure that the modem is Hayes-compatible (the industry standard).

• Be sure that the speed you buy is compatible with the speed of the modem with which you will be telecommunicating. When they match and you “shake hands” (called handshaking!), things work fine. Discrepancy in speeds leads nowhere fast and produces garbled data.

• Look for software or a modem that comes with a built-in buffer that enables you to store
information (such as messages or even small downloaded programs) for later use.

• Purchase only what you need. If all you need to do is send short notes around the country, don’t bother with the high power, fast, expensive modems. A simple 1200 or 2400 baud rate capability is adequate.

• Extra features (if you want to pay for them) include automatic dialing and redial. Check the software for these features.

See also File Compression, Networking, and Telecommunications.

---

Monitors

The first Mac had a nine-inch screen (as do the Classic and the SE/30), but you now can find everything from two-page displays to the revolutionary Pivot Display System (from Radius), which changes the orientation of the screen image as the monitor’s physical orientation is changed.

Monitors are similar to television sets. How clear an image appears is a matter of resolution, which depends on several factors.

The first variable is the number of pixels (picture elements), measured both horizontally and vertically. A high resolution display may show up to 1,664-by-1,200 pixels. That’s almost two million pixels on the screen—enough to show the finest detail.

The second variable is the horizontal scan rate—the rate at which horizontal lines are drawn across the screen. The higher the rate, the better the image.
The final variable is the refresh rate. The refresh rate is the speed at which the monitor brings its light level up to full capacity.

Monitors can be monochrome, show a variety of shades of gray, or be color. The color monitors can be expensive, but the images they can produce are nothing short of amazing.

When pricing monitors, make sure to inquire about graphics boards. Some monitors are packaged with any necessary boards; other monitors require a separate purchase. Your system may already support the monitor you select, without requiring you to purchase a board.

You can use a color monitor with an old Mac. Make sure you have a slot available for the board you need for your new monitor.

See also *Buying Hardware*.

---

**Mouse**

The mouse is the pointing device that comes with your Macintosh. You move the mouse and your Mac translates those movements to the screen.

Today's mouse is similar to the model introduced with the original Mac. You can plug the mouse connector into a port on the back of your Mac or into the keyboard (you even can choose which side of the keyboard).

The mouse pointer generally appears on your screen in the shape of an arrow, an I-beam, or a watch. The shape of the pointer changes depending on the function that the mouse is performing and the application you are using. For example, the mouse pointer appears as an I-beam during most text oper-
ations; the pointer changes to a wristwatch when your computer is busy thinking. The tip of the pointer indicates where an action takes place.

To use a mouse
With the mouse on a clean, flat surface, slide it in different directions. As the ball on the underside of the mouse rolls around, little sensors inside your mouse send messages to your Mac. The computer translates these messages and moves the mouse pointer on-screen accordingly.

Basic mouse techniques
Basic mouse tasks involve pointing, clicking, and dragging. Each of these techniques has an important purpose.

Pointing involves learning to move the mouse to select menus, commands, objects, and text. To do anything with a file, object, or portion of text, you must learn how to select those items. Clicking and double-clicking, in conjunction with pointing and dragging, create all of the necessary mouse functions. Dragging enables you to do two things: move an object from one location to another, and highlight a specific range of text, or a number of objects.

To point to an object
Place your mouse on a flat surface. Move the mouse until the tip of the pointer arrow is over the object you want to select or activate.

If you run out of mousepad...
If you run out of mousepad as you try to move the pointer, try this technique: lift up the mouse and place it in the center of the mouse pad.

Notice that the pointer doesn't move when you move the mouse; the pointer moves only when the ball inside the mouse moves. You now can scoot the
mouse pointer anywhere on the screen using a small area of mouse pad.

**To select an object**
1. Point to the object you want to select.
2. Click the mouse button once. To click, press and release the mouse button. Do not move the mouse as you click.

Selected icons reverse from white to black or change color.

**To deselect an object**
Click anywhere on the screen other than on that object.

**To select more than one object**
1. Press and hold the **Shift** key.
2. Click on one of the objects you want to select.
3. Click on another object you want to select.
4. Continue clicking on objects until you have selected all the items you want to select.
5. Release the **Shift** key.

This action is called *Shift-clicking* and is handy when you want to take the same action (such as deleting) with more than one item.

**To select objects by drawing a marquee**
A marquee is an invisible box that you draw to highlight several icons on the desktop. Drawing a marquee highlights those items contained within the marquee lines. Any action you take (drag, trash, duplicate, or copy) affects all items within the marquee.

1. Place the mouse pointer to the upper left of the object(s) you want to select.
2. Press and hold the mouse button.
3. While pressing the mouse button, drag the mouse diagonally toward the lower right of the object(s) you want to select.

4. Release the mouse button.

To deselect an object when more than one object is selected
1. Press and hold the Shift key.
2. Click on the object you want to deselect.
3. Release the Shift key.

To drag an object
1. Point to the object you want to move.
2. Press and hold the mouse button.
3. Drag the mouse to position the object where you want it.
4. Release the mouse button.

To double-click
1. Point to the object you want to open or activate.
2. Click the mouse button twice in rapid succession.

If you click too slowly, your Mac does not recognize the action as a double-click. Clicking too quickly does not present a problem.

To change the responsiveness of your mouse
1. Under the Apple menu, select Control Panel.
2. Select the icon for the Mouse device. Scroll if necessary.
3. Select the desired mouse tracking and repeat rate.
4. Click the close box to activate your changes.
Tracking determines how far your pointer moves when you move your mouse. If you select the fast speed, when you scoot your mouse a tiny bit, the pointer will move a greater distance across the screen than if you select a slower speed.

To clean your mouse

Although the mouse is reliable, it can quickly develop a disease endemic to the species called “dirtitis.” Dirtitis develops when gunk and junk from the mouse pad and your desk get into the mechanical workings and prevent smooth rolling. You can use alcohol and cotton swabs to cure your mouse and keep it happy.

1. Shut down your Mac and unplug the mouse cable.
2. Turn your mouse upside-down.
3. Rotate the plastic ring counter-clockwise. (If your mouse doesn’t come apart this way, check the manual that came with your mouse to see how to remove the ball.)
4. Cup your hand over the ring and turn the mouse over. The ring and the ball fall out.
5. Using a cotton swab dipped in rubbing alcohol, rub the gunk off the little plastic wheels inside the mouse.
6. Making sure the ball is free of crumbs and other particles, insert the ball back into the mouse, secure the plastic ring, and rotate the ring clockwise.
7. Plug the mouse cable back into the proper port, start up your machine, and enjoy the feeling!

Mouse alternatives

Many people stick with their mouse forever, but there are now alternatives such as an optical mouse (with no moving parts to dirty), the Isobar (on the Out-
bound portable computer), trackballs (like an upside down mouse where you move the ball, rather than moving the casing that contains the ball), and even The Cordless Mouse (from Practical Solutions) where infra-red technology allows you to use a mouse that does not have a tail! There also are pens and tablet input devices available.

See also Highlighting Text, and Scrolling.

**Mouse Pads**

A mouse pad is a flat object on which you maneuver your mouse. The pad is a luxury item designed to enhance your tactical mousing experiences.

The standard pad is generally six-by-nine inches and is made of a material that has enough friction to enable the ball on the underside of the mouse to rotate with the slightest mouse movement. As usual, there are now mouse pads that resemble Swiss cheese or contain crazy visuals. Some mouse pads are even clear, enabling you to slide a picture of your favorite boss underneath so that you can roll all over his or her face! If you do not have a mouse pad, you can substitute the plastic cover of a loose-leaf binder.

See also Mouse.

**MultiFinder**

MultiFinder is a file located in the System Folder. When you activate MultiFinder, it replaces the Finder and enables you to do multi-tasking—open more than one application at a time. For example, with MultiFinder you can have Filemaker sorting a database, while at the same time having instant access to
SuperPaint. MultiFinder is ideal for individuals who go back and forth regularly between applications.

Because MultiFinder is so powerful, it affords you certain luxuries. One luxury is background printing (printing while you continue to work). Apple provides a small program named Print Monitor, to enable you to control several printing functions as you work.

**MultiFinder requirements**

You can run MultiFinder on any Mac starting with the Mac Plus. You must have the following to run MultiFinder:

- Minimum of System 6.0 and Finder 5.0 installed.
- At least 2M of RAM.

**To activate MultiFinder**

1. From the Special menu, select Set Startup.
2. Click the radio button labeled MultiFinder.
3. Click OK.
4. From the Special menu, select Restart.

**To switch applications**

You can switch between several open applications by clicking on the icon in the upper right corner of the screen (see fig. M.2). Click until you get to the application you want.

You also can select the desired application from the list at the bottom of the Apple menu, or double-click on the application’s icon on the desktop.

Before selecting an application from under the Apple menu, you can press and hold the `key to get rid of the DAs in the listing.
To launch applications automatically upon startup
1. Shift-click to select the applications you want to load automatically.
2. From the Special menu, select Set Startup.
3. Click the radio button labeled MultiFinder.
4. Click the radio button labeled Open Applications and DAs.
5. From the Special menu, select Restart.

To open documents automatically upon startup
1. Shift-click to select the documents you want to open automatically.
2. From the Special menu, select Set Startup.
3. Click the radio button labeled MultiFinder.
4. Click the radio button labeled Selected items.
5. From the Special menu, select Restart.
To view memory allocation

1. At the desktop, from the Apple menu, select About the Finder.
   
   You see a bar listing of the memory allocation used in your system.

2. Click the close box to exit the window.

To adjust an application's memory size

1. From the desktop, select the icon for the application you want to check.

2. From the File menu, select Get Info.
   
   In the lower right corner of the Get Info window, you see the amount of memory that is suggested, and the amount that is allocated to run the application (see fig. M.4).

3. Click in the Application Memory Size (K) box, and type the amount of memory that you want to allocate, for example, 1024.

4. Click the close box to exit the Get Info box.

5. From the Special menu, select Restart.

![Fig. M.4. A Get Info window.](image-url)
To temporarily disable MultiFinder
1. Press and hold the Option key.
2. From the Special menu, select Restart.
3. After the Mac finishes booting, release the Option key.

To reactivate the Finder
1. From the Special menu, select Set Startup.
2. Click the radio button labeled Finder.
3. Click OK.
4. From the Special menu, select Restart.

You can tell that MultiFinder is no longer active by the disappearance of the MultiFinder icon from the upper right corner of the Mac screen after restarting.

Notes
You may not need to use MultiFinder, especially if you use only one application regularly.

MultiFinder is very RAM intensive. With insufficient RAM, you might get MultiFinder to work, but you may be limited to running only one application besides MultiFinder, which may not make it worth the effort.

Background printing is turned on automatically when you activate MultiFinder.

You need to adjust the Finder's memory size after getting a Not Enough Finder Memory message.

MultiFinder will be standard fare for System 7. In other words, MultiFinder will always be operating under the new System.

See also Crashes, Finder, Get Info, System, Print Monitor, and Printing.
Networking

A network is a particular configuration of devices, or nodes (computers, printers, plotters, etc.), that are connected so that information can be shared between these devices. The devices in a network are usually connected by cables, and some are connected using modems across "bridges" that connect networks located in other cities. A Macintosh, no matter which model, comes with a built-in network capability called AppleTalk. AppleTalk is the standard system for sharing information over a network.

See also AppleTalk, AppleShare, and Modem.

Note Pad

The Note Pad is a desk accessory located on the Apple menu. Note Pad enables you to write up to eight pages of notes; retrieve them whenever you want; cut, copy, and paste from them; and more. Anything you enter in the Note Pad is saved automatically—even if your battery goes down or you rebuild the Desktop file.

Note Pad consists of eight pages that you can fill as desired (see fig. N.1).

To enter text into the Note Pad

1. From the Apple menu, select Note Pad.
2. Click anywhere on the Note Pad.
3. Type the text you want to record. The computer saves the text automatically when you close the Note Pad.
4. Click the close box to exit the Note Pad.
Fig. N.1. The Note Pad desk accessory.

To flip through Note Pad pages
In the lower left corner of the Note Pad window, there are two triangles. Click in the upper triangle (folded up) to move to the next page; click in the lower triangle to move to the previous page.

To replace text in the Note Pad
1. Highlight the text you want to replace.
2. Type the new text.

To remove text from the Note Pad
1. Highlight the text you want to remove.
2. Type the replacement text or press Delete to remove the text without replacing it with new text.

Notes
Each of the eight Note Pad pages stores 12 lines of text.

Text does not automatically flow to the next page in the Note Pad.

The Note Pad does not support graphics.
See also *Desk Accessories, Desktop, Rebuilding the Desktop*, and *Scrapbook*.

**OCR**

Optical Character Recognition (OCR) software takes a file created by a scanner, and turns the scanned text into an editable file. OCR software reads text as text rather than just as a set of graphic characters. The software also interprets scanned images for your application. Scanners can also scan different levels of grays, and some models scan and interpret color.

**Types of OCR software**

The following list describes three basic types of OCR software:

- *Nontrainable* software is limited to the specific text and printers for which it was designed.

- *Trainable* software can be trained or taught so that it can follow a template and read almost any style of type.

- *Automatic* software includes some artificial intelligence features and is designed to read text without any kind of training.

**Notes**

No OCR program is perfect. You must read through a scanned document to be sure that there are no errors of omission (things that are not there that should be) or errors of commission (things that are there that shouldn’t be).

See also *Scanning*. 
Opening Files

There are two ways to open files: from the desktop and from within an application.

To open a file from the desktop
Double-click on the icon of the file you want to open. The application you used to create the file opens and the contents of the file appears on-screen.

To launch an application from the desktop
Double-click on the icon of the application you want to launch. The application launches and a blank screen appears, ready for you to begin working.

With some programs, you see a dialog box asking you to specify what type of document you want to create.

To open a file from within an application
1. From the File menu, select Open (see fig. O.1).
2. Select the disk that contains the file you want to open.
   Click Drive to view the contents of another drive.
3. Select the folder that contains the file you want to open.
   Double-click on the name of a folder in the file listing to view the contents of that folder.
   Click on the name above the Open button to move upward through folders in the hierarchy.
   Point to the name of the folder above the file listing, and press and hold the mouse button to view the names of the folders higher in the hierarchy. Release the mouse button to select the names of the folder containing the file you want to open.
4. Scroll through the file listing until you find the name of the file you want.

5. Double-click on the name of the file you want to open.

Click here to select a different level in the hierarchy

Click here to move up one level in the hierarchy

**Fig. O.1. The Open dialog box.**

**Notes**

Some applications support multiple open files.

See also *Files* and *Launching Applications*.

---

**Orientation**

Orientation specifies whether an image prints with the long edge of the paper horizontal or vertical. Apple refers to these settings as Tall/Wide on ImageWriter printers and Portrait/Landscape on LaserWriter printers (see fig. O.2). To print this book on a LaserWriter, we set the orientation to portrait.

**Fig. O.2. Orientation settings.**
Most programs are preset portrait orientation unless you specify landscape. You usually find orientation settings by selecting Page Setup or Print from the File menu.

To change the orientation of a document

1. From the File menu, select Page Setup.
2. Select icon for the orientation you want.
   Some programs do not display orientation settings as icons; the programs require you to click a checkbox to change the orientation setting.
3. Click OK

Notes

Orientation settings differ from application to application. Sometimes you must first select Options from the Page Setup or Print dialog box to get to the orientation settings.

See also Page Setup and Printing.

Page Setup

The Page Setup command, common to most Mac applications, enables you to set basic parameters as to how a Mac page appears when printed. The contents of the Page Setup dialog box depends on the type of printer you use (see figs. P.1 and P.2).

Fig. P.1. The ImageWriter Page Setup dialog box.
Both the ImageWriter and the LaserWriter Page Setup dialog boxes have the following features:

- **Paper** enables you to select the type of paper you are printing on, including US Letter (8.5 inches by 11 inches), US Legal (8.5 inches by 14 inches), A4 Letter (11.75 inches by 8.25 inches), B5 (10 inches by 7.5 inches, for LaserWriters only), and Tabloid (11 inches by 17 inches, for LaserWriters only). The ImageWriter also has Computer Paper (11 inches by 13 inches) and Fanfold (paper that comes in attached sheets) options.

- **Orientation** sets whether the image prints with the long edge of the paper horizontal or vertical.

- **Special Effects** (ImageWriter) permits you to make adjustments for the difference in the dpi between the Mac screen and the ImageWriter; reduce the size of the output (50% reduction); and avoid gaps between pages (the No Gaps Between Pages option). You also can reduce or enlarge from 25 to 200 percent.

- **Printer Effects** (LaserWriter) enables you to substitute fonts when they are not variable (the Font Substitution option); to lessen the occurrence of jaggies (the Text Smoothing option and Graphics Smoothing option); and
process bitmap images prior to sending them to the printer (the Faster Bitmap Printing option).

See also ImageWriter, LaserWriter, Orientation, and Printing.

Paper

Paper is not just paper. Most dot matrix printers limit your choice to fanfold paper, which comes in connected sheets, unless you want to insert 8 1/2-by-11-inch pieces individually. If you use fanfold paper with your ImageWriter, you may want to purchase paper perforated with a laser during manufacturing. When you separate this paper, it has a very sharp edge that looks like single-sheet paper.

You also should consider the weight of the paper. Weight is expressed in pounds of one ream (500 sheets of paper). For example, 500 sheets of 25-inch-by-38-inch paper weighs 60 pounds. Therefore, the weight of the paper is referred to as "60 pound."

Some printers cannot handle paper heavier than 24 pound. The paper-feed mechanism often determines which size paper a printer can handle. Some laser printers enable you to print heavier paper on a straight path, whereas the conventional path could not handle heavier papers.

There are also different types of paper. Use the standard bond for letters, textured paper for special uses, uncoated paper for general printing, coated paper (with a clay finish to help hold ink) for desktop publishing, and heavy cover paper for covers.

See also Printing.
The Paste command is a close cousin of the Cut and Copy commands located on the Edit menu. Once text or a graphic is cut or copied, the Clipboard stores it automatically. You then can paste the stored element into another location. A cut or copied item is stored in the Clipboard until you cut or copy another item to the Clipboard or shut down your Mac.

You can cut and paste within a document, between documents, or between applications. You also can paste an element into the Scrapbook for long-term storage.

To cut and paste
1. Highlight the text you want to cut or select the item you want to cut.
2. From the Edit menu, select Cut (⌘-X).
3. Select the location where you want the cut text/item to appear.
   - If you want to paste into the same document, scroll to the desired location and click.
   - If you want to paste into a different document, quit the current application, launch the other document, scroll to the desired location, and click.
4. From the Edit menu, select Paste (⌘-V).

To view the contents of the Clipboard
1. From the Edit menu, select Show Clipboard.
2. Click the close box to exit the Clipboard.

To paste an item from the Clipboard
1. Click where you want the text or graphics to appear.
2. From the Edit menu, select Paste (⌘-V).
To paste an item into the Scrapbook
1. Select the item you want to paste into the Scrapbook.
2. From the Edit menu, select Copy (⌘-C).
3. From the Apple menu, select Scrapbook.
4. Scroll, if you want, to select a position within the Scrapbook.
5. From the Edit menu, select Paste (⌘-V).
6. Click the close box to exit the Scrapbook.

To paste an item from the Scrapbook
1. From the Apple menu, select Scrapbook.
2. Scroll to find the item you want to use.
3. From the Edit menu, select Copy (⌘-C).
4. Click the close box to exit the Scrapbook.
5. Click where you want the text or graphic to appear.
6. From the Edit menu, select Paste (⌘-V).

Notes
You may paste an item as many times as you want, as long as that item remains in the Clipboard or Scrapbook.

See also Clipboard, Copying, Cutting, and Scrapbook.

Peripherals
A peripheral is any external device that attaches to your Macintosh. The general classes of peripherals are external hard and floppy drives, printers, plotters, scanners, modems, CD-ROM drives, and pointing devices such as mice and drawing tablets. Most
peripherals plug into the back of the Macintosh in the appropriate port (as indicated by the icon).

If you have more than one SCSI peripheral to connect to your Mac, you can chain up to seven together. You can "daisy-chain" SCSI devices only if each one has a unique ID# (from 0–6). Most SCSI devices have a switch that allows you to change the address. For instructions on changing a SCSI address, consult the manual that came with your peripheral.

**Caution**

*Never attach or detach peripherals with your Mac turned on.* Always shut down the Mac properly before you begin hooking up new items or disconnecting anything.

See also *SCSI*.

---

**PMMU**

The Paged Memory Management Unit (PMMU) makes virtual memory a reality. Virtual memory allows part of your hard disk to be used as RAM. Virtual memory improves the Mac's management of calculation-intensive tasks.

The PMMU is a separate chip that is built into the 68030 central processing unit (found on most newer Macs) and can be installed on other models. But the chip alone does not do the trick. You need virtual memory software. Support for virtual memory is built-in to the upcoming System 7, so the extra software will not be necessary for machines running System 7.

See also *Macintosh Systems* and *Virtual Memory*. 
PostScript is a page-description language from Adobe Systems that prepares an image for printing. This language describes the shape of the image (a letter or a graphic) as a mathematical formula that defines an outline to be drawn and then filled. The language—licensed to various printer manufacturers—is the most popular page-description language. PostScript provides the most power and the greatest number of options for producing high-resolution images (including fonts).

PostScript, in contrast with QuickDraw and other page-description languages, does not use any predeetermined shapes; different characters do not need to be stored. PostScript waits for a command to draw a graphic and then sends a message to the printer telling the printer how to draw that particular shape.

Actually, the command comes to the printer as a QuickDraw command (which is stored in ROM), and the page description language translates that command for the printer.

Some printers (such as GCC Technologies Personal Printers) produce print of the same quality as PostScript by using QuickDraw technology. QuickDraw printers, however, lack the flexibility to create graphics or text with an infinite number of size and shape options.

Because PostScript is a programming language, there are now products (such as Adobe’s SmartArt or Broderbund’s TypeStyler) that enable you to produce PostScript effects by issuing English commands.

See also Fonts, LaserWriter, Printers, and Printing.
Print Monitor

Print Monitor is a small spool program (included with your System software) that enables you to print while you continue working. Print Monitor allows you to specify when a print job prints. It notifies you about dwindling paper supply and signals when to insert paper manually.

To activate the print monitor

1. From the Apple menu, select Chooser.
2. Click to select Background Printing.
3. Click the close box to exit the Chooser.
4. From the Apple menu, select Print Monitor.
5. Select from the available options.
6. Click the close box to exit the Print Monitor.

Notes

Print Monitor must be in your System Folder along with your printer driver. Print Monitor only works under MultiFinder. You must activate Background Printing in the Chooser dialog box in order for Print Monitor to work.

See also Chooser, MultiFinder, Printing, and Print Spooler.

Print Spooler

Your printer can take up a great deal of time printing large documents. A print spooler is a handy program that enables you to continue working while you print a file. A print spooler tells the Mac to send the file you want to print to a disk file until the printer is ready for that file. The file, therefore, waits on the disk and does
not tie up your Macintosh. You even can have many files in the spooler queueing up to print.

Many companies—such as Orange Micro, the producers of the Grappler Spooler—sell print spoolers that can have up to one thousand documents waiting to be printed, provided you have the disk space.

Print spoolers are software solutions. Print buffers perform the same function as spoolers, but print buffers are hardware solutions. A print buffer is an actual device inserted between your Macintosh and your printer. When you direct your Mac to print, the Mac sends the file to the buffer where the file stays until your printer is ready to print the file or until you instruct the buffer to print.

See also *Printers* and *Printing*.

---

**Printers**

You can use many different types of printers with your Mac, provided you have the software that enables your Mac to talk to that printer.

The three main types of printers are: dot matrix, ink jet, and laser.

**Dot matrix printers**

Dot matrix is the most-used type of printer. Dot matrix printers print using impact technology: a series of pins in the print head strike through a nylon or a cloth ribbon containing ink, thereby forming a character as an impression. Today, dot-matrix printers with 24-pin print heads are quite common, and the quality of output is acceptable for most Mac users. The ImageWriter line of printers is of the dot-matrix variety.
**Ink jet printers**

Ink jet printers are a relatively new type of printer. Ink jet technology produces a very fine spray and "paints" the character on the page. The sprayed ink is dry as the page finishes printing. The best ink jet printers print about six pages per minute at a quality very close to that of a laser printer.

**Laser printers**

The laser printer is the printer with the best quality and speed of output. Laser printers are ideal for desktop publishers. Laser printers used to be expensive—the most inexpensive one you could get to work with the Mac was more than $4,000. Today's laser printers, however, are more affordable, starting at $1,300.

See also *Buying Hardware*, *ImageWriter*, *LaserWriter*, *PostScript*, *Print Spooler*, and *Printing*.

**Printing**

Printing is the production of a copy on paper of the work you have created on-screen.

In order to print Mac files, you must have a Macintosh-compatible printer connected to the proper port on your Mac or available to you on a network. You also must have a printer driver in your System Folder that matches your type of printer (the basic drivers come with your system software).

Individual applications such as PageMaker require a "prep" file—Aldus Prep, for example—to be present in addition to your printer driver in your System Folder (application-specific prep files come with the application software). You also must select the printer through the Chooser desk accessory.
You can print a file two ways: from within the application or from the desktop. Before you print anything, however, you must select a printer driver from the Chooser. The system file that makes a printer work is called a printer driver. For your printer to work (and for it to show up on the Chooser), you must have the correct driver for your printer in the System Folder when you boot up.

**Print options**

The Print dialog box gives you a number of options. Among those options, you can indicate the following:

- Which pages you want to print. You do not have to print the entire document each time you issue the Print command.
- The number of copies you want to print.
- Whether you want the paper feed to be automatic or manual.
- The quality/speed level you need (ImageWriter only). If your work is a draft, try printing in draft mode.

**To select a printer**

1. From the Apple menu, select Chooser.
2. Select the icon of the printer you want to use.
3. Click on the name of the printer.
4. Click the close box to exit the Chooser.

You may find it helpful to select Page Setup from the File menu upon creating a new document. This procedure ensures that your Mac uses the proper document specifications when printing to the selected device.

**To print a file from within an application**

1. Open the document/file you want to print.
2. From the File menu, select Print (⌘-P).
3. Click **OK**, or press **Return** or **Enter**.

The Print dialog box contains several different options that enable you to determine how your printed output appears.

**To print a file from the desktop**

1. Select the icon of the file you want to print.
2. From the **File** menu, select **Print** (⌘-P).
3. Click **OK**, or press **Return** or **Enter**.

Your Macintosh automatically sets up the file for printing and waits for you to tell it to go ahead and print.

**To cancel printing**

Press ⏪ (period) to stop the print procedure. If the job has transferred entirely from the Mac to the printer, this procedure may not work.

If you use a print spooler, you may be able to pause the spooling action and delete the file from the queue.

**To print the contents of the screen to an ImageWriter**

Press **Shift-⌘-4**.

This procedure works on ImageWriters and compatible printers only.

**To print the contents of the active window to an ImageWriter**

Press **Caps Lock-Shift-⌘-4**.

This procedure works on ImageWriters and compatible printers only.

**To create a screen dump file**

Press **Shift-⌘-3**.
Your Mac numbers screen dump files in order, starting with “Screen0,” to a maximum of 10 files. Rename the files to make room for 10 more screen dump files.

You may open, print, or alter a screen dump file using any standard paint program (such as MacPaint or SuperPaint). To print the contents of a screen, simply print the paint file.

**To print the contents of the screen to a LaserWriter**
Create a screen dump and then print the screen dump file.

**To print a listing of files and folders**
1. At the desktop, open the window that contains the files of which you want a list.
2. Under the **File** menu, select **Print Directory**.

**To prevent the test page from printing**
Laser printers generally run through auto-test routines whenever you turn them on. The printers assume that you want a report of the findings, and generously spit out such a report each time you startup your printer. To prevent the printer from printing this test sheet, pull out the paper tray just enough to prevent the paper from feeding. Push in the tray after several minutes elapse.

**If you have trouble printing...**
If you cannot get your document to print, check the following:

- Is your printer turned on?
- Is your surge protector light on?
- Is the “select” button activated? (ImageWriter only)
- Are your cable connections secured?
- Is the paper supply adequate?
- Is there a paper jam?
• Did you check your Chooser settings? Are all three items selected: icon for printer, name of printer, and user name?

• Do you have the proper printer driver in your System Folder? If not, copy the correct driver from your original system disk to the System Folder on your hard disk.

• If you have a spooler, did you check the print queue?

• Did you check your Page Setup selections? Do they reflect the specifications for document you want to create? Are your margins properly set?

• Did you check your Print selections? Are your feed selections correct? Is your page range correct?

• Did you check your page breaks?

• Do you have the proper fonts installed in your System?

Occasionally, it helps to shut off your printer and turn it back on again. Doing so clears out the printer's memory.

Notes

To see what a document will look like when printed (without wasting paper), look for a Print Preview command. Check the manual that came with your software to see if such a command is available. Some programs have a Print Preview command under the File menu; others allow you to preview a document from the Print dialog box.

See also Chooser, Fonts, ImageWriter, LaserWriter, Page Setup, Paper, Print Spoolers, Printers, and Troubleshooting.
The Programmer’s Switch is the extra piece of gray plastic that came with your Mac. The switch contains two buttons: **Reset** and **Interrupt**. Use the Reset button (an arrow) to reset your Mac instead of turning it off and on again—useful in the event of a crash. The Interrupt button (a circle) is used primarily by—you guessed it—programmers.

You install a Programmer Switch (on most machines) simply by snapping it into place. A few Macs require that you open the case to install the switch. On the Mac 128K through the SE/30, install the switch on the left side of your Mac. On the Mac II and above, install the switch on the right side. For the IICx and the IIfx, install the switch on the front. The Mac Portable doesn’t use a switch.

To install the Programmer’s Switch, consult your manual (or have your dealer install the switch).

See also **Crashes**.

Like PostScript, QuickDraw is a page-description and display language that is part of the Macintosh operating system. QuickDraw tells your Mac how to display and print characters and graphics. QuickDraw (developed by MacPaint and HyperCard genius Bill Atkinson) is responsible for the ease and speed with which you can move icons on the desktop. Unlike other page description languages, QuickDraw is built into the ROM of the printer.
Unlike PostScript, QuickDraw requires no extra licensing fee. QuickDraw does, however, have somewhat limited type capabilities. It provides a high quality—although fixed—set of fonts. For example, the LaserWriter II SC has four fonts of various sizes and QuickDraw prints these fonts beautifully. If you try to print a 13-point font when 12-point is resident, you won't get the same quality; the SC may have trouble approximating the new size.

Apple's efforts at developing an Apple page-description language may eliminate the need to purchase PostScript and thereby lower the price of high-quality laser printers.

See also PostScript and Printing.

Quitting

Just turn off your machine, right? Wrong.

Why can't you just turn off your machine? Your Mac is always very busy, even when you think it is just sitting there waiting for you to enter information. Your Mac spends part of this time keeping track of files. When you perform shut-down procedures, your Mac gets the message to do some "housekeeping." These tasks include putting files in the right place and closing files that may be open and so forth. In addition, shutting down prepares your Mac so that the beginning of the next work session goes smoothly.

If you do not select the Shut Down command, the next time you boot up, you will find your Mac takes longer to display the desktop. This delays occur because your Mac needs time to finish the clean up chores it should have had time to complete during the last session. In addition, you may lose data if you simply switch off your machine.
To quit an application

1. From the File menu, select Quit (⌘-Q).
2. Save your file if prompted to do so.

You may want to use the Close command instead of the Quit command. The difference is that Quit returns you to the desktop, whereas Close allows you to open another document created within the same application.

To shut down the Mac

1. Quit any active applications.
2. At the desktop, from the Special menu, select Shut Down.

The Mac II series of computers automatically turns off when you issue the Shut Down command. The compact Macs need you to turn off the power. The switch is on the back of the machine.

Notes

You must return to the desktop prior to shutting down.

You may leave windows open on the desktop when you shut down; it isn’t necessary to clear the desktop prior to selecting the Shut Down command.

See also Files, Restarting, and Shut Down.

RAM

Random access memory (RAM) handles temporary information storage. Random access memory is the place where your Mac does all of its thinking and scratch pad work. RAM is perhaps the most precious of all Mac commodities, because you must have adequate space to store all of the application direc-
tions while you are working. In general, the more RAM you have, the more room there is to work, and the faster your Mac can operate.

The basic Mac Classic comes with 1M of RAM, which used to be more than enough. With the introduction of applications that take almost 1M by themselves (to say nothing of the System and Finder space requirements), you can run out of room quickly. In addition, with the increasing demands of System 7, there will come a time when you need at least 2M of RAM to use the minimum of your Mac's capabilities. Fortunately, you can upgrade your Mac easily (at less than $100 per megabyte).

The Mac is sensitive if you don't have enough RAM; it alerts you when there is an insufficient amount to continue. When you get such a message, you can look to three possible sources of the difficulty. First, and most obvious, the application you want to use needs more memory than is available. Second, you have Control Panel devices (CDEVs) or INITs that are too big (or you have too many). Upon booting up, these utilities load, and there is insufficient RAM left for any further computing activity. Finally, you may have set the RAM cache too high, and RAM is going where it shouldn't.

Because RAM is only temporary, any unsaved information left in RAM (such as the unsaved contents of your document) is lost when you turn off the Mac.

See also Crashes, MultiFinder, RAM Cache, SIMMs and Upgrading.
RAM cache (pronounced “cash”) is a part of the Mac’s memory dedicated to specific operations that are performed frequently by the computer.

As processors get faster, the gap increases between how fast a computer processes information and how fast a hard disk can retrieve that information. We need something to close that gap. That’s where RAM cache comes in (see fig. R.1).

![Control Panel](image)

*Fig. R.1. Setting the RAM cache.*

RAM cache affects the time it takes to access a file or application. It also can improve the time it takes to go back and forth among applications running under MultiFinder.

When you activate RAM cache, any disk-based operation you perform automatically gets stored in the cache. When you perform a particular task, your Mac
reacts quicker the second time you perform the task because your Mac doesn't have to go all the way back to the disk. The larger the cache, the faster things work.

To change the RAM cache setting
1. From the Apple menu, select Control Panel.
2. Select the General device from the list of device icons. Scroll if necessary.
3. Click on the up or down lever in the RAM cache box to increase or decrease the amount of space available to the cache. You can increase the RAM cache in 32K increments.
4. Click the close box to exit the Control Panel.
5. At the desktop, from the Special menu, select Restart.

Which RAM cache setting do you use?
Changing the RAM cache setting is highly experimental. Apple recommends that your RAM cache setting not exceed 25% of RAM. If you allocate RAM through the RAM cache at greater than 348K per megabyte of RAM, your Mac resets the RAM cache to 348K per megabyte of RAM.

If you have less than 2M of RAM, activating RAM cache will not significantly affect your system. See Table R.1 for guidelines on setting the RAM cache.

To check the amount of RAM in your system
At the desktop, under the Apple menu, select About the Finder.

Click the close box to exit the Finder information window.
Table R.1.
Recommended RAM Cache Settings

<table>
<thead>
<tr>
<th>RAM</th>
<th>Without MultiFinder</th>
<th>With MultiFinder</th>
</tr>
</thead>
<tbody>
<tr>
<td>1M</td>
<td>128K</td>
<td>32K</td>
</tr>
<tr>
<td>2M</td>
<td>256K</td>
<td>64K</td>
</tr>
<tr>
<td>2.5K</td>
<td>512K</td>
<td>80K</td>
</tr>
<tr>
<td>4M</td>
<td>1,024K</td>
<td>128K</td>
</tr>
<tr>
<td>5M</td>
<td>1,280K</td>
<td>160K</td>
</tr>
<tr>
<td>8M</td>
<td>2,048K</td>
<td>256K</td>
</tr>
</tbody>
</table>

Notes
The more RAM you allocate to the cache, the less you have available for other purposes. Turn the cache off if your system crashes or if your applications run out of memory.

See also Control Panel and RAM.

---

Rebuilding the Desktop

Every Mac disk has a hidden Desktop file that is responsible for housekeeping. The Desktop file keeps track of available applications, icons, and file locations. As you add, delete, and move files on your hard disk, the Desktop file can grow to an unmanageable size. You may find that your Mac responds more slowly, or that your system crashes frequently.

The simple rebuilding procedure often can speed up all your desktop activities and can seem like a miracle fix. The only drawback is that this procedure erases all your Get Info comments stored with each file.
To rebuild the Desktop

1. Shut down your Mac.
2. Press and hold the ⌘ and Option keys.
3. Restart your Mac.
4. Click OK to respond to the Are you sure? prompt.

See also Crashes, Desktop, Finder, Get Info, Troubleshooting and Windows.

Recovering Data

No matter how hard you try, files can be corrupted or lost. This loss can happen for a variety of reasons including physical damage to a disk (rare), accidental deletion of a file (more likely), or problems with the inner workings of the system. This disaster can be slight (you lose a file that you backed up) or major (your Mac tells you that it can’t find your hard disk!). The Mac is a complex machine in its design and execution; therefore, it’s difficult for amateurs to recover lost information without having access to some special tools.

Several utility programs—such as SUM II (from Symantec) and Mac Tools Deluxe (from Central Point Software)—can help you recover a deleted file or erased disk, or repair a damaged disk. A new addition, The Norton Utilities for the Macintosh (also from Symantec), is especially useful (see fig. R.2).
You can do everything from restoring a damaged hard disk to unerasing a file to restoring a hard disk that has been accidentally formatted.

See also *Crashes* and *Troubleshooting*.

**ResEdit**

**Caution:** ResEdit has the capability to destroy data without warning. *Only* use this program if you know what you’re doing.

ResEdit (the resource editor) is Apple’s programming tool that enables a developer to get inside a program and easily change its features. With ResEdit, even non-programmers can make fun and interesting changes in menus, icons, and windows. You can get the ResEdit program from a bulletin board, your local dealer, or from various mail order companies.

ResEdit enables you to change system features by altering ResEdit templates such as WIND (for windows), PAT (for patterns), and ICN# (for icons). A Mac file consists of "resource forks" that contain
resources such as icons, dialog boxes, alert boxes, and menu commands. ResEdit enables you to edit these resources directly.

To alter an icon

1. Launch ResEdit by double-clicking on the ResEdit icon (see fig. R.3).

Fig.R.3. The ResEdit icon.

2. Open the System file by double-clicking on the System icon (make sure you have an identical copy of the System file in case you mess up this one).

3. In the resource list, double-click the ICN# template. The screen in Figure R.4 shows an icon consisting of two designs: a mask and a pattern.

Fig. R.4. Altering icons using ResEdit.

4. Use the mouse pointer to click pixels on or off to modify the image as you want.
5. Close all of the open windows and applications. When you restart your Mac, the newly modified icon appears.

**Notes**

*Always* work off a copy rather than an original file when using ResEdit. If/when you get the desired results, you can transfer the file to the desired location.

See also *Bulletin Boards* and *Mail Order*.

---

## Restarting

Use the Restart command to start up your Mac without turning off the power switch or using the Shut Down command. When you select Restart, all the disks in floppy drives are ejected, and the Mac begins its routine for loading the System so that you can begin work. Use this command when you make changes to the System file (such as the addition of an INIT or CDEV). You also can use this command when recovering from a system crash.

**To restart your Mac**

1. Quit any active applications (don’t forget to save!).

2. At the desktop, from the **Special** menu, select **Restart**.

**Notes**

You do not need to close all the open windows on your desktop prior to shutting down, starting up, or restarting.

See also *Crashes, Programmer’s Switch*, and *Shut Down*. 

Saving

One of the most basic commands in a Mac application is the Save command, accessed via the File menu. When you select the Save command for the first time, the Macintosh prompts you for a name for the file you want to save. You also can direct that file to be saved in one of the available folders, or on a different disk. You can save at any time while working on your file—even before you actually type anything. You can save continually without having to close up your document or return to the desktop.

The dialog box shown in Figure S.1 is a standard Save dialog box common to all Mac applications. You see the Save dialog box when you save an untitled document for the first time. When you save a file, you specify the following:

- A name for the file
- A location for the file

To save a file

1. From the File menu, select Save (⌘-S).
2. Type the name for the file.
3. Click OK, or press Return or Enter.

**Fig. S.1. The Save dialog box.**
To save a file to another folder

1. From the File menu, select Save (⌘-S).
2. Click on the folder name in the box above the file listing.
   Select the folder in which you want to save the file. Double-click on the name of a folder in the file listing to view the contents of that folder. Click on the name of the folder above the file listing to see the chain of folders leading to the top of the hierarchy. Click on the icon of the disk to go back up through the folder hierarchy.
3. Type the file name.
4. Click OK, or press Return or Enter.

To save a file to another disk

1. From the File menu, select Save (⌘-S).
2. Click the Drive button in the Save dialog box or press Tab until the disk to which you want to save the file appears.
3. Type the file name.
4. Click OK, or press Return or Enter.

To save a copy of the file on-screen

1. From the File menu, select Save As.
2. Type the file name.
3. Click OK, or press Return or Enter.

The original file remains intact.

What's the difference between Save and Save As?

The Save command allows you to save your work on disk. You give the file a specific name and indicate the folder in which the Mac should save the file.

The Save As command enables you to save a file under another name or save a copy of the active file to a
different location. The dialog box, which appears when you select the Save As command, is the same Save dialog box you first saw when you saved and named the file. You now can enter a new name and/or indicate a new location for the file.

The Save As command is useful for many situations such as when you want to use the same file (a form letter) with some slight modifications, yet leave the original file intact.

Notes

You do not have to wait until a file is complete before saving it. It is good practice to save a file every fifteen minutes or so. When you save a file, the file is updated to reflect your changes. It takes only seconds to issue the $S keystroke. You can do it every time you take a typing break.

See also File Formats and Files.

Scanning

A scanner is a peripheral that converts an image to a series of digital characters that your Mac can understand.

Using software provided with the scanner or other software developed for this purpose (such as Digital Darkroom from Silicon Beach Software), you can manipulate scanned images to accomplish seemingly impossible effects. The most expensive scanners are flat scanners similar to copying machines. You place the document to be scanned on a sheet of glass and start the scanner. A bright light moves across the scanner face, and more than 2,500 photosensors in the moving part of the scanner capture the image. The system saves the scan to a file that you can use with different programs.
Scanners also can come as sheet feeders and overhead units. You even can use a scanner (ThunderScan from ThunderWare) that attaches to the print head of an ImageWriter and moves across the image, reproducing it on-screen as the scan progresses, or a handheld scanner called HandScan, that you move across an image to capture it. Even the best scanner rarely reproduces a 100-percent duplicate image. You may clean up a scanned image using a program such as Photoshop (from Adobe Systems).

See also File Formats, OCR, and Peripherals.

**Scrapbook**

The Scrapbook allows you to access text or graphics from within any application. For example, you can open the Scrapbook while using MacWrite II, and paste the festive illustration in Figure S.2 into your party invitation. The Scrapbook is ideal also for company logos or frequently-used text blocks.

![Fig. S.2. The Scrapbook desk accessory.](image)

You can place things in the Clipboard for later use, but the Clipboard can hold only one item at a time,
and does not store things permanently. The Scrapbook, however, is bound only by the amount of memory that your Mac can afford to spare.

To store an item in the Scrapbook
1. Open the application that contains the item you want to store in the Scrapbook.
2. Select the item you want to place in the Scrapbook.
3. From the Edit menu, select Copy (⌘-C).
4. From the Apple ⌘ menu, select Scrapbook.
5. Scroll to select the location for your stored item.
6. From the Edit menu, select Paste (⌘-V).
7. Click the close box to exit the Scrapbook.

To use an item from the Scrapbook
1. Open the document you want to contain the Scrapbook text or graphic.
2. From the Apple ⌘ menu, select Scrapbook.
3. Scroll to find the text or graphic you want to use.
4. From the Edit menu, select Copy (⌘-C).
5. Click the close box to exit the Scrapbook.
6. In the document, click where you want the copied item to appear.
7. From the Edit menu, select Paste (⌘-V).

To remove an item from the Scrapbook
1. From the Apple ⌘ menu, select Scrapbook.
2. Scroll to find the text or graphic you want to remove.
3. From the Edit menu, select Cut (⌘-X).
4. Click the close box to exit the Scrapbook.

See also Clipboard, Copying, Cutting, and Pasting.

Screen Dump

Producing a screen dump means printing the contents of a Mac screen to a file on disk or to a printer.

To save a screen dump to disk

Press ⌘-Shift-3.

Your Mac creates a MacPaint file on your disk named “Screen0.” You can create up to 10 of these files (0 through 9); then the numbering starts over at 0 again. To produce more than 10 files, you need to renumber them. To print a screen dump file, treat it like any other paint file.

To print a screen dump of the current window

Press ⌘-Shift-4.

Your ImageWriter (or compatible) prints the contents of the open window; you cannot print a screen dump directly to a LaserWriter (or compatible).

To print a screen dump of the entire screen

Press Caps Lock-⌘-Shift-4.

Your ImageWriter (or compatible) prints the contents of the screen; you cannot print a screen dump directly to a LaserWriter (or compatible).

Notes

To capture pull-down menus or any other “active” screen, you need a program such as Capture (from Mainstay), Image Grabber (from Sebastian Software), or SnapJot (from Wildflower Software).

See also Files and Printing.
A screen saver is a Control Panel device or INIT that replaces the active screen with a moving display. By replacing the inactive screen with a moving display, an image does not remain on the screen for an excessive period of time and thereby cannot etch a design into the sensitive phosphor coating on the inside of the Macintosh's picture tube.

Screen savers used to be relatively simple, but they have become elaborate affairs with designs ranging from schools of fish to flying toasters (see fig. S.3). Many screen savers include sound as well. AfterDark and Pyro! currently are the two most popular screen savers.

See also CDEVs and INITs.

Fig. S.3. Flying toasters—a fun screen saver.
Scrolling enables you to move through a window or a listing of files so that you can see additional parts of the window or list and, therefore, see more information. When you have a window that cannot show all of the contents of a folder (such as 100 files in a folder and the window shows only 20), you have to scroll through the window to get to the part of the document you want.

As you scroll, you see different parts of the window. You can use the horizontal and vertical scroll bars (located on the bottom and right sides of a window) to view all the information. Scroll bars are gray if there is more to see in a particular direction and white if there isn’t. You also can use the scroll box (the small white box in the scroll bars) to move quickly through a large file (see fig. S.4).

If you have an extended keyboard, you can use the Home, End, Page Up, and Page Down keys.

To scroll one screen at a time

Click the gray area on the scroll bar.
Click above the white scroll box to scroll up one screen; click below the white scroll box to scroll down one screen.

To scroll one line at a time
Click one of the scroll arrows at the end of the horizontal or vertical scroll bar.

Click the up arrow to scroll up one line; click the down arrow to scroll down one line.

To scroll through an entire document
Drag the white scroll box up or down the scroll bar.

Release the mouse button when the scrollbox is where you want it to be.

To scroll from one part of a document to another
Drag the scroll box within the scroll bar. Release the mouse button to scroll to that location within the document.

The distance the screen scrolls is proportionate to how far you drag the scroll box. If you drag the scroll box to the middle of the scroll bar, you move near the middle of your document.

See also Mouse, Size Box, Window, and Zoom Box.

SCSI

The Small Computer System Interface (SCSI) is a communications port that is an integral part of your Mac’s hardware system. You can attach up to seven different devices or peripherals to your Mac in a daisy-chain fashion using the SCSI (pronounced “scuzzy”) port. For example, you may have an external hard drive linked to a scanner that is, in turn, linked to a printer. SCSI opened the world of hard drives and
other optional add-ons to the Mac, such as a removable hard disk, CD-ROM drive, or scanner.

So that the Mac knows what’s attached to what, your system needs to know the number assigned to each of the SCSI devices connected to your system. Your Mac is automatically assigned number 7, so you can’t use that number. The manufacturer usually assigns a SCSI number as well. When you start adding peripherals, these numbers may clash.

In the old days, the only way that you could set SCSI address numbers was to take apart your hard drive and printer and then cut wires or install jumpers. No more. Most hard drives and printers come with easy-to-set SCSI ID switches. All you have to do to change the number is turn a dial, press a button, or flip a switch. The procedure is quick and simple—and it works.

Your Mac must encounter a terminator when it searches through a chain of SCSI devices. A terminator looks like a serial plug without the cable and goes on the last device in the chain. Many devices have built-in terminators.

See also Crashes and Hard Drives.

Searching

Searching involves locating a file or the contents of a file by using various utilities. Search tools are an integral part of most word processing programs. You specify what to look for, and your Mac finds it for you.

Applications that offer a search function also may offer a search-and-replace (sometimes called “change”) function (see fig. S.5). Search-and-replace allows you to change the text you find—you can change capitalization, spelling, or even substitute
terms. For example, to change the spelling of a particular string of characters throughout a document using Microsoft Word, you select the Change option from the Utilities menu and provide the characters for which you want to search. You indicate whether to replace the text with new text. Word then stops on the next occurrence of the characters.

![Change dialog box](image)

Fig. S.5. A Change dialog box.

Other utilities are external to any application (such as Find File) and can be used as desk accessories. Among these, Gopher and OnLocation are both fast and efficient in their search procedures, scanning 20M of disk space in a matter of seconds.

See also Find File.

### Set Startup

The first thing you see when you boot up your Mac is the desktop, with menus along the top, disk icons in the upper right, and a trash can in the lower right corner. You are not, however, limited to the desktop as your only startup option.

You may want to replace the Finder with MultiFinder. You also may want to open a specific file created with a specific application. You can use the Set Startup option from the Special menu to open a file or application automatically when you start up your Mac (see fig. S.6).
To startup with the Finder
1. From the Special menu, select Set Startup.
2. Click Finder.
3. Click OK, or press Return or Enter.
4. From the Special menu, select Restart.

To startup with the MultiFinder
1. From the Special menu, select Set Startup.
2. Click MultiFinder.
3. Click OK, or press Return or Enter.
4. From the Special menu, select Restart.

Notes
You must restart your Mac to activate new startup settings.

See also Finder, MultiFinder, Restarting.

Shut Down

Shutting down involves more than switching off your Mac. When you select the Shut Down command, your Mac takes all of the directory information and makes sure that it is written back to the disk where it belongs.
This housekeeping enables you to start with a clean slate the next time you turn on your Mac.

**To shut down your Mac**

1. From the **File** menu, select **Quit** (⌘-Q).
2. At the desktop, from the **Special** menu, select **Shut Down**.

On the Mac II series, the power automatically shuts off when the Mac finishes its housekeeping activities. (On some Macs, an alert box tells you when it’s OK to turn off your Mac.)

**Notes**

*Never* turn off your Mac with an open document on-screen. *Always* return to the desktop first.

See also **Quitting** and **Restarting**.

---

**SIMMs**

Single In-line Memory Modules (SIMMs) increase the amount of RAM available on your Mac. A SIMM is approximately 1 inch by 0.35 inches and consist of eight memory chips connected on an integrated circuit. Rather than having to solder the chips directly onto a board, the SIMM holds the chip and you insert the SIMM into the existing sockets.

**SIMM speed**

The speed of a SIMM is measured in nanoseconds—billionths of a second. The lower the number, the faster the chip. A fast chip is 80 nanoseconds; a slow chip is 120 nanoseconds. Faster is better, but it’s relative to price. If all you do is word processing, you don’t see a big difference between 80 and 120 nanoseconds. You do see a difference, however, with memory-intensive number crunching.
Installing SIMMs

Expect your local dealer to charge $60-$100 per SIMM chip to install. You can purchase SIMMs for about one-half the dealer’s price by purchasing via mail order. Many companies that sell SIMMs also include the tools you need to “break” the case of your Mac (check your warranty). Some vendors provide a videotape (at no extra charge) that details how to perform a RAM upgrade.

You can add SIMMs yourself if you are careful, read all the directions, and review the instructional material each step of the way. Adding SIMMs can be a tricky business and a disaster without the correct tools. If you are a do-it-your-selfer, remember to unplug your Mac before opening the case, and be sure you’re free of static electricity. You don’t want to shock your system.

SIMMs purchasing guidelines

If you do purchase SIMMs chips for do-it-yourself installation, ask the vendor the following questions:

- How long has your company been in business?
- Do you provide free technical assistance?
- Who manufactures the chips?
- What kind of warranty comes with the chips?
- How many SIMMs do I need to upgrade my 1M system to a 4M system? (Fill in the appropriate amounts)

Notes

Each SIMM usually holds 256K. Different Macintosh models require different SIMMs configurations. (Be sure to ask vendors about your individual needs.)

Adding SIMMs usually means that your Mac takes more time to boot up and does not necessarily mean
that it works any faster, although you can do more with it.

See also *Mail Order* and *RAM*.

---

**Size Box**

The size box, located in the lower right corner of a window (at the intersection of the scroll bars), enables you to resize the window (see fig. S.7).

To resize the window

1. Move your mouse to position the tip of the mouse pointer in the size box.

2. Press the mouse button and drag the size box in any direction—vertical, horizontal, or diagonal—until the window is the size you want it.

3. Release the mouse button.

---

![Jen's Stuff](image)

*Fig. S.7. The size box.*

See also *Mouse, Scrolling, Windows* and *Zoom Box.*
Special Characters

You can create special characters by using the Shift and the Option keys (in combination or alone). For example, to produce the Macintosh Apple 🍎, use the Shift-Option-K key combination in the Times or Chicago font.

To create a special character

At the location where you want to insert a special character, type the key combination as specified in the “QUICK KEY GUIDE” or Table S.1.

To create a special character in a different font

1. Type the keystrokes necessary to create the character.
2. Highlight the character(s) you want to change.
3. Select the new font.

For a quick reference to the most commonly used special characters, see Table S.1.

For a more detailed list of characters, refer to the “QUICK KEY GUIDE.”

To view a font’s special characters

1. From the Apple 🍎 menu, select Key Caps.
2. From the Key Caps menu, select the name of the font you want to view.
3. Press and hold the Option key to view one set of characters.
4. Press and hold the Shift key to view another set of characters.
5. Press and hold both the Shift and Option keys to view a third set of characters.
6. Type several characters using the Shift and Option modifier keys.
7. Click the close box to exit Key Caps.

You can type individual keys to see which characters they create. When you find the character you want, and you know which key-combination produces that character, return to your original document. Click where you want the character to appear. Type the necessary key-combination, and change the font, if necessary.

**Alternatives to Key Caps**

You probably will find it impossible to remember all of the Shift and Option key combinations and what they produce. To see the result of the combinations on-screen, you can use Key Caps or an alternative program.

Peter Norton’s KeyFinder shows you a screen of all the different characters, and when you click on the one you want, KeyFinder tells you the combination of keys you need to press. As you select different fonts, you see different symbols on the screen. This procedure is much easier than using Key Caps, and you also can cut and paste from KeyFinder to an application.

**Notes**

Some programs create “smart” quotation marks for you automatically. For example, in Microsoft Word, you can select the “Smart Quotes” option from the Preferences dialog box accessed via the Edit menu. This command tells Word to make true opening and closing quotation marks for you.

See also Fonts, Highlighting Text, Key Caps, and the “QUICK KEY GUIDE.”
### Table S.1
**Special Characters**

<table>
<thead>
<tr>
<th>Description</th>
<th>Key(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General characters</strong></td>
<td></td>
</tr>
<tr>
<td>• Bullet</td>
<td>Option-8</td>
</tr>
<tr>
<td>© Copyright</td>
<td>Option-G</td>
</tr>
<tr>
<td>... Ellipsis</td>
<td>Option-;</td>
</tr>
<tr>
<td>— Em dash</td>
<td>Option-Shift-- (dash)</td>
</tr>
<tr>
<td>— En dash</td>
<td>Option-- (dash)</td>
</tr>
<tr>
<td>- Hyphen; dash</td>
<td>- (dash or minus)</td>
</tr>
<tr>
<td>® Registered</td>
<td>Option-R</td>
</tr>
<tr>
<td>™ Trademark</td>
<td>Option-2</td>
</tr>
<tr>
<td><strong>Accents (type the symbol, then the letter)</strong></td>
<td></td>
</tr>
<tr>
<td>à Grave</td>
<td>Option-`, A</td>
</tr>
<tr>
<td>é Acute</td>
<td>Option-E, E</td>
</tr>
<tr>
<td>ü Umlaut</td>
<td>Option-U, U</td>
</tr>
<tr>
<td>ñ Tilde</td>
<td>Option-N, N</td>
</tr>
<tr>
<td>è Circumflex</td>
<td>Option-I, E</td>
</tr>
<tr>
<td>ç Cedilla</td>
<td>Option-C</td>
</tr>
<tr>
<td><strong>Quotes</strong></td>
<td></td>
</tr>
<tr>
<td>“ Opening double</td>
<td>Option-[</td>
</tr>
<tr>
<td>” Closing double</td>
<td>Option-Shift-[</td>
</tr>
<tr>
<td>‘ Opening single</td>
<td>Option-]</td>
</tr>
<tr>
<td>’ Closing single; apostrophe</td>
<td>Option-Shift-]</td>
</tr>
<tr>
<td><strong>Arrows (use Symbol font)</strong></td>
<td></td>
</tr>
<tr>
<td>↑ Up arrow</td>
<td>Option-=</td>
</tr>
<tr>
<td>↓ Down arrow</td>
<td>Option-Shift-O</td>
</tr>
<tr>
<td>→ Right arrow</td>
<td>Option-Shift-'</td>
</tr>
<tr>
<td>← Left arrow</td>
<td>Option-U</td>
</tr>
<tr>
<td><strong>Boxes (use Zapf Dingbats font)</strong></td>
<td></td>
</tr>
<tr>
<td>□ Box with shadow</td>
<td>O</td>
</tr>
<tr>
<td>■ Box, filled</td>
<td>N</td>
</tr>
<tr>
<td>□ Box, unfilled</td>
<td>n (outline)</td>
</tr>
</tbody>
</table>

See also the "QUICK KEY GUIDE."
A spreadsheet is an electronic ledger consisting of rows and columns that you use to organize information. The worksheets that you create (using programs such as Microsoft Excel or Wingz) enable you to manipulate numbers and text by providing you with a grid like the one you see in Figure S.8.

You can enter numbers or text at the intersections ("cells") of these rows and columns. You then can perform a variety of operations based on the information. For example, you can use a built-in function such as AVERAGE to add values in a group of cells and then divide the sum by the number of values. Or, you can create your own formula that performs any type of operation you want on one cell, or a set of cells, such as adding cell A1 to cell A2 and multiplying by 5: \((A1+A2)\times 5\).

You also can use spreadsheets to manage databases, although spreadsheet programs do not have the tools a full database management system has.
Finally, you can create stunning graphs and charts (such as the one you see in Figure S.9) that you can paste into other applications.

![Excel Spreadsheet](image)

*Fig. S.9. A Microsoft Excel chart.*

See also *Buying Software.*

**Startup Screen**

Tired of the same picture on-screen when you start up your Mac? Any graphic you can capture as a paint file, you can have appear on your Mac screen each time you start up your Mac. You must have an application that supports this capability.

**To create a startup screen**

1. Launch a paint program such as MacPaint or SuperPaint.

2. Create an illustration to use as a startup screen, or open the file containing the image you want to use as a startup screen.

3. From the **File** menu, select **Save As**.
4. Select the **Startup Screen** option (see fig. S.10).

5. Click **OK**, or press **Return** or **Enter**.

![Fig. S.10. Saving a startup screen using MacPaint.](image)

The next time you start up your Mac, the setup screen—not the regular desktop pattern—appears.

**Notes**

Your startup screen file must reside in your System Folder.

See also **Restarting** and **Saving**.

**System**

Computers are nothing more than a collection of hardware components such as integrated circuits, resistors, and switches. What makes your Mac do all the wonderful things it does? An operating system.

The operating system is the brains of any computer. This software enables you to do everything from boot up to the desktop screen, to cut text from one application and paste it into another.

System software comes on disk with every Mac. The System is responsible for all those things you can’t
see: organizing files, keeping track of file names and the date when they were last modified, and storing text or graphics in the Clipboard.

As the Macintosh grows more powerful and offers more features, the need for increasingly sophisticated Systems also grows. The latest version (as of this printing), System 6.0.7, offers more options and smoother operation than any previous System. You usually can get the latest System update from your Apple dealer.

System 7.0 is the new version of the Macintosh operating system (due from Apple sometime in 1991). For information on its features and how to use them, refer to the next section of this book: "SYSTEM 7 FIRST LOOK."

To check System and Finder version numbers
At the desktop, from the Apple menu, select About the Finder.

Click the close box to exit the information window.

To install a new version of the System and Finder
1. At the desktop, from the Special menu, select Shut Down.

2. Insert a copy of the Macintosh Systems Tools disk into a floppy drive.

3. Turn on your Mac.

4. Double-click on the icon of the Systems Tools disk and then double-click on the file named Installer.

5. Select your model of the Mac from the list that appears.

6. Click the Drive button to select the drive you want to contain the new System Tools (for example: your hard drive).

7. Click the Install button and wait.
The System, the Finder, and other important files automatically transfer. You also can install a new System and Finder by copying the files from one disk to another. Be sure and put the System and Finder into the System Folder. There should be only one System Folder per disk.

To see if you have more than one System file on your disk

1. From the Apple menu, select Find File.
2. Type system. Press Return or Enter.
   Find File shows you a list of files containing "system" in the file name.
3. Click the individual files to see where they are located.
4. Delete all files but the one system you want to use in the System Folder. You will probably want to keep the latest version.
5. From the Special menu, select Restart.

To activate a different System

You may want to take advantage of what another system might offer (such as a DA or Font not available on the System installed on your hard disk). To do so, you have to make this other System dominant.

1. Press and hold the Option key.
2. Double-click on an application on the disk containing the System you want to activate.

The icon located in the upper right corner of the desktop represents the dominant drive.

Notes

To create a bare-bones startup disk, you need only two files: the System and the Finder.

Newer versions of system software take up more memory and more disk space. If you are working on
an older machine, or a floppy-disk-based system, you may want to keep using an older version of the system software.

See also *Bulletin Boards, Find File, Finder, Get Info, Installing Software*, and "SYSTEM 7 FIRST LOOK."

---

### Telecommunications

Telecommunications have become increasingly more sophisticated over the past few years. You now can connect with another computer through your Macintosh.

For the price of a modem (starting at around $100), and a communications package, you can connect with the world. You can send and receive messages, download free games and programs, ask questions of experts thousands of miles away, go shopping, compare airline flights, advertise your talents, check the weather forecast, access the computer at the office from your home, and so on. You even can send and receive faxes using your Mac.

### Purchasing considerations

A good telecommunications program should do the following:

- Use on-screen, rather than modem, buttons to control functions.
- Offer automatic answering, dialing, and redialing.
- Supply on-line help.
- Transmit sound, graphics and color.
- Supply an on-line timer so that you can track billing charges.
• Use a command language for customizing telecommunications functions.

• Support multiple protocols including the major ones such as XModem, YModem, and Kermit.

• Support terminal emulation (so that you can talk to mainframes).

The leading telecommunication packages, both of which incorporate the above features and more, are White Knight (formerly the public domain program called Red Ryder) from FreeSoft, and MicroPhone II from Software Ventures. White Knight is a tremendously powerful telecommunications package. You can tell by its version number (11!—Red Ryder went through 10 upgrades) that the program has been around awhile and has been enhanced through numerous upgrades.

See also Bulletin Boards and Modems.

**Trash Can**

The Trash Can, located in the lower right corner of the desktop, is the destination of files you want to delete, and floppy disks you want to eject (see fig. T.1).

A file dragged to the Trash Can remains in the Trash Can until you do one of three things: select the **Empty Trash** command from the **Special** menu, shut down your Mac, or launch a new application.

A bulging trash can icon indicates that you have trashed a document (marked it for removal). You can retrieve the file from the trash, but you must act fast! (see fig. T.2).
Once your bulging Trash Can slims down, your only hope of retrieving a trashed file is through the use of a recovery program such as The Norton Utilities for the Macintosh.

To delete a file or folder

1. At the desktop, drag the icon for the file or folder you want to delete to the Trash Can at the lower right corner of the screen.

2. When the Trash Can icon reverses, release the mouse button.

To delete several files

1. At the desktop, Shift-click to select the files you want to delete.

2. Drag any one of the selected items to the Trash Can. The rest of the selected items move as well.
3. When the Trash Can icon reverses, release the mouse button.

**To retrieve a file from the Trash Can**

1. Double-click on the Trash Can icon to open it.
2. Drag the file you want to retrieve out of the Trash Can window to a location on the Desktop.
3. Click on the close box to exit the Trash Can window.

**To empty the trash**

At the desktop, from the Special menu, select Empty Trash.

You also can empty the trash by launching an application or shutting down the Mac.

This procedure is irreversible.

**To eject a floppy disk**

1. Drag the icon of the floppy disk to the trash.
2. When the Trash Can icon reverses, release the mouse button.

The data on the trashed disk remains intact.

**Notes**

You can retrieve a trashed item only if the trash can is bulging.

To clear off space on a disk, you may drag items to the trash. However, the disk won’t recognize that space as available until you “empty the trash.”

See also Deleting Files, Files, and Mouse.
What do you do when things won’t work?

First, think about recent events. What has changed recently? Did you install a new program? Experience a crash? Add new INITS, desk accessories, or games? Set the RAM cache? Delete an application or system file?

Are you using new System software? Are you running Suitcase II? Did you download recently any files from a bulletin board? Did you turn on MultiFinder? Have you been playing with ResEdit? Are you running QuicKeys\(^2\) or Tempo II?

The following is an attempt to help you when you get stuck. Keep in mind that most problems are easily solved, and that you are never alone in your suffering.

If your computer won’t start...

If your system won’t start, ask yourself the following questions:

- Is your computer plugged in?
- Is your surge protector turned on?
- If you have an external hard drive, is the hard drive turned on? Did you turn it on prior to turning on the Mac?
- Are all your cables connected securely?
- Are your peripheral devices turned on?
- Is your monitor turned on? Is the brightness turned up?

If your Mac is making unusual noises, take it to an authorized service facility.
If your hard disk won’t boot...

The blinking question mark doesn’t go away. Your hard disk cannot seem to startup. One or more of the following situations may be the cause of the problem:

• Damaged boot blocks on your hard disk.
• A corrupted Desktop file.
• A corrupted or incompatible System and/or Finder.
• More than one System file or System Folder on your hard disk.
• Corrupted PRAM.
• A corrupted directory.
• Incompatible INITs contained in your System Folder

The first thing you should do is to rebuild the desktop. Hold the ⌘ and Option keys as you startup your Mac.

If rebuilding the desktop doesn’t work, try starting up from a floppy disk or any other startup device such as an external drive.

If your Mac doesn’t start from a hard disk or a floppy disk, you should have it serviced. Ask the service person to recover as many files as possible.

If your Mac starts from a floppy disk, but not from the hard disk

If your Mac starts up from a floppy disk, try the Restart command to see if the hard disk can now startup on its own. If you can boot up only from a floppy, and the icon for the hard disk appears on the desktop, back up as many files as you can.

Remove the INITs from the System Folder on the hard disk. You don’t have to delete them, just move them out of the System Folder (put them in a new folder
called "INITs"). Restart your Mac. If your hard disk now starts, an INIT is the culprit. Try putting one INIT at a time back into your System Folder and restarting. This technique isolates the conflicting INIT.

**If INITs are not the problem**

If taking INITs out of the System Folder on your hard disk does not solve the startup problem, install new System files from copies of your original Apple System disks. Use the Installer program. After installing new System files, try Restarting. You also can drag the System Folder from your hard disk to the trash, and copy the System Folder from your startup disk onto your hard disk.

Try using the Disk First Aid program that comes with your Mac.

If problems continue, zap the PRAM.

**To zap your PRAM**

1. Press and hold the Option-3€-Shift.
2. From the Apple menu, select Control Panel.
3. Click Yes.

**If your Mac ejects your startup disks**

When your Mac starts up, it ejects disks that do not contain System and Finder files.

Try a different startup disk. If the new startup disk works, copy the System Folder from the working startup disk to the ailing startup disk. If none of your startup disks work, you may have a problem with your disk drive.

**If you get a sad Mac face with a numerical error message beneath it**

Write down the message and take the Mac to your dealer or a computer technician.
To create an emergency startup disk

For those times when your computer acts unpredictably, you can be somewhat prepared by having an emergency startup disk ready.

An emergency startup disk should contain a System Folder containing a System and a Finder, and Disk First Aid, and possibly any hard disk utilities that came with your hard disk. If you purchase utility software, you may want your emergency startup disk to contain any utilities you’re likely to use in an emergency situation. Some utility programs contain a log application that records your Mac’s activities.

If your Mac asks you to initialize your hard disk

DON’T! Rebuild the desktop by holding down the ⌘ and Option keys when restarting your Mac. If you don’t get the alert box asking if you want to rebuild the desktop file, try starting up from a floppy disk.

If you get the message “…not a Macintosh disk. Do you want to initialize?”

All new unformatted 3 1/2-inch floppy disks will ask you to initialize them. If you are sure the disk is blank, you must initialize it in order to put data on the disk.

However, IF THE DISK CONTAINS DATA, DO NOT INITIALIZE the disk, unless you’re sure you want to erase all data on that disk.

If the Mac cannot read that disk, ask yourself the following questions:

- Are you inserting a high-density (HD) disk into a double-density (DD) disk drive?
- Are you inserting a DOS-formatted floppy into a Mac disk drive?

If you have a floppy disk that won’t work

The floppy disk was fine yesterday, but it won’t work today. Or, it’s a new disk that won’t initialize. The disk
may be damaged. Try a utility program (such as SUM II or Norton Utilities) to recover the data on that disk. If you come to terms with the fact that any data on the floppy disk may be lost, you can try to reinitialize the disk. If this procedure fails more than once, consider the disk destined for the trash heap—the real trash heap.

**If you have an application or desk accessory that continually crashes**

If crashes occur when using specific programs, try loading a fresh copy of the program onto your disk.

**If you get the message “file...could not be opened/printed...the application is busy or missing”**

Chances are, you double-clicked on a System file, such as the Clipboard or LaserPrep file—something that you really can’t *launch*. Try double-clicking on an application icon. Then open your document from within that application, or create a new document.

**If you can’t find a file**

Use the Find File desk accessory to locate the file. Select *Search Here* from the *Find File* menu to scan a different disk.

**If you have a blank screen with a menu bar**

You are working on your Mac, and suddenly you find yourself staring at a blank screen with a menu bar at the top of the screen. You are in application limbo. Did you click the close box when you had a document on-screen? If so, the application is still active. From the *File* menu, select *Quit*. You return to the desktop.

**If you can’t print**

Check your cables. Check your power switches. If you have an ImageWriter, make sure the Select button is on. Check the Chooser desk accessory from the Apple menu. Are all three items selected: the printer icon, the printer name, and the user name? Try shutting
If you are having trouble printing your documents, try the following steps:

1. **Down and Restarting Your Mac and Printer**: If you have a print spooler, such as SuperLaserSpool, did you select the Pause button? If so, click Resume.

2. **If What You See Isn't What You Get**
   - If your document prints sideways, check the Page Setup orientation selection from the File menu.
   - If your page breaks in a strange place, check to see if you inserted a manual page break. Check the margin settings in your Page Setup dialog box.

See also **Backups, Crashes, Disks, Erasing Disks, Error Messages, Find File, INITs, Printing, and System**.

---

**Undo**

Most Macintosh applications have an Undo command, generally accessed through the Edit menu, or activated through **⌥-Z** (see fig. U.1). Undo enables you to do just that: undo your last operation. For example, suppose that you deleted a paragraph of text in Microsoft Word and wanted to restore it. Under the File menu, the command reads as Undo Typing and, once selected, the deleted paragraph is restored.

![Edit Menu](image)

**Fig. U.1. The Edit menu contains the Undo command.**

Many Mac users try to correct a mistake rather than try the Undo command immediately after making an
error. Remember, most undos work only on the last operation, so try Undo first.

**To undo a command or action**
Before you do anything else, from the Edit menu, select Undo (⌘-Z).

**Notes**
If you cannot "undo" your action, try quitting without saving your document. (Another reason to save often.)

Different applications enable you to undo different actions. For example, Microsoft Word enables you to undo a sort but will not allow you to undo the Go To command.

Some applications allow for multiple undos—Nisus allows for up to 32,000 undos!

See also Quitting and Saving.

---

**Upgrading**

Upgrading is the process of enhancing the capabilities of your computer system. You can upgrade your system by increasing the memory, the size of the hard disk, or even getting a new monitor. The most common upgrade is to increase the amount of RAM that your Macintosh can make available to applications and data. Generally, the more memory that your Mac has available, the faster the system can work and handle applications that require more "room" for specific operations.

If you plan to do the upgrading yourself, remember to check your warranty first. If you are going to void your warranty, you might as well be aware of it.

See also Buying Hardware, Monitors, RAM, and SIMMs.
Utilities

A utility is a software tool that makes your Macintosh activities easier and more efficient. Although some software programs help you manage data or manipulate words, utilities keep your system in tip-top shape through such tasks as compressing files, moving and copying files from one location to another, deleting files when necessary, creating charts, undeleting files, automating keystrokes, switching applications, optimizing your hard disk, saving screens, undeleting files, and searching for text phrases. Many utilities function as desk accessories; others may be Control Panel devices or separate applications.

See also CDEVs, Desk Accessories, INITs, Macros, Recovering Data, and Screen Savers.

Viewing Files

The View menu on the desktop enables you to decide how you want to view the contents of a Macintosh window or the contents of a disk. You can view files by small icon, icon, name (see fig. V.1), date when they were last changed, size (from biggest to smallest), and kind (based on the application used to create them or the type of file).

To change the current view

1. At the desktop, open the window you want to view.

2. From the View menu, select how you want to view the file: by Small icon, Icon, Name, Date, Kind, or Size.

On color machines, you also have a view by color option.
If you view by icon or small icon, you may find that icons overlap because too many are in one window.

### To make frequently used files more accessible

Drag the icon of the frequently used file onto the desktop.

When you no longer need the icon to be readily available, select the icon. From the **File** menu, select **Put Away**. The file goes back to where it was before you moved it to the desktop.

### To make files appear at the top of an alphabetical file listing

Change the first letter of the file to a space, dash, or bullet.

### To list files numerically

To arrange numbered files in numerical order (1, 3, 5, 10, 11, rather than 1, 10, 11, 3, 5), place a leading 0 (zero) in front of the single-digit numbers.

### To align an icon to the invisible grid

1. Select all the icons you want to snap to the invisible grid.
2. From the **Special** menu, select **Clean Up Selection**.

*To align an icon to the invisible grid*
1. Select the icon(s) you want to snap to the invisible grid.
2. From the **Special** menu, select **Clean Up Selection**.

*To move together spread-out icons*
1. Press and hold the **Option** key.
2. From the **Special** menu, select **Clean Up**.

See also *Files, Mouse, Opening Files.*

---

**Virtual Memory**

The Macintosh uses many types of memory, including RAM and ROM. One type of memory—virtual memory—enables you to use space on your hard drive as RAM. This method is slower than using RAM because data has to be transferred from the CPU to the hard disk and back again. Your application, however, does not know that it is accessing data from the hard disk versus the CPU's RAM. Virtual memory speeds up your work and increases the amount of RAM memory you have available to perform memory-intensive operations.

For example, if you have a 40M hard disk with at least 10M unused, you can use virtual memory to access up to 8M (or as much as your Macintosh can handle) of additional RAM.

The only caveat in this seemingly something-for-nothing procedure, is that the more actual RAM you have, the better virtual memory works. So if you have 1M of RAM and use virtual memory, your Macintosh
does not work as efficiently as if you were to have 2M or more of "real" RAM. The general rule is the more actual RAM you have, the better your system is able to work with virtual memory, and the less likely you are to notice your machine slowing down to go to the hard disk for data.

You do not have to have System 7 in order to utilize virtual memory. You do, however, have to have a PMMU chip, and a 68030 processor.

See also PMMU, RAM, RAM Cache, and "SYSTEM 7 FIRST LOOK."

---

**Viruses**

A virus is a small computer program that attaches itself to another program and then causes damage. Although scores of viruses exist, the two most common are the Scores virus and the nVir, which have infected millions of files over the past few years. A Trojan Horse is a virus that does not reproduce itself once it attaches to another program.

**To protect against viruses**

You can reduce the possibility of contracting a viral infection by taking the following precautions:

- Put a virus-protection program (such as SAM or Virex) on your Mac to scan all incoming disks for potential germs. (Lock the virus-protection disk before you insert it into your machine!)
- Only use software that is available through conventional and commercial channels. When you borrow an application from a friend, you increase the risk of virus attacks (as well as the possibility of breaking the law).
• If in doubt, don’t copy applications that may be infected.

• Be especially cautious (but not paranoid) about “new finds” on bulletin boards.

**How can you tell if you have a virus?**

The behavior of an infected system may mimic the behavior of a non-infected system. You may find your system crashing repeatedly, no matter which application you use. You may see unfamiliar dialog boxes, altered icons, or unusual screen patterns. An application may behave differently. Programs may disappear from your hard disk. You may have trouble opening and closing windows. You may be unable to print.

If you haven’t been “interacting” with bulletin board files or disks from someone else’s machine, you can try the remedies discussed in the *Crashes* and *Troubleshooting* sections. If those procedures prove unsuccessful, scan your system with a virus-detection program.

**Virus protection software**

Virus protection utilities generally check files when you insert a floppy and enable you to repair the disk and destroy the detected virus. The best commercial products—such as Virex (from Microcom), SAM II (from Symantec), and Antitoxin (from Mainstay)—monitor your file activity and prevent any virus infections. You first should check and repair (if necessary) files that already exist on your hard disk.

As you read this, someone is creating a new virus. Be sure to keep up-to-date on your virus protection programs. If you purchase a subscription to Virex, Microcom sends you updated virus-protection software as new viruses are discovered.

See also *Crashes* and *Troubleshooting*. 
A window is the Macintosh’s primary tool for organizing information and displaying the contents of a file or a folder. A window is a separate workspace with its own title, and it is independent from any other windows that may be on the desktop. Although you can have more than one window open, you can have only one window active. The active window is always the one window that is front-most on your screen and has horizontal lines in the title bar. You can move, resize, and scroll through windows.

To open a window
Double-click on the icon of the disk, file, or folder you want to open or press ⌘-O.

To close a window
Click the Close box in the upper left corner of the active window, or press ⌘-W.
To close all open windows on the desktop
Press and hold the Option key and click the Close box of the active window.

To activate a window
Click anywhere in the window.

To move a window
Drag the title bar of the window to the new location.

To move a window without making it active
Press and hold the 3C key and drag the window by the title bar to its new location.

To change the size of a window
Drag the size box in the lower right corner of the window.

To enlarge a window to the full screen
Click the Zoom box in the upper right corner of the window. Click the Zoom box again to revert to the Window's previous size.

To scroll one line
Click the scroll arrow in the direction you want to scroll (up, down, left, or right).

To scroll up or down one screenful
Click in the gray scroll bars above or below the white scroll box, or use the Page Up and Page Down keys.

To scroll in large increments
Drag the white scroll box from one part of the scroll bar to another.

See also Files, Mouse, Printing, Scrolling, Size Box, and Zoom Box.
Word Processing Programs

Word processing programs enable you to create and manipulate text; store one paragraph or 100-page documents for later retrieval, review, and printing; and perform magical format changes to produce attractive documents. Word processors come in all shapes and sizes, from a simple desk accessory you use to address an envelope to those designed specifically for desktop publishing. The leading word processor is Microsoft Word, followed by other contenders such as WordPerfect for the Mac (from WordPerfect), MacWrite II (from Claris), WriteNow (from T/Maker), Nisus (from Paragon), and FullWrite Professional (from Ashton-Tate).

Basic word processors enable you to enter, edit, save, and print text. Most word processors let you check spelling, format text, number pages automatically, change margin and tab settings, select page orientation, apply headers and footers, select paragraph alignment, insert page breaks, and perform searches and replacements.

Powerful word processors enable you to sort alphabetically, find a synonym, use style sheets for specific formatting tasks, perform redlining procedures, use macros, generate tables of contents, indexes, footnotes and bibliographies, import graphics files, and create columns of text.

Word processors are often powerful enough to substitute for sophisticated and costly page-layout programs. Also, look at integrated packages such as Microsoft Works and Ragtime (from Ragtime USA) that include powerful word processors, as well as database management systems, spreadsheets, graphics (as with Ragtime), and communications capabilities.

See also Buying Software and Desktop Publishing.
You can use the Zoom box located in the upper right corner of most active windows to enlarge or reduce the size of the window (see fig. Z.1). The Zoom box works like a toggle switch. Each time you click it, the window enlarges or decreases in size.

Fig. Z.1. The Zoom box.
SYSTEM 7 FIRST LOOK

As those wizards who originally brought us the Mac continue their research and development work, they offer new and more powerful Systems. The latest System enhancement is System 7. System 7 is Apple's first release of a major system enhancement in over three years.

This section of The Little Mac Book discusses some of the new features in System 7. Many features—such as cutting and pasting and moving a file—remain the same between older Systems and System 7, but other features have changed.

What's New With System 7?

Many items are new to System 7, and several new features make your Macintosh a more useable and powerful machine. Note that all of the following features may not end up in the final release of the software.

Here's a rundown of the features System 7 contains (as of the date of this printing):

• A new Finder that enables you to place an unlimited number of DAs in the Apple Menu Folder (contained in the System Folder), rather than using the Font/DA mover.

• A new system for installing fonts that enables you to drop them into a folder in the System Folder.

• A new Trash Can that empties only when you tell it to (select the Empty Trash Can command), and not when you shut down or launch an application.
• You can make any item a selection on the Apple menu. You can access desk accessories, applications—even files—quickly and easily through the Apple menu.

• Macintosh FileShare, which is a tool for sharing files over an AppleTalk network without a dedicated server.

• Virtual memory, that enables your computer to use your hard disk as extra RAM.

• A new printer architecture that enables you to create new printer drivers as well as background printing, so that you can print while you continue to work.

• InterApplication Communication Architecture (IAC), for linking data between applications. IAC will eventually allow developers to design a system where every element is linked, thereby giving you control over how information flows from one application to another.

• A new font technology (TrueType) that enables you to produce high-quality output, even on your ImageWriter. You also can control such desktop publishing processes as kerning (the spacing between letters), by using the Layout Manager.

• Database Access Manager, for linking data to remote databases.

Should You Get System 7?

Should you make the switch? Here’s the big plus: More power and tools to make your Mac life easier. Another favorable change is the ease with which old Mac features are now integrated into the Finder.

However, there are minuses as well:
• You must have at least 2M of RAM.
• You cannot use virtual memory on certain Macs without upgrading, which can be costly.

Most people will not want to be pushed into spending a lot of money for more RAM before they see what they are buying and until Apple fixes any bugs found in System 7. This process will take some time. Until then, System 7 probably will not be required to run new applications.

In the future, certain Mac applications may only run under System 7. That may leave lots of Mac users unable to keep up with software and system changes. There is talk, however, of creating applications that work with both Macs using System 6 and Macs using System 7.

The gurus have mixed opinions. Many believe you should have System 7 available but should not yet get rid of System 6. Others believe you should go cold turkey and go to 7 as soon as it comes out, and you should pay the money for the disks and whatever else you might need to upgrade. There is one other option: you can wait until the dust settles.

How Do You Get System 7?

System 7 will come with Macintosh computers manufactured after the System 7 release date that can support the new operating system. User groups and bulletin boards will distribute System 7, and the software will be available on CD-ROM. You will be able to get System 7 at your local Apple dealer for approximately $49.
It's in Apple's best interest to get the word out quickly, so the company will make every effort to sell System 7 at the lowest possible price.

Apple plans to make System 7 available to you sometime in the Summer of 1991.

**What Do You Need to Run System 7?**

If you want to use System 7 and have been putting off that memory upgrade, you now have the perfect reason: System 7 will not work with anything less than 2M of RAM.

To run System 7, you must have the following:

- Any Mac from the Plus up
- At least 2M of RAM
- A hard drive
- 800K floppy drive to read the system disks

You can get System 7 up and running on the old Macs, such as the 128K and 512K machines, but you will need a new motherboard, in addition to the items above. Adding these items to an old Mac is costly. For example, to get a 128K machine going, you can spend upwards of $1,500—and even then the result is a relatively slow machine. Why not just put that money toward one of the new Macs that can run System 7 with little modification?

**System 7 vs. System 6**

When you use System 7, you find that certain tasks are different. The following chart compares the new System 7 operating system to the old System 6 operating system.
### Table 7.1
System 7 vs. System 6

<table>
<thead>
<tr>
<th>You Used To...</th>
<th>Now You...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplicate a file and get a file named <em>Copy of filename.</em></td>
<td>Duplicate a file and get a file named <em>Filename #1.</em></td>
</tr>
<tr>
<td>Install a font using the Font/DA Mover.</td>
<td>Drag fonts into the System Folder.</td>
</tr>
<tr>
<td>See how a font looked by using it.</td>
<td>Click on a font to see how it looks.</td>
</tr>
<tr>
<td>Copy a file and place the copy in another location for easy access.</td>
<td>Create an alias.</td>
</tr>
<tr>
<td>Drag an INIT into the System Folder.</td>
<td>The system directs the INIT to a folder named “Extensions.”</td>
</tr>
<tr>
<td>Work with one control panel through which you access all CDEVs.</td>
<td>Each CDEV has its own control panel.</td>
</tr>
<tr>
<td>Be limited to 15 fonts or desk accessories.</td>
<td>Have no limit on fonts or desk accessories (other than disk space).</td>
</tr>
<tr>
<td>Press <strong>Shift-d</strong> to create a screen dump.</td>
<td>Create a Picture file.</td>
</tr>
<tr>
<td>Empty the Trash Can by restarting your Mac, launching a new application, or selecting the <strong>Empty Trash</strong> command.</td>
<td>Empty the Trash Can through the <strong>Empty Trash</strong> command only.</td>
</tr>
</tbody>
</table>
Table 7.1 (continued)

<table>
<thead>
<tr>
<th>You Used To…</th>
<th>Now You…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Double-click on a folder to view its contents</td>
<td>Click on the dot next to the folder icon.</td>
</tr>
<tr>
<td>Forego the active use of a Mac file server on a network.</td>
<td>Use FileShare, which permits a server to be an active part of the network.</td>
</tr>
<tr>
<td>Select a file or folder by scrolling through a list.</td>
<td>Type the name of a file or folder.</td>
</tr>
<tr>
<td><strong>Shift-Click</strong> to select files.</td>
<td>Use the <strong>Find</strong> and <strong>Find Again</strong> commands to locate and select files.</td>
</tr>
<tr>
<td>Use a special utility to display large fonts on-screen properly.</td>
<td>Have TrueType, which makes all fonts in all sizes display accurately.</td>
</tr>
<tr>
<td>Specify when to use MultiFinder as a startup option.</td>
<td>MultiFinder operates automatically.</td>
</tr>
<tr>
<td>Be limited by the physical memory of our Mac.</td>
<td>Use virtual memory.</td>
</tr>
<tr>
<td>Scream for help and no one answered.</td>
<td>Access on-line system help.</td>
</tr>
</tbody>
</table>
The following section contains an alphabetical listing of topics related to System 7 features.

The information is based on a pre-release version of the software. There may be differences when the final product ships.

**Aliases**

You can assign an Alias (literally, the "same thing") to a file or a folder and place the alias anywhere on the desktop or in any folder. You are, in effect, creating multiple icons for the same file or folder. When you create (or in System 7 lingo, "make") an alias, you are placing only a reference to that file or folder in another place—not the actual contents of that file or folder.

In effect, System 7 enables you to organize the same information in different ways. For example, you can have all your folders organized by application (word processor, database, and so on), and then have aliases in other folders that organize the same information by creation date. Or, you may have a cover letter for an annual report that contains documents you created using WriteNow and Microsoft Excel. Where should the letter go? You can place the letter in the WriteNow folder and an alias for that letter in the Excel file as you see in Figure 7A.1. The information management schemes are endless; you can customize them to suit your needs.

You can treat an alias as you would treat any other file. When you double-click on an alias, the original file—not the alias—opens.
The Little Mac Book

---

### Excel

<table>
<thead>
<tr>
<th>Name</th>
<th>Size</th>
<th>Kind</th>
<th>Le</th>
</tr>
</thead>
<tbody>
<tr>
<td>annual report letter alias</td>
<td>1K</td>
<td>alias</td>
<td></td>
</tr>
<tr>
<td>CDA&amp;B Budget 1990-1991</td>
<td>1K</td>
<td>Microsoft Excel docu...</td>
<td></td>
</tr>
<tr>
<td>ch4 hard drive comp</td>
<td>3K</td>
<td>Microsoft Excel docu...</td>
<td></td>
</tr>
<tr>
<td>Chb5 - PLP II</td>
<td>9K</td>
<td>MacPaint document</td>
<td></td>
</tr>
</tbody>
</table>

**Fig. 7A.1. An alias of a file in another folder.**

---

### Apple Menu

Do you want instant access to any application, desk accessory, or alias? All you have to do is drop the file into the Apple Menu Folder in the System Folder.

Notice the contents of the Apple menu in Figure 7A.2. You see some of the standard DAs such as the Alarm Clock, Chooser, and DiskTop, a Control Panel device. However, you see not-so-standard items as well.

- Alarm Clock
- Battery
- Calculator
- Chooser
- Control Panels
- DiskTop
- Find File
- Image Grabber™
- Key Caps
- Scrapbook
- Smart Art™

**Fig. 7A.2. Items available under the Apple menu.**

Placing items in the Apple menu is a great way to have constant access to those applications, files, and other tools that you use often.
AppleScript

System 7's programming language is supposed to be the language (like the computer) for the rest of us. Like HyperCard's HyperTalk, AppleScript provides plain English commands that enable you to program the Mac.

AppleEvents is a set of messages such as "Open File," that all applications understand. You can use AppleEvents to control the activities of one application from another application. For example, you can "program" the Finder to open a document automatically upon starting up.

See also IAC.

CDEVs

Control panel devices located on the Apple menu operate like CDEVs of earlier systems. Previously, you accessed CDEVs through one control panel window. Each System 7 CDEV has its own window where you manage and change the settings.

To select a particular CDEV

1. From the Apple menu, open the Control Panels icon. All of the icons representing Control Panel devices are shown (see figure 7C.1).

2. Double-click on the device you want to use.

3. Make any desired adjustments.

4. Click the close box to close the window.
Remember the System 6 Control Panel? Say goodbye to it. You access the System 7 Control Panels folder from the Apple menu (see fig. 7C.2). The System stores control panel devices in the Control Panels folder. When you select Control Panels, you see all the Control Panel devices (CDEVs). You then need to select the device you want, whether you are setting the Alarm Clock or launching Microsoft Word.

The Control Panels folder contains the following features:
• *General* controls the desktop pattern, the mouse blink rate, the menu blink rate, and the time and date. This control panel is similar to the General device in earlier systems.

• *Keyboard* controls the keyboard repeat rate and the delay-until-repeat rate. You also use this option to set the keyboard for a foreign language.

• *Labels* enables you to attach your own label to a particular file (see fig. 7C.3).

<table>
<thead>
<tr>
<th>figures</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
</tr>
<tr>
<td>➡️ MacPaint</td>
</tr>
<tr>
<td>□ alias</td>
</tr>
<tr>
<td>□ apple menu icons</td>
</tr>
<tr>
<td>□ dt contents</td>
</tr>
<tr>
<td>□ find creation 1</td>
</tr>
<tr>
<td>□ hide balloon</td>
</tr>
</tbody>
</table>

*Fig. 7C.3. File names and labels.*

• *Monitors* controls the type of monitor you are using (black-and-white or color).

• *Mouse* controls basic mouse adjustments, including tracking and double-click speed.

• *Network Setup* controls system accessibility and verifies passwords. This device permits you to set the number of connections (nodes) on a network and whether you want to share files with others on the network.

• *Portable* controls settings specific to the Mac Portable.

• *Sound* enables you to select a sound (such as "Boing") and adjust the speaker volume.

• *Startup* enables you to specify any disk as the startup disk.
• *Views* lets you control which information appears on the desktop and adjust the appearance of this information (see fig. 7C.4).

![Fig. 7C.4. The Views Control Panels device.](image)

See also *Desktop*.

---

**Database Access Manager**

The Database Access Manager (no acronym?) enables you to connect your Macintosh applications with databases on other (host) computers. You can use a page layout program such as PageMaker, for example, and import data from an entirely different system. The success of this procedure depends on the application importing the data.

---

**Desk Accessories**

Desk accessories are still desk accessories, but System 7 changes a few things. You no longer need to use the
Font/DA Mover to install or remove fonts or desk accessories. You simply drag fonts and DAs into (and out of) the Apple Menu folder.

There is no limit to the number of items you can have on the Apple menu. You can put ten or one hundred DAs on the menu. If you have more DAs than can fit on the menu on one screen, you see an arrow at the bottom telling you to scroll to see the rest of the list.

The System 7 desktop looks basically the same as the desktop from earlier systems (see fig. 7D.1). Note, however, the following differences:

- You can customize the desktop through the View and Label Control Panels.
- You can view the contents of a folder in the same window as the folder containing those files.

![Fig. 7D.1. The System 7 desktop.](image)
Empty Trash

With earlier versions of the System, to delete a file, you select the file and drag it to the Trash Can. When you delete a file in System 7, however, it remains in the Trash Can until you select the **Empty Trash** command from the **Special** menu.

In earlier systems, the Trash Can emptied automatically when you shut down your Mac or launched an application. With System 7, the Trash Can serves as a folder where you can store items as long as you like. You—not the System—are in control of your trash.

Extensions

Extensions is the name of a new folder contained in the System Folder. The Extensions folder holds INITs, which the System uses when you boot up your computer.

To install an INIT, drag the INIT into your System Folder. Your Mac automatically puts the INIT in the Extensions folder. System 7 is smart and self-sorting: it takes information and places the information where it belongs.

The INIT loads when you restart your Mac.

FileShare

AppleShare, Apple's server product, requires a Mac dedicated to storing and distributing files. In contrast, Apple FileShare, an integral part of System 7, is a non-dedicated AppleTalk Filing Protocol server. What does that mean? Well, with Apple FileShare software,
a Mac specifically assigned to managing the network can now be used for other tasks.

**Finding Files**

Find File replaces the old desk accessory of the same name. The new Find File works the same way as the old Find File, but it is much faster—Apple claims it can search an 80M hard disk in three seconds.

Find File is great for finding a particular file and the file’s location, but System 7 comes with other powerful search utilities. You invoke these utilities by selecting the Find command from the File menu. The Find command searches for and selects files that meet the user-defined criteria.

You can search for file size, name, or version; whether the file is locked; or when the file was created or modified (see fig. 7F.1). After you search and find what you specified, you can use the Find Again command to resume the search. The system searches through the information in the Get Info windows (which contain the necessary information), rather than through the individual files.

![Fig. 7F.1. The More Choices dialog box.](image-url)
To find a file

1. From the File menu, select Find.

2. Click the More Choices button.

3. Select the various criteria by which you want to search. The general categories of criteria are as follows:

   • Name, Size, Version, Comment, Label, Kind, Lock, Creation Date, and Modification Date.

   • A second qualifier based on the first criterion you selected. Using this qualifier, you can find and select all files, excluding those files created on April 27, 1991, for example.

   • A third qualifier based on the second criterion you select. For example, if you select Creation Date, the third criterion is the actual date you set.

   • The disks you want to search. All Disks is the default.

For example, to search for any files created after a particular date, you select the Creation Date option from the first list of criteria, Is After from the second, set the Date in the third, and then select All Disks. Once you click Find, the files meeting these specifications are found and selected.

To Find Again using the same criteria

Select Find Again on the File menu, or press ⌘-G.

When you select the Find Again command, you do not see the search box as you did with the original Find operation. System 7 only searches through disks you define.
System 7 brings striking changes to the Finder, making it more intuitive and easier to use. On the flip side, the new Finder takes twice the memory—almost 310K, as opposed to 150K for the old Finder.

The new Finder enables you to locate a file through its select-by-typing option. You can select a file by using the keyboard.

**To select a folder or a file by typing**

1. Open the window that contains the file or the folder you want to select.

2. Type the name of the folder of the file from the keyboard.

The Finder searches automatically for the entry with the closest match.

**Notes**

There is a catch: you have to enter the keystrokes to search for a file or folder name using an even pattern of keystrokes. For example, if you are looking for the file named Annual Report, and you type the word *Annual* and then pause, the Finder goes to the first file beginning with “annual,” whether “report” follows it or not. If you type the words *Annual Report* and do not pause between the words, the Finder finds and highlights the file you want.

**Folders**

The biggest change in the desktop is the way in which System 7 presents the folders. Each folder that contains files has a small dot to the left of its name when folders are viewed by name (see fig. 7F.2). This dot,
or control object, means that the folder contains files. If there is no dot, the folder is empty. The dot, which is the current shape of the control object, may appear as a triangle with the final release of System 7.

Fig. 7F.2. A icon of a folder containing files.

When you do expand the contents of a folder (somewhat like an outline), the control object appears gray, indicating that the folder is expanded. You still double-click on the original folder or file icon when you want to open a folder, so that the folder contents appear in a separate window. You also use this method to launch an application.

As with earlier systems, folders can contain files and you may place folders within other folders.

To see the contents of a folder in “outline” style
1. Double-click on the folder button or control object. The listing of files and other folders appears.

2. Double-click on the gray folder dot (or triangle).

To create a new folder
From the File menu, select New Folder.

The system creates a folder named Untitled Folder. The initial label is framed by a white line. If you create another folder, the system names it Untitled Folder #2, unless you rename the first new folder.

To rename a folder
1. Click once on the folder name. The highlighted name is framed by a white line.

2. Enter the new name for the folder.
To restore the original name of the folder

1. Press **Backspace** until you delete all of the characters.

2. Press **Return** or **Enter**.

---

Font/DA Mover

Don’t look for this once-invaluable utility; it’s not in System 7. Instead, you install fonts, desk accessories, and sound directly into the Apple menu in the System folder.

To install a desk accessory, drag the desk accessory to the Apple Menu Folder located in the System Folder.

To install a font, drag the font suitcase into the System Folder.

To install a sound, drag the sound file into the System Folder.

To hear a sound or see a font that you installed in System 7, double-click on the font or sound icon.

---

Fonts

Outline fonts technology, part of System 7, enables you to generate sharp text of any size on any Mac monitor and all printers.

See also **Font/DA Mover** and **TrueType**.
You know how important help is when working with any application, and the wizards at Apple are including what they call Balloon Help for System 7 (see fig. 7H.1). Help is available whenever you need it.

To get Help on any System 7 feature

1. From the Apple menu, select Show Balloons.

2. Move the mouse pointer to any part of the desktop. A balloon provides you with a short but helpful statement about that feature.

You also can get help on any menu item by selecting that menu item after you activate Show Balloons.

Notes

Balloons continue to appear about one second after you stop moving the mouse pointer. Keep moving your mouse if you don't want help to appear, or you can select Hide Balloons (see fig. 7H.2).
InterApplication Communications (IAC) is a new data exchange format that provides links between applications and links between files. After you update a worksheet created using Excel, for example, the table based on those numbers that you imported into a Microsoft Word document changes to reflect the new data.

IAC is not a System 7 feature that you need to interact with, because the benefits you reap are the result of redesign by application developers. Get set to deal with live links here: active fields placed into other files and those fields easily accessed for changes.

Installation

Ignoring System 7 until all the bugs are worked out and until all the software that you want is available and compatible may be the best way to avoid the frustration that comes with any new software. Don’t forget: the System is the brains of your machine. Once it gets a headache, you get a migraine.

If you install System 7 on a floppy system, certain features, such as virtual memory, are unavailable.
Your best bet is to install System 7 on your hard drive and have System 6 (or the other system you were working from) available on a floppy. This setup enables you to take advantage of what System 7 has to offer, yet still use applications that won't work with System 7.

If you have two hard drives, you can install System 6 on one hard drive and System 7 on the other. Then keep all the applications that work with System 7 on one drive and applications that don't work with System 7 on the other drive. Hard drive prices are dropping; you can get a 20M hard drive for less than $300.

**To install System 7**

1. Back up all your hard disk files.

2. Reformat—don't erase—your hard disk. To reformat, use the software that came with your hard disk. Be careful: reformatting erases everything on the disk. You can try installing the software without reformatting, but there may be hidden file spooks waiting to sabotage System 7.

3. Install System 7 by following the directions that come with the System software.

4. Drag the DAs, INITs, and CDEVs that you want on your system into the System Folder. These files may cause conflicts, so you might want to test each one as you add it.

5. Create folders for the applications you want to use, and copy the programs to your hard disk.

6. Back up your hard disk by using a commercial product (such as FastBack by Fifth Generation Software) or by copying files onto a floppy disk or another hard disk.
Labels

System 7 enables you to create and attach labels to files for identification and organizational purposes.

To attach a label to a file

1. From the Apple menu, select Control Panels.

2. Double-click on Labels.

3. Type the names of the labels you want to use as in Figure 7L.1.

4. Select the file to which you want to attach a label.

5. Select the label from the Label menu. To see the labels, you must select the Label box on the Views control panel (see fig. 7L.2).

![Fig. 7L.1. Creating a label.](image)

<table>
<thead>
<tr>
<th>figures</th>
<th>Name</th>
<th>Label</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>MacPaint</td>
<td>Vivacious</td>
</tr>
<tr>
<td></td>
<td>alias</td>
<td>Optimal</td>
</tr>
<tr>
<td></td>
<td>apple menu icons</td>
<td>Hip</td>
</tr>
<tr>
<td></td>
<td>dt contents</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>find creation</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>hide balloon</td>
<td>Hip</td>
</tr>
</tbody>
</table>

![Fig. 7L.2. Viewing files with labels.](image)
Layout Manager

Layout Manager, part of Apple's new font technology, provides automatic support for kerning and creating ligatures (such as æ and œ).

See also Fonts and TrueType.

MultiFinder

MultiFinder, Apple's "multi-tasking" software introduced with System 6, is standard with System 7. When you boot up, you see the MultiFinder icon in the upper right corner of the screen and a listing under that icon of all active applications.

You cannot disable MultiFinder under System 7. The basic 2M of RAM needed for System 7 provides enough memory for you to start with MultiFinder. The 2M of RAM is not, however, enough to run more than one of the larger applications within MultiFinder.

MultiFinder has one new feature under System 7. When you have several applications active, you can select the Show command to view only the application, or select the Hide command to view the application's windows. For example, if you select Show MacPaint Only from the MultiFinder menu, then the MacPaint icon will appear as the MultiFinder icon. If you select Hide MacPaint Windows, MacPaint remains an open application, but all the MacPaint windows close. These new features help you manage a crowded desktop.
Opening Files

As with earlier systems, the dialog box that appears when you select Open permits you to open a file and navigate to other folders. The System 7 Open dialog box has two new parts (see in figure 70.1). First, there is a button labeled Desktop. When you click this button, you return to the desktop, where you can see the contents of the desktop inside the dialog box.

The second feature is a small black triangle above the file list box that points toward the bottom of the screen. Point to the triangle and press and hold the mouse button. The triangle reveals the contents of the desktop and all mounted drives. Releasing the button restores the original name above the list box.

QuickDraw

QuickDraw is software built-in to the Mac’s ROM that enables you to construct various typefaces and graphic images. System 7 contains a more powerful QuickDraw—one that enables you to produce high-quality type, similar to the quality output produced by Post-
Script machines. How can System 7 achieve this quality? Like PostScript, QuickDraw uses a mathematical formula. Unlike PostScript, the formula is based on "quadratic spline curves," instead of Bezier curves. Along with the Layout Manager, which provides control over many different aspects of typography (such as kerning and spacing), the new QuickDraw program provides high-quality output from any printer you use.

---

**San Jose**

Have you wondered why the Special menu on the screenshots in this section appears as "SanJose?" The developers of the pre-release versions of System 7 want to commemorate their May, 1989 meeting in San Jose, where the developers released the System 7 standards.

---

**Screen Dumps**

With System 6, you capture the contents of the screen as a Paint file by pressing `Shift-3C-3`. This procedure produced a Paint file labeled "Screen0." When you use the `Shift-3C-3` key combination with System 7, your Mac produces a TeachText file labeled "Picture."

TeachText is a general utility developed by Apple Computer that saves text and graphic files in a format that many different applications can read. By creating a TeachText file, rather than a Paint file, you have more flexibility regarding the type of application you can use to modify captured screens.
You can create as many TeachText files as you want (at least up to 999—after that, my fingers got tired). No more starting over after 10 screen captures!

Select

Select is a new menu item that enables you to select files based on a criterion. For example, you may want to select all files larger than 20K. System 7 enables you to specify the criterion, and then your computer performs the searching and selecting work for you.

System Folder

The System Folder contains the familiar System and Finder files, but has the capability to sort new folder additions and place items where they belong. For example, if you place an INIT in the System Folder, the System automatically moves the INIT to the Extensions Folder.

See also Desk Accessories and Font/DA Mover.

TrueType

TrueType is Apple's new outline font technology that provides you with more flexibility and cleaner type—both on the screen and on paper. TrueType improves the relationship between what you see on your Macintosh screen and your final output.

TrueType offers font options similar to the current standard: Adobe PostScript fonts. The two font options, however, use different technologies. You need
a conversion program to use an Adobe font with Apple's new font technology. The new technology uses "quadratic line curves," which are computed quickly and easily. PostScript uses Bezier (pronounced "bez'-ee-ay") curves. Bezier curves must be converted before you can use a font developed by one company on the other company's technology. With TrueType, the Font Manager computes these equations.

TrueType attaches an instruction set to each font. This instruction set provides what Apple calls "hints." Hints help maximize the screen or printer output. Hints maximize output according to the high-quality model dictated by the equation defining the character's shape. There is a down side to this new technology: it is unclear whether current applications will operate under the new font technology without requiring a software rewrite. The need won't be clear until the applications are tested with the final release of System 7.

Views is a Control Panel Device that enables you to control the appearance of information the desktop displays. If you are tired of the typeface Geneva, rejoice! You really can spruce up your desktop.

The example in Figure 7V.1 uses 14-point Times Roman, which provides large, easy-to-read letters. The new Control Panel view options are a real boon to the visually impaired.

The options that you select appear on the View menu, from which you can select any or all to organize how your files are arranged. For example, unless you select view-by-date, you will not be able to organize your files by date on the desktop.
To change the font or the size of text on the desktop

1. From the Apple menu, select Control Panels.
2. Double-click on Views.
3. Select the font name and size that you want to use.

To change the way icons are staggered

1. From the Apple menu, select Control Panels.
2. Double-click on Views.
3. Select Normal grid if you do not want the icons staggered, or Staggered grid if you do. The staggered option avoids overlap when names of files and folders are too close together.

To change the view of lists

1. From the Apple menu, select Control Panels.
2. Double click on Views.
3. Check off the box (as many as you want) in the List Views box to show the following:
Virtual Memory

Virtual memory is a System 7 feature that permits certain Macintosh computers to use more RAM than is physically available. Virtual memory takes advantage of available space on the hard disk and transfers ("pages") often-needed information from the hard disk to the computer, rather than from RAM.

You easily can modify your Mac II to use virtual memory by installing a Paged Memory Management Unit (or PMMU) for about $190. Adjustments to the actual use of virtual memory are made through the memory control panel device that allows you to turn virtual memory on and off and make other memory settings including the cache setting. Therefore, even if you buy hardware modifications, you need to have virtual memory (the PMMU chip).

Virtual memory makes System 7 improvements come alive. First, you can simply do more. More applications can operate simultaneously and you can process more information within those applications. But what does it mean in terms of actual RAM needed and used? First, because your hard disk picks up some of
the load, you need less RAM for equivalent operations using just physical memory. For example, you might have up to 14M of RAM available (much of it virtual) on a standard system! That’s quite a bit of RAM at no increase in cost. You have to make sure that you have a hard disk that can handle the flow of information and the other data tasks that your machine demands.

You do not have to have System 7 in order to utilize virtual memory. You can use “Virtual” from Con­nectix.
QUICK KEY GUIDE

There’s more to your keyboard than meets the eye.

By using simple key combinations, you can create characters and perform certain functions quickly.

Every Mac comes with fonts. Each font contains special characters. The first section of the Quick Key Guide shows you how to create hundreds of specialized characters. These characters are not specific to a particular application; you can use these characters within any Macintosh program.

The second section of this guide shows you how to perform routine and specialized functions from the keyboard in your favorite applications.

To help you distinguish between the letter “O” and a zero, a zero is represented as “Ø.”
Creating Special Characters

You can use the following key combinations to insert specialized characters into your Mac documents. You create the characters by using standard fonts, common to all Mac systems.

A dash (-) between keystrokes means you press those keys simultaneously. A comma means that you should press the first set of keys simultaneously, release those keys, and then press the next set of keys simultaneously.

Your Mac stores a listing of special characters. This listing is available whenever you use your Mac. To see these characters, select the Key Caps desk accessory from the Apple menu.

Unless otherwise indicated, you can create these characters using standard fonts, such as Times, Helvetica, Geneva, Courier, etc. Certain characters, however, are only available in a particular font. If you need to change the font to Chicago, Symbol, or Zapf Dingbats in order to create a character, you see the font name below the key combination. Some characters are enlarged to show detail.

See also Fonts, Font/DA Mover, Highlighting Text, and Mouse in the “MACINTOSH TOPICS” section of this book.
<table>
<thead>
<tr>
<th>Description</th>
<th>Symbol</th>
<th>Key(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>AE ligature</td>
<td>Æ</td>
<td>Shift-Option-'</td>
</tr>
<tr>
<td></td>
<td>æ</td>
<td>Option-'</td>
</tr>
<tr>
<td>Aleph</td>
<td>Α</td>
<td>Shift-Option/-</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td>Alpha</td>
<td>A</td>
<td>Shift-A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td></td>
<td>α</td>
<td>A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td>Angle</td>
<td>&lt;</td>
<td>Option--</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td>Apostrophe</td>
<td>,</td>
<td>Shift-Option-]</td>
</tr>
<tr>
<td>Apple</td>
<td>♠</td>
<td>Shift-Option-K</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Chicago</td>
</tr>
<tr>
<td>Approximately</td>
<td>≈</td>
<td>Option-X</td>
</tr>
<tr>
<td>Arrow</td>
<td>⇔</td>
<td>Shift-Option-2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Shift-Option-6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Shift-Option-3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Shift-Option-4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Shift-Option-7</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Shift-Option-1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Shift-Option-S</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Shift-Option-D</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Shift-Option-F</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbat</td>
</tr>
<tr>
<td>Description</td>
<td>Symbol</td>
<td>Key(s)</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Arrow (cont.)</td>
<td>➕</td>
<td>Shift-Option-G, Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>➖</td>
<td>Shift-Option-H, Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>➗</td>
<td>Shift-Option-J, Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>➘</td>
<td>Shift-Option-L, Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>⊄</td>
<td>Shift-Option-:, Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>←</td>
<td>Option-E, Space bar</td>
</tr>
<tr>
<td></td>
<td>→</td>
<td>Option-’</td>
</tr>
<tr>
<td></td>
<td>↓</td>
<td>Option-Z, Symbol</td>
</tr>
<tr>
<td></td>
<td>⇆</td>
<td>Option-U, Space bar</td>
</tr>
<tr>
<td></td>
<td>↑</td>
<td>Option-=, Symbol</td>
</tr>
<tr>
<td></td>
<td>→</td>
<td>Option-], Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>→</td>
<td>Shift-Option-], Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>→</td>
<td>Shift-Option-, Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>←</td>
<td>Option-/-, Zapf Dingbats</td>
</tr>
<tr>
<td>Description</td>
<td>Symbol</td>
<td>Key(s)</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Arrow (cont.)</td>
<td>▲▼</td>
<td><strong>Shift-Option-V</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>▶◀</td>
<td><strong>Shift-Option-~</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>▶</td>
<td><strong>Option-U, Y</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>▶</td>
<td><strong>Shift-Option-1</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>▶</td>
<td><strong>Shift-Option-2</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>▶</td>
<td><strong>Shift-Option-3</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>▶</td>
<td><strong>Shift-Option-Y</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>▶</td>
<td><strong>Shift-Option-9</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>▶</td>
<td><strong>Shift-Option-4</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>▶</td>
<td><strong>Shift-Option-5</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>▶</td>
<td><strong>Shift-Option-Z</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>▶</td>
<td><strong>Shift-Option-B</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>▶</td>
<td><strong>Shift-Option-X</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>▶</td>
<td><strong>Shift-Option-N</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>▶</td>
<td><strong>Shift-Option-,</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>▶</td>
<td><strong>Shift-Option-M</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>▶</td>
<td><strong>Option-H</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td>Description</td>
<td>Symbol</td>
<td>Key(s)</td>
</tr>
<tr>
<td>------------------</td>
<td>--------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>Arrow (cont.)</td>
<td>⬇️</td>
<td><strong>Shift-Option-.</strong> Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>⬆️</td>
<td><strong>Option-K</strong> Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>⬅️</td>
<td><strong>Shift-Option-E</strong> Zapf Dingbats</td>
</tr>
<tr>
<td>Arrowhead</td>
<td>⬅️</td>
<td><strong>Shift-Option-Ø</strong> Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>⬅️</td>
<td><strong>Shift-Option-W</strong> Zapf Dingbats</td>
</tr>
<tr>
<td>Asterisk</td>
<td>*</td>
<td><strong>Shift-Q</strong> Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>*</td>
<td><strong>Shift-R</strong> Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>⋋</td>
<td><strong>Shift-S</strong> Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>⋋</td>
<td><strong>Shift-Z</strong> Zapf Dingbats</td>
</tr>
<tr>
<td>Bar</td>
<td>⬟</td>
<td><strong>Z</strong> Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>⬟</td>
<td><strong>Y</strong> Zapf Dingbats</td>
</tr>
<tr>
<td>Beta</td>
<td>B</td>
<td><strong>Shift-B</strong> Symbol</td>
</tr>
<tr>
<td></td>
<td>β</td>
<td><strong>B</strong> Symbol</td>
</tr>
<tr>
<td>Box</td>
<td>□</td>
<td><strong>N</strong> Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>□</td>
<td><strong>N</strong> (outline) Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>□</td>
<td><strong>O</strong> Zapf Dingbats</td>
</tr>
<tr>
<td>Description</td>
<td>Symbol</td>
<td>Key(s)</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>Box (cont.)</td>
<td>[ ]</td>
<td>P</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>[ ]</td>
<td>Q</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>[ ]</td>
<td>R</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>◆</td>
<td>U</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>◆</td>
<td>V</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td>Brace</td>
<td>[ ]</td>
<td>Shift-Option-J</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td>Breve</td>
<td>·</td>
<td>Shift-Option-.</td>
</tr>
<tr>
<td>Bullet</td>
<td>•</td>
<td>Option-8</td>
</tr>
<tr>
<td>Cedilla</td>
<td>ζ</td>
<td>Option-C</td>
</tr>
<tr>
<td>Caret</td>
<td>^</td>
<td>Option-I, Space bar</td>
</tr>
<tr>
<td>Carriage return</td>
<td>←</td>
<td>Option-O</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td>Check mark</td>
<td>✓</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>✓</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td>Chi</td>
<td>X</td>
<td>Shift-C</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td></td>
<td>χ</td>
<td>C</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td>Circle</td>
<td>8</td>
<td>Shift-Option-′</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>Option-Z</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>Option-\</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td>Description</td>
<td>Symbol</td>
<td>Key(s)</td>
</tr>
<tr>
<td>-----------------</td>
<td>--------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td>Circle (cont.)</td>
<td>8</td>
<td>Option-.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>●</td>
<td>L</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>○</td>
<td>M</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td>Club</td>
<td>⌂</td>
<td>Option-S</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td></td>
<td>⌂</td>
<td>Option-R</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td>Cluster</td>
<td>⋆</td>
<td>G</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>⋆</td>
<td>H</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td>Congruent</td>
<td>≅</td>
<td>Shift-2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td>Copyright</td>
<td>©</td>
<td>Option-G</td>
</tr>
<tr>
<td></td>
<td>©</td>
<td>Shift-Option-W</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td></td>
<td>©</td>
<td>Shift-Option-[</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td>Cross Botonée</td>
<td>⊠</td>
<td>Shift-E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td>Cross Formée</td>
<td>⊤</td>
<td>Shift-2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td>Cross</td>
<td>⊕</td>
<td>Shift-;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>+</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>⌂</td>
<td>Shift-</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>+</td>
<td>;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td>Description</td>
<td>Symbol</td>
<td>Key(s)</td>
</tr>
<tr>
<td>--------------</td>
<td>--------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Crux</td>
<td>†</td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>†</td>
<td>Option-/</td>
</tr>
<tr>
<td></td>
<td>†</td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>†</td>
<td>Shift-.</td>
</tr>
<tr>
<td></td>
<td>†</td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td>Dagger</td>
<td>‡</td>
<td>Shift-Option-7</td>
</tr>
<tr>
<td></td>
<td>†</td>
<td>Option-T</td>
</tr>
<tr>
<td>Degree</td>
<td>°</td>
<td>Shift-Option-8</td>
</tr>
<tr>
<td>Delta</td>
<td>Δ</td>
<td>Option-J</td>
</tr>
<tr>
<td></td>
<td>Δ</td>
<td>Shift-D</td>
</tr>
<tr>
<td></td>
<td>δ</td>
<td>D</td>
</tr>
<tr>
<td></td>
<td>δ</td>
<td>Symbol</td>
</tr>
<tr>
<td>Diaeresis</td>
<td>..</td>
<td>Option-U, space bar</td>
</tr>
<tr>
<td>Diamond</td>
<td>◆</td>
<td>Option-R</td>
</tr>
<tr>
<td></td>
<td>◆</td>
<td>Symbol</td>
</tr>
<tr>
<td></td>
<td>◆</td>
<td>Option-G</td>
</tr>
<tr>
<td></td>
<td>◆</td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td>Diesis</td>
<td>‡</td>
<td>Shift-Option-7</td>
</tr>
<tr>
<td>Divide</td>
<td>÷</td>
<td>Option-/</td>
</tr>
<tr>
<td>Dot accent</td>
<td>.</td>
<td>Option-H</td>
</tr>
<tr>
<td>Element</td>
<td>∈</td>
<td>Shift-Option-Q</td>
</tr>
<tr>
<td></td>
<td>∈</td>
<td>Symbol</td>
</tr>
<tr>
<td>Ellipsis</td>
<td>...</td>
<td>Option-;</td>
</tr>
<tr>
<td>Em dash</td>
<td>—</td>
<td>Shift-Option--</td>
</tr>
<tr>
<td>Empty Set</td>
<td>Ø</td>
<td>Option-J</td>
</tr>
<tr>
<td></td>
<td>Ø</td>
<td>Symbol</td>
</tr>
<tr>
<td>En dash</td>
<td>-</td>
<td>Option--</td>
</tr>
<tr>
<td>Epsilon</td>
<td>E</td>
<td>Shift-E</td>
</tr>
<tr>
<td></td>
<td>E</td>
<td>Symbol</td>
</tr>
<tr>
<td>Description</td>
<td>Symbol</td>
<td>Key(s)</td>
</tr>
<tr>
<td>------------------------------</td>
<td>--------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>Epsilon (cont.)</td>
<td>ε</td>
<td>E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td>Eta</td>
<td>H</td>
<td>Shift-H</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td>η</td>
<td>H</td>
<td>Symbol</td>
</tr>
<tr>
<td>Exclamation point</td>
<td>•</td>
<td>Option-1</td>
</tr>
<tr>
<td>Exclamation heart</td>
<td>•</td>
<td>Option-3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td>Exclamation point</td>
<td>•</td>
<td>Option-4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td>i</td>
<td></td>
<td>Option-1</td>
</tr>
<tr>
<td>Existential</td>
<td>Ω</td>
<td>Shift-4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td>Feet</td>
<td>′</td>
<td>Option-4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td>fi ligature</td>
<td>fi</td>
<td>Shift-Option-5</td>
</tr>
<tr>
<td>fl ligature</td>
<td>fl</td>
<td>Shift-Option-6</td>
</tr>
<tr>
<td>Florin</td>
<td>f</td>
<td>Option-F</td>
</tr>
<tr>
<td>Flower</td>
<td>ꕔ</td>
<td>Shift-</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td>Flower</td>
<td>ꕔ</td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td>Flower</td>
<td>ꕔ</td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td>Gamma</td>
<td>Γ</td>
<td>Shift-G</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td></td>
<td>γ</td>
<td>G</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td>German double S</td>
<td>☸</td>
<td>Option-S</td>
</tr>
<tr>
<td>Gradient</td>
<td>▽</td>
<td>Shift-Option-</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td>Greater than or equal to</td>
<td>≥</td>
<td>Option-</td>
</tr>
<tr>
<td>Description</td>
<td>Symbol</td>
<td>Key(s)</td>
</tr>
<tr>
<td>-------------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>Guillemot</td>
<td>«</td>
<td>Option-\</td>
</tr>
<tr>
<td></td>
<td>»</td>
<td>Shift-Option-\</td>
</tr>
<tr>
<td></td>
<td>&lt;</td>
<td>Shift-Option-3</td>
</tr>
<tr>
<td></td>
<td>&gt;</td>
<td>Shift-Option-4</td>
</tr>
<tr>
<td>Heart</td>
<td>♥</td>
<td>Option-G</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td></td>
<td>♥</td>
<td>Option-2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>♥</td>
<td>Option-6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>♥</td>
<td>Option-8</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td>Inches</td>
<td>&quot;</td>
<td>Option-,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td>Index</td>
<td>⊕</td>
<td>Shift-8</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>⊕</td>
<td>Shift-=</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td>Infinity</td>
<td>∞</td>
<td>Option-5</td>
</tr>
<tr>
<td>Intersection</td>
<td>⊙</td>
<td>Option-\</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td>Iota</td>
<td>I</td>
<td>Shift-1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td></td>
<td>I</td>
<td>I</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td>Jet</td>
<td>⊠</td>
<td>Shift-9</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td>Kappa</td>
<td>K</td>
<td>Shift-K</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td></td>
<td>k</td>
<td>K</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td>Description</td>
<td>Symbol</td>
<td>Key(s)</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>Lambda</td>
<td>Λ</td>
<td>Shift-L Symbol</td>
</tr>
<tr>
<td></td>
<td>λ</td>
<td>L Symbol</td>
</tr>
<tr>
<td>Leaf</td>
<td>☺</td>
<td>Option-7 Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>☻</td>
<td>Option-S Zapf Dingbats</td>
</tr>
<tr>
<td>Less than</td>
<td>&lt;</td>
<td>Shift-,</td>
</tr>
<tr>
<td>Less than or equal to</td>
<td>≤</td>
<td>Option-,</td>
</tr>
<tr>
<td>Line break</td>
<td>↓</td>
<td>Option-O Symbol</td>
</tr>
<tr>
<td>Logical and</td>
<td>∧</td>
<td>Shift-Option-~ Symbol</td>
</tr>
<tr>
<td>Logical not</td>
<td>¬</td>
<td>Option-L</td>
</tr>
<tr>
<td>Logical or</td>
<td>∨</td>
<td>Shift-Option-1 Symbol</td>
</tr>
<tr>
<td>Lozenge</td>
<td>⊙</td>
<td>Shift-Option-V</td>
</tr>
<tr>
<td>Macron</td>
<td>-</td>
<td>Shift-Option- ,</td>
</tr>
<tr>
<td>Minutes</td>
<td>′</td>
<td>Option-4 Symbol</td>
</tr>
<tr>
<td>Mu</td>
<td>µ</td>
<td>Option-M</td>
</tr>
<tr>
<td>Multiply</td>
<td>⊗</td>
<td>Option-F Symbol</td>
</tr>
<tr>
<td></td>
<td>.</td>
<td>Shift-Option-9</td>
</tr>
<tr>
<td></td>
<td>×</td>
<td>Option-Y Symbol</td>
</tr>
<tr>
<td>N with tilde</td>
<td>ñ</td>
<td>Option-N, N</td>
</tr>
<tr>
<td>Not an element</td>
<td>∈</td>
<td>Option-Q Symbol</td>
</tr>
<tr>
<td>Not equal</td>
<td>≠</td>
<td>Option-=</td>
</tr>
<tr>
<td>Description</td>
<td>Symbol</td>
<td>Key(s)</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>Not subset</td>
<td>(\aleph)</td>
<td>Option-~ or <strong>Shift-A</strong> Symbol</td>
</tr>
<tr>
<td>Nu</td>
<td>(N)</td>
<td><strong>Shift-N</strong> Symbol</td>
</tr>
<tr>
<td></td>
<td>(\nabla)</td>
<td>(\nabla) Symbol</td>
</tr>
<tr>
<td>O slash</td>
<td>(\emptyset)</td>
<td><strong>Shift-Option-\emptyset</strong></td>
</tr>
<tr>
<td>Obelisk</td>
<td>(\dag)</td>
<td><strong>Option-\dag</strong></td>
</tr>
<tr>
<td>OE ligature</td>
<td>(\OE)</td>
<td><strong>Shift-Option-\OE</strong></td>
</tr>
<tr>
<td></td>
<td>(\textasciicircum)</td>
<td><strong>Option-\textasciicircum</strong></td>
</tr>
<tr>
<td>Omega</td>
<td>(\Omega)</td>
<td><strong>Shift-W</strong> Symbol</td>
</tr>
<tr>
<td></td>
<td>(\omega)</td>
<td>(\omega) Symbol</td>
</tr>
<tr>
<td></td>
<td>(\omicron)</td>
<td>(\omicron) Symbol</td>
</tr>
<tr>
<td>Ord, feminine</td>
<td>(a)</td>
<td><strong>Option-9</strong></td>
</tr>
<tr>
<td>Ord, masculine</td>
<td>(o)</td>
<td><strong>Option-0</strong></td>
</tr>
<tr>
<td>Paragraph</td>
<td>(\¶)</td>
<td><strong>Option-7</strong></td>
</tr>
<tr>
<td></td>
<td>(\partial)</td>
<td><strong>Shift-Option-\partial</strong> Zapf Dingbats</td>
</tr>
<tr>
<td>Partial differential</td>
<td>(\partial)</td>
<td><strong>Option-\partial</strong> Zapf Dingbats</td>
</tr>
<tr>
<td>Peace</td>
<td>($$)</td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td>Description</td>
<td>Symbol</td>
<td>Key(s)</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>Pen nib</td>
<td>![Pen nib symbol] 2 Zapf Dingbats</td>
<td></td>
</tr>
<tr>
<td></td>
<td>![Pen nib symbol] 1 Zapf Dingbats</td>
<td></td>
</tr>
<tr>
<td>Pencil</td>
<td>![Pencil symbol] . Zapf Dingbats</td>
<td></td>
</tr>
<tr>
<td></td>
<td>![Pencil symbol] / Zapf Dingbats</td>
<td></td>
</tr>
<tr>
<td></td>
<td>![Pencil symbol] Ø Zapf Dingbats</td>
<td></td>
</tr>
<tr>
<td>Perpendicular</td>
<td>![Perpendicular symbol]</td>
<td>Option-I, Space bar Symbol</td>
</tr>
<tr>
<td>Per thousand</td>
<td>%0</td>
<td>Shift-Option-E</td>
</tr>
<tr>
<td>Petal cross</td>
<td>![Petal cross symbol]</td>
<td>Shift-C Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>![Petal cross symbol]</td>
<td>Shift-D Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>![Petal cross symbol]</td>
<td>Shift-B Zapf Dingbats</td>
</tr>
<tr>
<td>Phi</td>
<td>⌀</td>
<td>Shift-F Symbol</td>
</tr>
<tr>
<td></td>
<td>⌀</td>
<td>F Symbol</td>
</tr>
<tr>
<td></td>
<td>⌀</td>
<td>J Symbol</td>
</tr>
<tr>
<td>Pi</td>
<td>π</td>
<td>Shift-P Symbol</td>
</tr>
<tr>
<td></td>
<td>π</td>
<td>P Symbol</td>
</tr>
<tr>
<td>Plus or minus</td>
<td>±</td>
<td>Shift-Option-=</td>
</tr>
<tr>
<td>Plus</td>
<td>⊕</td>
<td>Option-X Symbol</td>
</tr>
<tr>
<td>Pound sterling</td>
<td>¥</td>
<td>Option-3</td>
</tr>
<tr>
<td>Description</td>
<td>Symbol</td>
<td>Key(s)</td>
</tr>
<tr>
<td>------------------------------</td>
<td>--------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>Product</td>
<td>Π</td>
<td>Shift-Option-P</td>
</tr>
<tr>
<td>Proper subset</td>
<td>⊂</td>
<td>Option-N, Shift-A Symbol</td>
</tr>
<tr>
<td>Proper superset</td>
<td>⊃</td>
<td>Option-; Symbol</td>
</tr>
<tr>
<td>Proportional</td>
<td>∞</td>
<td>Option-M Symbol</td>
</tr>
<tr>
<td>Psi</td>
<td>ψ</td>
<td>Shift-Y Symbol</td>
</tr>
<tr>
<td>Question mark, inverted</td>
<td>¤</td>
<td>Shift-Option-/</td>
</tr>
<tr>
<td>Quotation mark, baseline</td>
<td>&quot;</td>
<td>Shift-Option-W</td>
</tr>
<tr>
<td>Quotation mark, closed</td>
<td>&quot;</td>
<td>Shift-Option-[</td>
</tr>
<tr>
<td>Quotation mark, open</td>
<td>&quot;</td>
<td>Shift-～ Zapf Dingbats</td>
</tr>
<tr>
<td>Quotation, single, baseline</td>
<td>,</td>
<td>Shift-Option-Ø</td>
</tr>
<tr>
<td>Quotation, single, closed</td>
<td>'</td>
<td>Shift-Option-]</td>
</tr>
<tr>
<td>Quotation, single, open</td>
<td>'</td>
<td>Shift-\ Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>'</td>
<td>Option-]</td>
</tr>
<tr>
<td></td>
<td>'</td>
<td>Shift-[ Zapf Dingbats</td>
</tr>
<tr>
<td>Description</td>
<td>Symbol</td>
<td>Key(s)</td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>R fraktur</td>
<td>R</td>
<td>Option-1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td>Radical extension</td>
<td>~</td>
<td>~</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td>Radical initiate</td>
<td>√</td>
<td>Option-V</td>
</tr>
<tr>
<td>Receiver</td>
<td>🔴</td>
<td>Shift-7</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td>Reflexive subset</td>
<td>⊆</td>
<td>Option-N, Shift-O</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td>Reflexive superset</td>
<td>⊇</td>
<td>Option-Space bar</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td>Registered trademark</td>
<td>®</td>
<td>Option-R</td>
</tr>
<tr>
<td></td>
<td>®</td>
<td>Shift-Option-Ø</td>
</tr>
<tr>
<td></td>
<td>®</td>
<td>Option-[</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td>Rho</td>
<td>P</td>
<td>Shift-R</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td></td>
<td>ρ</td>
<td>R</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td>Ring diacritic</td>
<td>◯</td>
<td>Option-K</td>
</tr>
<tr>
<td>Scissors</td>
<td>🔺</td>
<td>Shift-1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>🔺</td>
<td>Shift-3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>🔺</td>
<td>Shift-4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td>Seconds</td>
<td>&quot;</td>
<td>Option-,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td>Section</td>
<td>§</td>
<td>Option-6</td>
</tr>
<tr>
<td>Semicircle</td>
<td>△</td>
<td>W</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td>Description</td>
<td>Symbol</td>
<td>Key(s)</td>
</tr>
<tr>
<td>-----------------</td>
<td>--------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>Sigma</td>
<td>Σ</td>
<td><strong>Shift-S</strong> Symbol</td>
</tr>
<tr>
<td></td>
<td>σ</td>
<td><strong>S</strong> Symbol</td>
</tr>
<tr>
<td></td>
<td>ζ</td>
<td><strong>Shift-V</strong> Symbol</td>
</tr>
<tr>
<td>Snowflake</td>
<td>*</td>
<td><strong>D</strong> Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>E</strong> Zapf Dingbats</td>
</tr>
<tr>
<td>Spade</td>
<td>♠</td>
<td><strong>Option-2</strong> Symbol</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Option-E, Space bar</strong> Zapf Dingbats</td>
</tr>
<tr>
<td>Star cross</td>
<td>✷</td>
<td><strong>Shift-F</strong> Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>✷</td>
<td><strong>Shift-G</strong> Zapf Dingbats</td>
</tr>
<tr>
<td>Star of David</td>
<td>⭐</td>
<td><strong>Shift-A</strong> Zapf Dingbats</td>
</tr>
<tr>
<td>Star</td>
<td>⭐</td>
<td><strong>Shift-J</strong> Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>⭐</td>
<td><strong>Shift-H</strong> Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>⭐</td>
<td><strong>Shift-L</strong> Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>⭐</td>
<td><strong>Shift-N</strong> Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>⭐</td>
<td><strong>Shift-M</strong> Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>⭐</td>
<td><strong>Shift-O</strong> Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>⭐</td>
<td><strong>Shift-P</strong> Zapf Dingbats</td>
</tr>
<tr>
<td>Description</td>
<td>Symbol</td>
<td>Key(s)</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------</td>
<td>------------------------------------</td>
</tr>
<tr>
<td>Star (cont.)</td>
<td>⭐</td>
<td>Shift-K, Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>⭐</td>
<td>Shift-I, Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>⭐</td>
<td>] Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>⭐</td>
<td>[ Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>⭐</td>
<td>C Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>⭐</td>
<td>Option-I, Space bar, Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>⭐</td>
<td>\ Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>⭐</td>
<td>Shift-V, Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>⭐</td>
<td>K Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>⭐</td>
<td>J Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>⭐</td>
<td>Shift-X, Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>⭐</td>
<td>Shift-U, Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>⭐</td>
<td>Shift-T, Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>⭐</td>
<td>Shift-W, Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>⭐</td>
<td>Shift-Y, Zapf Dingbats</td>
</tr>
<tr>
<td>Summation</td>
<td>Σ</td>
<td>Option-W, Zapf Dingbats</td>
</tr>
<tr>
<td>Sun</td>
<td>☀</td>
<td>B, Zapf Dingbats</td>
</tr>
<tr>
<td>Description</td>
<td>Symbol</td>
<td>Key(s)</td>
</tr>
<tr>
<td>-----------------</td>
<td>--------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>Tau</td>
<td>T</td>
<td>Shift-T, Symbol</td>
</tr>
<tr>
<td></td>
<td>\tau</td>
<td>T, Symbol</td>
</tr>
<tr>
<td>Telephone</td>
<td>☛</td>
<td>Shift-5, Zapf Dingbats</td>
</tr>
<tr>
<td>Therefore</td>
<td>.</td>
<td>, Symbol</td>
</tr>
<tr>
<td>Theta</td>
<td>\Theta</td>
<td>Shift-Q, Symbol</td>
</tr>
<tr>
<td></td>
<td>\theta</td>
<td>Q, Symbol</td>
</tr>
<tr>
<td></td>
<td>\vartheta</td>
<td>Shift-J, Symbol</td>
</tr>
<tr>
<td>Tilde</td>
<td>~</td>
<td>Shift-Option-M</td>
</tr>
<tr>
<td>Trademark</td>
<td>™</td>
<td>Option-2</td>
</tr>
<tr>
<td>Triangle</td>
<td>▼</td>
<td>T, Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>▲</td>
<td>S, Zapf Dingbats</td>
</tr>
<tr>
<td>Umlaut</td>
<td>`</td>
<td>Option-U, Space bar</td>
</tr>
<tr>
<td>Union</td>
<td>\cup</td>
<td>Shift-Option-, Symbol</td>
</tr>
<tr>
<td>Upsilon</td>
<td>\Psi</td>
<td>Shift-Y, Symbol</td>
</tr>
<tr>
<td></td>
<td>\Upsilon</td>
<td>Shift-Option-8, Symbol</td>
</tr>
<tr>
<td></td>
<td>\Psi</td>
<td>Y, Symbol</td>
</tr>
<tr>
<td>Victory</td>
<td>$</td>
<td>, Zapf Dingbats</td>
</tr>
<tr>
<td>Weierstrass</td>
<td>\varnothing</td>
<td>Option-V, Symbol</td>
</tr>
<tr>
<td>Description</td>
<td>Symbol</td>
<td>Key(s)</td>
</tr>
<tr>
<td>--------------</td>
<td>--------</td>
<td>------------------</td>
</tr>
<tr>
<td>Writer's hand</td>
<td>☃️</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td>X mark</td>
<td>✗</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>✗</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>✗</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td></td>
<td>✗</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zapf Dingbats</td>
</tr>
<tr>
<td>Xi</td>
<td>⧫</td>
<td>Shift-X</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td></td>
<td>ξ</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td>Yen</td>
<td>¥</td>
<td>Option-Y</td>
</tr>
<tr>
<td>Zeta</td>
<td>Z</td>
<td>Shift-Z</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
<tr>
<td></td>
<td>ζ</td>
<td>Z</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Symbol</td>
</tr>
</tbody>
</table>
PROGRAM-SPECIFIC QUICK KEYS

Ever find yourself with that certain keystroke combination or command on the tip of your tongue but not quite there? Relax. If you use one of the major applications such as Excel, FileMaker, MacDraw, PageMaker, SuperPaint, or Word, this shortcut guide may be all you need.

Note: The “universal” quick keys are available in each of the preceding applications, unless noted otherwise.

-- Universal Quick Keys --

The following key combinations are available in most applications.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel</td>
<td>•. (period) or Esc</td>
</tr>
<tr>
<td>Close</td>
<td> W</td>
</tr>
<tr>
<td>Copy</td>
<td> C</td>
</tr>
<tr>
<td>Cut</td>
<td> X</td>
</tr>
<tr>
<td>New</td>
<td> N</td>
</tr>
<tr>
<td>Open</td>
<td> O</td>
</tr>
<tr>
<td>Paste</td>
<td> V</td>
</tr>
<tr>
<td>Print</td>
<td> P</td>
</tr>
<tr>
<td>Quit</td>
<td> Q</td>
</tr>
<tr>
<td>Save</td>
<td> S</td>
</tr>
<tr>
<td>Select all</td>
<td> A</td>
</tr>
<tr>
<td>Undo</td>
<td> Z</td>
</tr>
</tbody>
</table>
## Excel Quick Keys

The following key combinations are available when using Microsoft Excel Version 2.2.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate formula bar</td>
<td>⌘ U</td>
</tr>
<tr>
<td>Bold</td>
<td>⌘ B</td>
</tr>
<tr>
<td>Calculate</td>
<td>Shift-F9</td>
</tr>
<tr>
<td>Create names</td>
<td>⌘ '</td>
</tr>
<tr>
<td>Date, current</td>
<td>⌘ -</td>
</tr>
<tr>
<td>Delete selected cells</td>
<td>⌘ K</td>
</tr>
<tr>
<td>Equal to</td>
<td>=</td>
</tr>
<tr>
<td>Extract</td>
<td>⌘ E</td>
</tr>
<tr>
<td>Fill down</td>
<td>⌘ D</td>
</tr>
<tr>
<td>Fill left</td>
<td>⌘ Shift-R</td>
</tr>
<tr>
<td>Fill right</td>
<td>⌘ R</td>
</tr>
<tr>
<td>Fill up</td>
<td>⌘ Shift-D</td>
</tr>
<tr>
<td>Find next</td>
<td>⌘ F</td>
</tr>
<tr>
<td>Find previous record</td>
<td>⌘ Shift-F</td>
</tr>
<tr>
<td>Go to cell or named area</td>
<td>⌘ G or F5</td>
</tr>
<tr>
<td>Help</td>
<td>⌘ / or Help</td>
</tr>
<tr>
<td>Help, context-sensitive</td>
<td>Shift-F1</td>
</tr>
<tr>
<td>Insert</td>
<td>⌘ I</td>
</tr>
<tr>
<td>Maximize window</td>
<td>⌘ F10</td>
</tr>
<tr>
<td>Move window</td>
<td>⌘ F7</td>
</tr>
<tr>
<td>New chart</td>
<td>F11</td>
</tr>
<tr>
<td>New macro sheet</td>
<td>⌘ F11</td>
</tr>
<tr>
<td>Paste special</td>
<td>⌘ Shift-V</td>
</tr>
<tr>
<td>Plain text</td>
<td>Shift-P</td>
</tr>
</tbody>
</table>
### Filemaker Quick Keys

The following key combinations are available when using Filemaker Pro Version 1.0 from Claris.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add record</td>
<td>⌘ A</td>
</tr>
<tr>
<td>Align center</td>
<td>⌘ Shift-C</td>
</tr>
<tr>
<td>Align left</td>
<td>⌘ Shift-L</td>
</tr>
<tr>
<td>Align objects</td>
<td>⌘ K</td>
</tr>
<tr>
<td>Align right</td>
<td>⌘ Shift-R</td>
</tr>
<tr>
<td>Align to grid</td>
<td>⌘ Y</td>
</tr>
<tr>
<td>Alignment</td>
<td>⌘ Shift-K</td>
</tr>
<tr>
<td>Bold</td>
<td>⌘ Shift-B</td>
</tr>
<tr>
<td>Underline</td>
<td>⌘ Shift-U</td>
</tr>
<tr>
<td>Borders, format</td>
<td>⌘ Option-B</td>
</tr>
<tr>
<td>Browse</td>
<td>⌘ B</td>
</tr>
<tr>
<td>Center</td>
<td>⌘ Shift-C</td>
</tr>
<tr>
<td>Create macro</td>
<td>⌘ H</td>
</tr>
<tr>
<td>Date, current</td>
<td>//</td>
</tr>
<tr>
<td>Date, paste current</td>
<td>⌘ - (hyphen)</td>
</tr>
<tr>
<td>Delete</td>
<td>⌘ D</td>
</tr>
<tr>
<td>Action (continued)</td>
<td>Key(s)</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>Delete record</td>
<td>%E</td>
</tr>
<tr>
<td>Define field</td>
<td>%Shift-D</td>
</tr>
<tr>
<td>Duplicate record</td>
<td>%D</td>
</tr>
<tr>
<td>Equal to</td>
<td>=</td>
</tr>
<tr>
<td>Exponential (to the power of...)</td>
<td>^</td>
</tr>
<tr>
<td>Field, format</td>
<td>%Option-F</td>
</tr>
<tr>
<td>Find again</td>
<td>%F</td>
</tr>
<tr>
<td>Find all specified criteria and add them to browsing routine</td>
<td>%J</td>
</tr>
<tr>
<td>Format date</td>
<td>%Shift-D</td>
</tr>
<tr>
<td>Format number</td>
<td>%Shift-N</td>
</tr>
<tr>
<td>Greater than</td>
<td>Shift-.</td>
</tr>
<tr>
<td>Greater than or equal to</td>
<td>Option-.</td>
</tr>
<tr>
<td>Grid</td>
<td>%Y</td>
</tr>
<tr>
<td>Group</td>
<td>%G</td>
</tr>
<tr>
<td>Help</td>
<td>%?</td>
</tr>
<tr>
<td>Italic</td>
<td>%Shift-I</td>
</tr>
<tr>
<td>Layout mode</td>
<td>%L</td>
</tr>
<tr>
<td>Left-justify</td>
<td>%Shift-L</td>
</tr>
<tr>
<td>Less than</td>
<td>Shift-,</td>
</tr>
<tr>
<td>Less than or equal to</td>
<td>Option-,</td>
</tr>
<tr>
<td>Lock</td>
<td>%H</td>
</tr>
<tr>
<td>Multiplication</td>
<td>Shift-8</td>
</tr>
<tr>
<td>Next field</td>
<td>Tab</td>
</tr>
<tr>
<td>Not equal to</td>
<td>Option-=</td>
</tr>
<tr>
<td>Omit multiple records</td>
<td>%Shift-M</td>
</tr>
<tr>
<td>Omit record</td>
<td>%M</td>
</tr>
<tr>
<td>Action (continued)</td>
<td>Key(s)</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>Outline</td>
<td>⌥Shift-O</td>
</tr>
<tr>
<td>Page number</td>
<td>##</td>
</tr>
<tr>
<td>Paste current date</td>
<td>⌥Shift--</td>
</tr>
<tr>
<td>Plain text</td>
<td>⌥Shift-P</td>
</tr>
<tr>
<td>Previous field</td>
<td>Shift-Tab</td>
</tr>
<tr>
<td>Preview</td>
<td>⌥U</td>
</tr>
<tr>
<td>Print (bypass dialog box)</td>
<td>⌥Option-P</td>
</tr>
<tr>
<td>Record number</td>
<td>@@</td>
</tr>
<tr>
<td>Refind</td>
<td>⌥R</td>
</tr>
<tr>
<td>Replace field</td>
<td>⌥=</td>
</tr>
<tr>
<td>Right-justify</td>
<td>⌥Shift-R</td>
</tr>
<tr>
<td>Script most recent actions</td>
<td>⌥H</td>
</tr>
<tr>
<td>Send backward</td>
<td>⌥Shift-J</td>
</tr>
<tr>
<td>Shadow</td>
<td>⌥Shift-S</td>
</tr>
<tr>
<td>Sort</td>
<td>⌥S</td>
</tr>
<tr>
<td>T squares</td>
<td>⌥T</td>
</tr>
<tr>
<td>Time, current</td>
<td>::</td>
</tr>
<tr>
<td>Time, paste current</td>
<td>⌥;</td>
</tr>
<tr>
<td>Underline</td>
<td>⌥Shift-U</td>
</tr>
<tr>
<td>Ungroup</td>
<td>⌥Shift-G</td>
</tr>
<tr>
<td>Unlock</td>
<td>⌥Shift-H</td>
</tr>
<tr>
<td>Zoom</td>
<td>⌥Shift-Z</td>
</tr>
</tbody>
</table>
# MacDraw Quick Keys

The following commands are based on MacDraw II Version 1.1.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Align</td>
<td>⌘ K</td>
</tr>
<tr>
<td>Autogrid</td>
<td>⌘ Y</td>
</tr>
<tr>
<td>Bold text</td>
<td>⌘ B</td>
</tr>
<tr>
<td>Current 100% view</td>
<td>⌘ Shift-M</td>
</tr>
<tr>
<td>Down one layer</td>
<td>⌘ Down arrow</td>
</tr>
<tr>
<td>Fit to window</td>
<td>⌘ M</td>
</tr>
<tr>
<td>Group elements</td>
<td>⌘ G</td>
</tr>
<tr>
<td>Help</td>
<td>⌘ /</td>
</tr>
<tr>
<td>Italic</td>
<td>⌘ I</td>
</tr>
<tr>
<td>Library</td>
<td>⌘ L</td>
</tr>
<tr>
<td>Lock</td>
<td>⌘ H</td>
</tr>
<tr>
<td>Magnify view</td>
<td>⌘ Right arrow</td>
</tr>
<tr>
<td>Move backward</td>
<td>⌘ J</td>
</tr>
<tr>
<td>Move forward</td>
<td>⌘ F</td>
</tr>
<tr>
<td>Move to back</td>
<td>⌘ Shift-J</td>
</tr>
<tr>
<td>Move to front</td>
<td>⌘ Shift-F</td>
</tr>
<tr>
<td>New layer</td>
<td>⌘ Shift-N</td>
</tr>
<tr>
<td>Paste and rescale</td>
<td>⌘ Shift-V</td>
</tr>
<tr>
<td>Plain text</td>
<td>⌘ Shift-P</td>
</tr>
<tr>
<td>Reshape</td>
<td>⌘ R</td>
</tr>
<tr>
<td>Rotate</td>
<td>⌘ T</td>
</tr>
<tr>
<td>Select all</td>
<td>⌘ Shift-A</td>
</tr>
<tr>
<td>Select all on active layer</td>
<td>⌘ A</td>
</tr>
<tr>
<td>Smooth</td>
<td>⌘ E</td>
</tr>
</tbody>
</table>
### Action (continued) | Key(s)
---|---
Spelling | $=\$
Underline | $U$
Ungroup | $\mathbb{Shift}\text{-}G$
Unsmooth | $\mathbb{Shift}\text{-}E$
Up one layer | $\uparrow$

---

**PageMaker Quick Keys**

The following key combinations are available when using Aldus PageMaker Version 4.0.

| Action          | Key(s)  |
---|---|
25% view        | $0$
50% view        | $5$
75% view        | $7$
100% view       | $1$
200% view       | $2$
400% view       | $4$
Actual size     | $1$
All caps        | $\mathbb{Shift}\text{-}K$
Align center    | $\mathbb{Shift}\text{-}C$
Align left      | $\mathbb{Shift}\text{-}L$
Align right     | $\mathbb{Shift}\text{-}R$
Auto leading    | $\mathbb{Shift}\text{-}A$
Bold            | $\mathbb{Shift}\text{-}B$
Bring to front  | $F$
Center          | $\mathbb{Shift}\text{-}C$
Change          | $9$
Circle tool     | Shift-F7
<table>
<thead>
<tr>
<th>Action (continued)</th>
<th>Key(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color palette</td>
<td>⌘ K</td>
</tr>
<tr>
<td>Cropping tool</td>
<td>⌘ Shift-F8</td>
</tr>
<tr>
<td>Define styles</td>
<td>⌘ 3</td>
</tr>
<tr>
<td>Diagonal line tool</td>
<td>⌘ Shift-F2</td>
</tr>
<tr>
<td>Edit story</td>
<td>⌘ E</td>
</tr>
<tr>
<td>Find</td>
<td>⌘ 8</td>
</tr>
<tr>
<td>Find and change</td>
<td>⌘ 9</td>
</tr>
<tr>
<td>Find next</td>
<td>⌘ ,</td>
</tr>
<tr>
<td>Fit in window</td>
<td>⌘ W or ⌘ Option-click</td>
</tr>
<tr>
<td>Force justify</td>
<td>⌘ Shift-F</td>
</tr>
<tr>
<td>Go to page</td>
<td>⌘ G</td>
</tr>
<tr>
<td>Guides</td>
<td>⌘ J</td>
</tr>
<tr>
<td>Help</td>
<td>⌘ ?</td>
</tr>
<tr>
<td>Hyphenation</td>
<td>⌘ H</td>
</tr>
<tr>
<td>Increase point size</td>
<td>⌘ Shift-·</td>
</tr>
<tr>
<td>Indents</td>
<td>⌘ I</td>
</tr>
<tr>
<td>Index entry</td>
<td>⌘ ;</td>
</tr>
<tr>
<td>Italic</td>
<td>⌘ Shift-I</td>
</tr>
<tr>
<td>Justify</td>
<td>⌘ Shift-J</td>
</tr>
<tr>
<td>Line tool, perpendicular</td>
<td>Shift-F3</td>
</tr>
<tr>
<td>Line tool, diagonal</td>
<td>Shift-F2</td>
</tr>
<tr>
<td>Links</td>
<td>⌘ =</td>
</tr>
<tr>
<td>Move window</td>
<td>Option-drag</td>
</tr>
<tr>
<td>Move window, constrained</td>
<td>Shift-Option-drag</td>
</tr>
<tr>
<td>Next page</td>
<td>⌘ Tab</td>
</tr>
<tr>
<td>Nonbreaking hyphen</td>
<td>⌘ Option-- (hyphen)</td>
</tr>
<tr>
<td>Outline text</td>
<td>⌘ Shift-D</td>
</tr>
<tr>
<td>Page number marker</td>
<td>⌘ Option-P</td>
</tr>
<tr>
<td>Action (continued)</td>
<td>Key(s)</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Paragraph</td>
<td>⌘-M</td>
</tr>
<tr>
<td>Perpendicular line tool</td>
<td>Shift-F3</td>
</tr>
<tr>
<td>Place</td>
<td>⌘-D</td>
</tr>
<tr>
<td>Point size, larger</td>
<td>⌘-Shift-Option-.</td>
</tr>
<tr>
<td>Point size, smaller</td>
<td>⌘-Shift-Option-.</td>
</tr>
<tr>
<td>Point size, standard, larger</td>
<td>⌘-Shift-.</td>
</tr>
<tr>
<td>Point size, standard, smaller</td>
<td>⌘-Shift-.</td>
</tr>
<tr>
<td>Pointer tool</td>
<td>Shift-F1 or ⌘-Spacebar</td>
</tr>
<tr>
<td>Previous page</td>
<td>⌘-Shift-Tab</td>
</tr>
<tr>
<td>Rectangle tool</td>
<td>Shift-F5</td>
</tr>
<tr>
<td>Reduce type size</td>
<td>⌘-Shift-.</td>
</tr>
<tr>
<td>Replace</td>
<td>⌘-D</td>
</tr>
<tr>
<td>Rounded rectangle tool</td>
<td>Shift-F6</td>
</tr>
<tr>
<td>Ruler</td>
<td>⌘-R</td>
</tr>
<tr>
<td>Select layer</td>
<td>⌘-click</td>
</tr>
<tr>
<td>Send to back</td>
<td>⌘-B</td>
</tr>
<tr>
<td>Shadow text</td>
<td>⌘-Shift-W</td>
</tr>
<tr>
<td>Small caps text</td>
<td>⌘-Shift-H</td>
</tr>
<tr>
<td>Snap to guides</td>
<td>⌘-U</td>
</tr>
<tr>
<td>Snap to rulers</td>
<td>⌘-[</td>
</tr>
<tr>
<td>Spelling</td>
<td>⌘-L</td>
</tr>
<tr>
<td>Strikethru text</td>
<td>⌘-Shift-/</td>
</tr>
<tr>
<td>Style palette</td>
<td>⌘-E</td>
</tr>
<tr>
<td>Subscript text</td>
<td>⌘-Shift--</td>
</tr>
<tr>
<td>Superscript text</td>
<td>⌘-Shift-=</td>
</tr>
<tr>
<td>Tabs</td>
<td>⌘-I</td>
</tr>
<tr>
<td>Text tool</td>
<td>Shift-F4</td>
</tr>
<tr>
<td>Toolbox</td>
<td>⌘-6</td>
</tr>
</tbody>
</table>
### Quick Key Guide

<table>
<thead>
<tr>
<th>Action (continued)</th>
<th>Key(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type specs</td>
<td>⇧ T</td>
</tr>
<tr>
<td>Underline text</td>
<td>⇧ Shift-U</td>
</tr>
<tr>
<td>Undo/redo last operation</td>
<td>⇧ Z</td>
</tr>
<tr>
<td>Zoom in/out</td>
<td>⇧ Option-click</td>
</tr>
</tbody>
</table>

## SuperPaint Quick Keys

The following key combinations are available when using SuperPaint 2.0 from Silicon Beach Software.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actual size</td>
<td>⇧ Shift-R</td>
</tr>
<tr>
<td>Align objects</td>
<td>⇧ M</td>
</tr>
<tr>
<td>Autotrace bit map</td>
<td>⇧ T</td>
</tr>
<tr>
<td>Bold</td>
<td>⇧ B</td>
</tr>
<tr>
<td>Bring to front</td>
<td>⇧ =</td>
</tr>
<tr>
<td>Change current layer</td>
<td>⇧ /</td>
</tr>
<tr>
<td>Duplicate element</td>
<td>⇧ D</td>
</tr>
<tr>
<td>Fit in window</td>
<td>⇧ Shift-W</td>
</tr>
<tr>
<td>Full screen</td>
<td>⇧ F</td>
</tr>
<tr>
<td>Grid</td>
<td>⇧ Shift-G</td>
</tr>
<tr>
<td>Group</td>
<td>⇧ G</td>
</tr>
<tr>
<td>Hide/show all palettes</td>
<td>⇧ H</td>
</tr>
<tr>
<td>Hide/show back layer</td>
<td>⇧ L</td>
</tr>
<tr>
<td>Increase one point size</td>
<td>⇧ Shift-.</td>
</tr>
<tr>
<td>Italic</td>
<td>⇧ I</td>
</tr>
<tr>
<td>Left-justify</td>
<td>⇧ Shift-L</td>
</tr>
<tr>
<td>Nudge Up</td>
<td>⇧ Y</td>
</tr>
<tr>
<td>Nudge Down</td>
<td>⇧ M</td>
</tr>
</tbody>
</table>
### Key(s)

<table>
<thead>
<tr>
<th>Action</th>
<th>Key(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nudge Left</td>
<td>⌘ J</td>
</tr>
<tr>
<td>Nudge Right</td>
<td>⌘ K</td>
</tr>
<tr>
<td>Object info</td>
<td>⌘ I</td>
</tr>
<tr>
<td>Outline text</td>
<td>⌘ Shift-O</td>
</tr>
<tr>
<td>Plain</td>
<td>⌘ P</td>
</tr>
<tr>
<td>Print</td>
<td>⌘ ;</td>
</tr>
<tr>
<td>Reduce one point size</td>
<td>⌘ Shift- <code>-</code></td>
</tr>
<tr>
<td>Reduced view</td>
<td>⌘ W</td>
</tr>
<tr>
<td>Right-justify</td>
<td>⌘ Shift-R</td>
</tr>
<tr>
<td>Scrolling on/off</td>
<td>⌘ <code>-</code></td>
</tr>
<tr>
<td>Send to back</td>
<td>⌘ <code>-</code></td>
</tr>
<tr>
<td>Underline</td>
<td>⌘ Shift-U</td>
</tr>
<tr>
<td>Ungroup</td>
<td>⌘ U</td>
</tr>
<tr>
<td>Zoom in</td>
<td>⌘ E</td>
</tr>
<tr>
<td>Zoom in 800%</td>
<td>⌘ Shift-E</td>
</tr>
</tbody>
</table>

### Word Quick Keys

The following key combinations are available when using Microsoft Word Version 4.0.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate next window</td>
<td>Option-⌘W</td>
</tr>
<tr>
<td>Add to menu</td>
<td>Option-⌘+</td>
</tr>
<tr>
<td>Again</td>
<td>⌘ A</td>
</tr>
<tr>
<td>All caps</td>
<td>⌘ Shift-K</td>
</tr>
<tr>
<td>Assign style</td>
<td>⌘ Shift-S, type name</td>
</tr>
<tr>
<td>Bold</td>
<td>⌘ Shift-B</td>
</tr>
<tr>
<td>Calculate</td>
<td>⌘ =</td>
</tr>
<tr>
<td>Action (continued)</td>
<td>Key(s)</td>
</tr>
<tr>
<td>--------------------------------------------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>Center text</td>
<td><code>Shift-C</code></td>
</tr>
<tr>
<td>Change</td>
<td><code>H</code></td>
</tr>
<tr>
<td>Character</td>
<td><code>D</code></td>
</tr>
<tr>
<td>Define styles</td>
<td><code>Shift-F3</code></td>
</tr>
<tr>
<td>Delete next character</td>
<td><code>Option-3&amp;-F</code></td>
</tr>
<tr>
<td>Delete next word</td>
<td><code>Option-3&amp;-G</code></td>
</tr>
<tr>
<td>Delete previous word</td>
<td><code>Option-3&amp;-Backspace</code></td>
</tr>
<tr>
<td>Dotted-underline</td>
<td><code>Shift-\</code></td>
</tr>
<tr>
<td>Double space</td>
<td><code>Shift-Y</code></td>
</tr>
<tr>
<td>Double-underline</td>
<td><code>Shift-[ or Shift-F12</code></td>
</tr>
<tr>
<td>Find</td>
<td><code>F</code></td>
</tr>
<tr>
<td>Find and Change</td>
<td><code>H</code></td>
</tr>
<tr>
<td>Find formats</td>
<td><code>Option-R</code></td>
</tr>
<tr>
<td>First line indent, nudge 1/2 inch</td>
<td><code>Shift-F</code></td>
</tr>
<tr>
<td>Font</td>
<td><code>Shift-E, type name</code></td>
</tr>
<tr>
<td>Footnote</td>
<td><code>E</code></td>
</tr>
<tr>
<td>Glossary</td>
<td><code>K</code></td>
</tr>
<tr>
<td>Go to page</td>
<td><code>G</code></td>
</tr>
<tr>
<td>Hanging indent, nudge 1/2 inch</td>
<td><code>Shift-T</code></td>
</tr>
<tr>
<td>Help</td>
<td><code>/ or Help</code></td>
</tr>
<tr>
<td>Hidden</td>
<td><code>Shift-X</code></td>
</tr>
<tr>
<td>Hide symbols</td>
<td><code>Y</code></td>
</tr>
<tr>
<td>Italic</td>
<td><code>Shift-I</code></td>
</tr>
<tr>
<td>Justify text</td>
<td><code>Shift-J</code></td>
</tr>
<tr>
<td>Left-justify text</td>
<td><code>Shift-L</code></td>
</tr>
<tr>
<td>Left margin, indent, nudge 1/2 inch (nest)</td>
<td><code>Shift-N</code></td>
</tr>
<tr>
<td>Action (continued)</td>
<td>Key(s)</td>
</tr>
<tr>
<td>----------------------------------------------------------------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>Left margin indent, nudge 1/2 inch (unnest)</td>
<td>%Shift-M</td>
</tr>
<tr>
<td>Menu mode</td>
<td>. (numeric keypad)</td>
</tr>
<tr>
<td>Normal text</td>
<td>%Shift-Spacebar</td>
</tr>
<tr>
<td>Normal style sheet, change selection</td>
<td>%Shift-P</td>
</tr>
<tr>
<td>Outline</td>
<td>%Shift-D</td>
</tr>
<tr>
<td>Outlining</td>
<td>%U</td>
</tr>
<tr>
<td>Page view</td>
<td>%B or F13</td>
</tr>
<tr>
<td>Paragraph</td>
<td>%M</td>
</tr>
<tr>
<td>Plain text</td>
<td>%Shift-Spacebar</td>
</tr>
<tr>
<td>Point size, increase</td>
<td>%Shift-&gt;</td>
</tr>
<tr>
<td>Point size, decrease</td>
<td>%Shift&lt;-</td>
</tr>
<tr>
<td>Preview</td>
<td>%I</td>
</tr>
<tr>
<td>Remove from menu</td>
<td>Option-% - (minus)</td>
</tr>
<tr>
<td>Repaginate</td>
<td>%J</td>
</tr>
<tr>
<td>Right-justify text</td>
<td>%Shift-R</td>
</tr>
<tr>
<td>Ruler</td>
<td>%R</td>
</tr>
<tr>
<td>Show symbols</td>
<td>%Y</td>
</tr>
<tr>
<td>Small caps</td>
<td>%Shift-H</td>
</tr>
<tr>
<td>Spelling</td>
<td>%L</td>
</tr>
<tr>
<td>Split window</td>
<td>Option-% S</td>
</tr>
<tr>
<td>Strikethrough</td>
<td>%Shift-/</td>
</tr>
<tr>
<td>Style</td>
<td>%Shift-S, type name</td>
</tr>
<tr>
<td>Styles, define</td>
<td>%T</td>
</tr>
<tr>
<td>Symbol character</td>
<td>%Shift-Q</td>
</tr>
<tr>
<td>Underline</td>
<td>%Shift-U</td>
</tr>
<tr>
<td>Underline word</td>
<td>%Shift-]</td>
</tr>
<tr>
<td>Zoom</td>
<td>Option-[%]</td>
</tr>
</tbody>
</table>
Glossary

Accelerator board. An option card that enables your Mac to operate and manipulate data at a faster rate.

Active window. The topmost window on the desktop, denoted by a highlighted title bar.

ADB. See Apple Desktop Bus.

American Standard Code for Information Interchange (ASCII). A standard computer text format in which each character is represented by seven bits. See also Text file.

Apple Desktop Bus (ADB). The connectors on the back of the Macintosh that allow connection of the keyboard, mouse, joysticks, graphics tablets, touch screens, track balls, and so forth, up to 16 input devices. See also Input device.

AppleShare. An operating system designed to enable a Macintosh to become a server to other Macintosh computers on the same network.

AppleTalk. A local area network standard used to connect Macintosh computers and to allow sharing of peripheral devices, such as printers. AppleTalk is the communication protocol by which data is transferred. See also Protocol.

Application. A program that allows the user to create, enter, and design information. Examples are word processors, spreadsheets, and paint programs.

ASCII. See American Standard Code for Information Interchange.

Assembler. A program that translates symbolic codes, or assembly language, to machine language.

Asynchronous communication. A means of transmitting data between computers. A special signal indicates when each character starts and stops.

BBS. See Bulletin Board System.

Background execution. A program that can continue operating without user commands and without interrupting a procedure operating in the foreground. See also MultiFinder, Multitasking, and Spooler.

BASIC. See Beginner's All-purpose Symbolic Instruction Code.

Baseline. In typography, the lowest point characters reach (excluding descenders). See also Descender.

Baud rate. A measure of speed equal to one signal per second. Common baud rates are 1,200 and 2,400.
BBS. See *Bulletin Board System*.

**Beginner's All-purpose Symbolic Instruction Code** *(BASIC)*. A common programming language that is easy to learn but relatively inflexible.

**Beta test.** The first test outside of the laboratory of a new product. This test is the final step before a full market release.

**Bezier curves.** (Pronounced bez-ee-ay) Mathematical equations that describe the outlines that create PostScript fonts.

**Binary.** A numbering system based on a series of ones (1s) and zeros (0s) used to encode text and numerical information.

**Bit.** A binary digit; the smallest unit of computer information. A 1 or a 0 code electronically represents, respectively, on or off.

**Bit-mapped image.** An image consisting of dots, in which one dot represents one or more bits of the image (depending on whether color or other attributes are used). A Mac Classic uses one bit per dot. See also *Font*.

**Bomb.** An abnormal termination of a program. A bomb occurs when a program unexpectedly halts due to a bug, or it encounters data conditions it cannot handle. See also *Bug*.

**Boot.** To start a computer by loading the operating system (the System and Finder) into memory. The operating system software tells the Macintosh how to load other programs.

**Bridge.** A device that lets you connect networks so that members on one network can communicate with members on another network. See also *Gateway*.

**Buffer.** A section of memory that temporarily holds information from I/O (input/output) communications, including data transfer via modem, or reading and writing to your disk. The buffer holds information when the computer is sending information faster than the device can receive it. See also *Spooler*.

**Bug.** A problem in a software program. An inappropriate or inaccurate line of programming code that causes the program to halt execution or respond incorrectly. Initially named after a moth that caused the failure of an early computer at Harvard University in 1945. See also *Bomb*.

**Bulletin Board System** *(BBS)*. A telecommunications facility used to share information with others through the use of a modem and specialized communications software.

**Bus.** A path through which information is shared between one part of a computer and another. See also *Apple Desktop Bus*. 
**Byte.** A measure of the amount of information equivalent to the memory needed to store a character of the alphabet. 1,024 bytes are equivalent to 1K of memory. A byte is made up of eight bits; it has eight 1s and 0s per byte. See also *Bit.*

**Cache.** (Pronounced “cash.”) A special section of RAM memory reserved for frequently used applications and utility information.

**CDEV.** See *Control Panel Device.*

**Central Processing Unit (CPU).** The computer’s main information processing unit. In a Macintosh, the CPU is a single silicon chip called the microprocessor.

**Chip.** A tiny piece of silicon with an integrated electronic circuit on its surface.

**Chooser.** A desk accessory that allows you to select a printer on which to print. For the Chooser to function, the printer resource files must be present in the System Folder. In a networking environment, the Chooser can be used to connect and disconnect from the network as well as to choose among devices connected to the network.

**Click.** A quick press-and-release of the mouse button.

**Clip art.** Artwork purchased on disk. Clip art can be a bit-mapped graphic image, an object graphic, or even an Encapsulated PostScript file.

**Clipboard.** A temporary storage location, which holds cut and copied information. See also *Scrapbook.*

**Close box.** A small box located at the upper left corner of a document window. Clicking inside the close box causes the program to prompt the user to save changes to the document and close the current window.

**CMYK.** The four colors used in the color separation process that can be combined to form any other color: Cyan, Magenta, Yellow, and Black.

**Cold boot.** Turning on your Macintosh with the power switch.

**Color separations.** A process used in offset printing in which separate plates are used to print different colors of ink on a page with multiple colors. As the name implies, each color has its own plate.

**Computer-aided design (CAD).** Applications that take advantage of the power of the computer to design architectural, mechanical, electrical, civil, schematic, IC, and various other types of drawings.

**Control Panel.** A desk accessory used to personalize such features as the pattern on the desktop, the speed of the mouse movement, and the volume of the warning beep.
Control Panel Device (CDEV). A utility program placed in the System Folder and controlled from the Control Panel.

Coprocessor. A microchip that assists the main microprocessor with data-intensive tasks such as large spreadsheet, large database, complex statistical analysis, or graphics activities.

Copy. A command used to make an exact replica of anything—a letter, an entire document, a graphic, an application, or even a disk. The Copy command is located under the Edit menu. Using Copy does not modify or delete the original. See also Clipboard, Cut, Paste, and Scrapbook.

Copy protection. A method of preventing unauthorized duplication or use of software. See also Write-protect tab.

CPU. See Central Processing Unit.

Crash. When your Macintosh gives you that dreaded “bomb”—forcing you to restart; or when the Mac keyboard freezes up and won’t do anything.

Cursor. An icon indicating the current mouse location on your screen. The Macintosh has a variety of cursor shapes including a vertical bar, I-beam, pointer, and wristwatch. See also Insertion point.

Cut. A command that removes selected information from a document and temporarily places it in the Clipboard. See also Clipboard, Copy, Paste, and Scrapbook.

DA. See Desk Accessory.

Data. The information processed by a computer application.

Database. A collection of related information organized for storage and retrieval. For example, a database may contain names, addresses, and phone numbers.

Delete key. A key you press to remove information from a document. See also Cut.

Descender. The portion of a lowercase letter that hangs below the baseline. Five letters of the alphabet have descenders: g, j, p, q, and y.

Density. A measurement of the amount of information (in bits) that can be packed reliably into a square inch of magnetic media, such as a floppy disk. See also Disk and Floppy disk.

Desk Accessory (DA). A small application located in the System file, that is accessible from the Apple menu. Examples are the Alarm Clock, Chooser, and Control Panel.
Glossary

**Desktop.** The work area of the Macintosh. The screen, disk icons, trash can, and menu bar that you see when you first start your Mac.

**Desktop file.** An invisible file on all Macintosh disks that contains the information the Finder uses to locate files, folders, and icons.

**Desktop publishing.** A package that combines page layout, text entry, and graphics design into one application.

**Dialog box.** A message from the Macintosh requesting further action or information from the user. In most instances, the user responds by typing a response or clicking a button.

**Disk.** A device utilizing a magnetic medium designed to store information. The Macintosh uses 3 1/2-inch hard-case floppy disks. Disks can be floppy disks or hard disks. A typical floppy disk can be single-density (400K), double-density (800K), or high-density (1.4M). Hard disks can range from 10M to more than a gigabyte.

**Disk drive.** A disk drive holds the disk and retrieves and stores information. A floppy disk drive (3 1/2-inch) holds the floppy disk that the user inserts. A hard disk is a high performance storage device consisting of platters coated with magnetic media. A hard disk is protected by a sealed case.

**Document.** A generic term describing whatever the user creates using an application on the Macintosh. A document can be a letter, article, picture, table, or spreadsheet worksheet, among others. A document contains the information the user has entered and saved.

**Dot-matrix printer.** A printer that forms characters and graphics out of dots.

**Dots per inch (dpi).** A measure of screen and printer resolution. The higher the number the better the resolution. The ImageWriter II operates at 144 dpi, and the LaserWriters operate at 300 dpi. See also Resolution.

**Double-click.** Used to open applications, documents, or folders. Double-clicking is performed by clicking the mouse button twice in rapid succession.

**Download.** A procedure in which a user transfers data from a remote computer's database to the user's computer and stores the data on a hard or floppy disk.

**Downloadable font.** A font that is sent from your Macintosh to your printer.

**Dpi.** See Dots per inch.
Drag. A technique used to move icons from one location to another, such as moving a file from one folder to another. To drag an item, move the mouse to position the cursor over an item. Press and hold the mouse button, and move the mouse to position the item in the desired location. Release the mouse button to “plant” the item in that location.

Driver. Software that tells the Macintosh how to operate an external device, such as a printer. A driver is located in the System Folder.

E-Mail. A messaging system that enables users to send and receive “mail” to and from other people on the electronic network.

Emulation. A feature that enables one device to imitate another.

Encapsulated PostScript (EPS). A file format that uses PostScript language to store an image.

Encryption. The substitution of characters to hide the contents of a document.

EPS. See Encapsulated PostScript.

Ethernet. A standard for local area network hardware.

Expansion card. An internal board you attach to your system that enables features to be added to improve processing capability, telecommunications capability, and so on.

Expansion slot. A location inside your Macintosh that allows you to install a card to perform additional functions.

FAX (facsimile transmission). The transmission of information from printed page to printed page through a telecommunications device.

File. Information stored on a disk. Also called a document.

File format. The set of instructions or pattern used to store information.

File server. An item on a network that makes available to all users a disk drive and software. File-server software controls access to individual files and multi-user software allows several users simultaneous access to the same file.

Finder. Part of the Macintosh operating system that keeps the desktop organized, allowing the user to find and open files or folders. The Finder file must be present in the System Folder on a startup disk.

Fkey. A utility program executed by pressing one of the function keys at the top of an extended keyboard.

Floppy disk. A 3 1/2-inch flexible disk contained within a semi-rigid plastic casing. See also Disk.
Folder. An item on the desktop that holds icons for related information in one location—just like the folders you have in your file cabinet at the office. A folder can contain files, other folders, graphics documents, or any type of information.

Font. A collection of letters, punctuation marks, numbers, and symbols that appear in the same typeface, style, and size. The Macintosh comes with a number of different fonts, such as Monaco, Chicago, and Geneva. See also Bit-mapped image, Outline fonts, and PostScript.

Font/DA Mover. A Macintosh utility that moves fonts and desk accessories from one system to another or from a floppy disk to a system.

Font substitution. A Macintosh activity that substitutes one font for another when the font required by a particular application is not available.

Format. See Initialize.

Freeware. Macintosh software shared without cost to the user, with the intention that the software will be shared by others and distributed throughout a large network of users.

Function key. A key that you can program to perform a particular function.

Gateway. In a computer network, the hardware and software used to connect two different types of computer networks. See also Bridge.

Gigabyte (G). One billion bytes (1,073,741,824 bytes).

Graphical User Interface (GUI). A description of an interface between a user and a computer that uses menus and icons to represent commands and files.

Hard copy. A printout on paper, as opposed to data stored in memory or on disk.

Hard disk. A disk housed inside or outside a system unit that contains permanently installed disks. A hard disk holds much more information than a floppy disk and operates faster.

Hardware. The physical parts of the Macintosh. The screen, keyboard, mouse, disk drives, casing, cables, and all the electronic mechanisms and boards inside the Macintosh.

Highlight. To select something so that it appears different from the surrounding information. When a piece of information is highlighted, the user can initiate a command to modify that information. For example, you highlight a word and change the font.
**HyperCard.** A user-modifiable, object-oriented environment. With a scripting language called HyperTalk, you program HyperCard to create applications called stacks. Stacks are made up of cards that have buttons, icons, and fields which can perform other functions or can be linked to other stacks or cards. See also *HyperTalk.*

**HyperTalk.** The programming language used to program HyperCard stacks and create user-defined functions. HyperTalk is an English-like scripting language. See also *HyperCard.*

**Hypertext.** The retrieval of text and ideas throughout various documents and files without regard to order.

**I-beam.** The shape of the cursor when you enter or edit text.

**Icon.** A graphic representation of a file, folder, disk, or command. An icon is similar to a sign representing information. For example, a file is generally represented as a sheet of paper, and a folder looks like a manila folder.

**ImageWriter.** A dot-matrix printer designed specifically for use with a Macintosh.

**Initialize.** To prepare a disk for use on your system. Generally, initializing a disk means that the Macintosh will clear off any data on the disk and structure the disk into sectors and tracks. Also called "formatting."

**INIT.** A utility file located in the System Folder that executes during a system start or restart.

**Input device.** A device that inputs information into your Macintosh such as mouse, keyboard, trackball, or graphics tablet.

**Insertion point.** The location in a document where the user may insert something. The insertion point is designated by positioning the cursor where you want the insertion to occur and clicking once. A blinking I-beam appears at that point. See also *Cursor.*

**Integrated software.** A software package containing a spreadsheet, database, word processor, and telecommunications in which the component programs can freely exchange data.

**Interface.** An electronic link between different computer devices such as the computer and a mouse.

**Invisible file.** A file that does not appear on the desktop and cannot be copied, erased, or moved.

**K.** See *Kilobyte.*

**Kerning.** Adjusting the spacing between letters. Typically used to reduce the space between pairs of letters.
Kilobyte (K). One thousand (1,024) bytes. A common measure of file size. A typical page of plain text is 2K.

LAN. See *Local Area Network*.

Landscape. A page orientation in which the printer prints the image horizontally. The page top is the longest side of the paper.

Laser font. An easily scaled font defined by mathematical formula.

Laser printer. A printer that forms characters and graphics by moving a laser beam across a photoconductive drum. The printer then projects the image onto paper. Macintosh laser printers are called LaserWriters. See also *Toner*.

Launch. To start an application.

Leading. The amount of vertical spacing, in points, between baselines of type.

Lisa. The first computer that used the Mac interface including the mouse and icons but that was not successful because of its high costs.

*Local Area Network* (LAN). Computers linked with cables and software. The computers can share files and external devices, such as printers and disk drives. Many offices are linked with LANs to improve communication and efficiency.

LocalTalk. The hardware portion of Apple's LAN system used to connect Macs to LaserWriters and other Macs.

Logic board. The board inside the Macintosh responsible for organizing and executing instructions.

M. See *Megabyte*.

MacBinary. A format that enables Macintosh files to be stored on non-Mac machines without any loss of information.

Macro. A small computer program, usually developed with a macro maker application, that you program to do repetitive tasks simply by typing a key combination.

Marquee. The dotted box drawn with a mouse around items to highlight the items.

Megabyte (M). A measure of size representing one million (1,048,576) bytes of storage capacity on a disk or in RAM.

Memory. The primary location within the computer that stores internal instructions.

Menu. A list of commands available to the user.
Menu bar. An area at the top of your Macintosh screen that lists available commands.

Microprocessor. A small silicon chip containing a huge number of electronic components. The microprocessor chip can operate on large amounts of information when used with other computer components.

Modem (modulator/demodulator). A peripheral device that allows computers to communicate by telephone lines.

Moire. (Pronounced "mwah´ray.") An optical illusion perceived as flickering, that occurs when high-contrast line patterns are too close together.

Monitor. A color or monochrome screen associated with a computer.

Motherboard. The main board (also called the logic board) in the Macintosh that contains the central processing chips, RAM, and expansion slots.

Mouse. A device used to navigate on the Macintosh screen. You use a mouse to select information and issue commands. When you move the mouse, the cursor moves on-screen in the corresponding direction.

MultiFinder. Part of the system that allows the user to load into memory multiple applications and switch between them. MultiFinder also allows for concurrent tasks to take place at (seemingly) the same time. This process is also known as multitasking.

Multimedia. Information presented combining graphics, text, and sound.

Multitasking. A computer capability in which two or more programs are loaded into memory simultaneously. The CPU attends to all programs at once by switching back and forth between them, which is called time slicing. See also MultiFinder.

Nanosecond. One billionth of a second.

Network. A communications pathway using hardware and software that links multiple computers and peripheral devices so that each computer or device shares information. See also Node.

Node. A device on a network that can send and receive information. See also Network.

NuBus. A high-speed information pathway for the Mac II family of computers.

Null modem. A cable connecting two computers. Used instead of a modem for communication purposes.
Object-Oriented Programming (OOP) A programming language in which program elements are conceptualized as objects that can pass messages to each other.

OCR. See Optical Character Recognition.

On-line help. A file contained within an application that provides help while you operate the application.

Open. The act of accessing a document for modification or viewing.

Operating system. The software that controls the functioning of the Macintosh and the direction of information flow among computer components.

Optical Character Recognition (OCR). A technology by which printed characters are optically scanned and translated into software text that the computer can process.

Optical disc. A disc on which data (or music) is recorded in the form of small deformations. The data is retrieved with a laser beam.

Outline font. A PostScript font formed of outlines, which are then filled in. See also Bit-mapped image, Font, and PostScript.

Page Description Language (PDL). A language used to affect printer output.

Parallel port. A connection to a computer through which eight or more bits are transmitted simultaneously in one direction. See also Disk drive.

Parameter RAM (PRAM). Memory devoted to certain system settings such as the time, date, and the alarm clock. PRAM is stored in a battery inside your system.

Parity bit. An extra bit appended to a character whose value is used to check for errors in the transmission of data.

Partition. A physically separate section on a hard disk that you can use with the same or a different operating system.

Paste. A command that places a copied or cut piece of information at the insertion point in a document. The Paste command retrieves from the Clipboard information that has been copied or cut.

Path. The hierarchical directions to a folder, application, or document file.

Peripheral. A unit of hardware, such as a printer, modem, or hard disk drive. Cables connect peripheral devices to your Macintosh.

Pica. A unit of measure equal to 12 points, or approximately 1/6th inch.
Phosphor. A chemical material used to coat the inside of cathode ray
tubes on which electrons are targeted to produce images.

PICT. An object-oriented graphic format used to store documents.

Pixel. A single dot or picture element on the Macintosh display.

Platform. A computer hardware standard, such as Macintosh or IBM PC-
compatible, in which there is a comprehensive approach to the
computer solution of a problem.

Platter. The glass or metal circular component of a hard disk that spins
and on which information is written and from which information is
read.

Point. A unit of measure used to indicate size of line or type. There are 72
points in an inch.

Pointer. One of the shapes of the cursor. Usually, the pointer is an arrow
pointing upward and to the left.

Port. A socket on the back of the Macintosh that allows you to connect a
printer cable, hard disk drive, modem, keyboard, or mouse to your
Macintosh.

Portrait mode. A page orientation in which the top of the printed image
is along the short side of the paper.

that prepares an image for printing on a laser printer. PostScript
fonts—widely recognized as the standard in near-typeset quality
printing—are used with PostScript-compatible printers only.

PostScript interpreter. A code built into PostScript-compatible printers
that converts PostScript commands into a language the printer can
process to create an image or character.

PRAM. See Parameter RAM.

Printer driver. The software containing the instructions that enable the
computer to communicate with a particular type of printer.

Printer font. A font designed for printing rather than just for display.

Print-spooling. The process by which documents to print are stored in
a memory outside of the computer's RAM, enabling computer
processing to continue.

Program. A set of instructions that tells a computer what to do.

Programmer's switch. A plastic switch that comes with all Macs. You can
place the switch on the side of your Macintosh to enable you to
reboot the computer and access the Macintosh debugging utility.
Programming language. A language used to write programs for the Macintosh. There are many languages, including Object Pascal, C++, BASIC, FORTRAN, and SmallTalk/V.

Proportional spacing. In typesetting or printing, a setting that allows wider letters to take up more space than narrower letters.

Protocol. In computer telecommunications, the set of rules and procedures determining how information travels between computers.

Public domain software. Software that can be copied without copyright infringement.

QuickDraw. A computer code that resides in the Macintosh's ROM and facilitates the generation of images for the screen and printer.

RAM cache. (Pronounced "cash.") A portion of RAM that you can designate to hold disk information. You change RAM cache settings from within the Control Panel.

RAM disk. A program that fools your computer into recognizing disk space as additional memory.

Random-Access Memory (RAM). The part of the Macintosh's memory that allows for the temporary storage of information. Information left in RAM is lost when you turn off your Macintosh.

Read-Only Memory (ROM). Memory that stores permanent system information and contains the information needed to start up your machine.

Reboot. To restart the computer.

ResEdit. A utility that enables you to edit application resources. ResEdit allows you to customize applications, change menu commands, or modify the appearance of the trash can icon.

Resolution. The number of dots per inch displayed on a screen or printer. The Macintosh Classic screen, for example, has a resolution of 72 dpi. A LaserWriter has a resolution of 300 dpi. See also Dots per inch.

Restart. To reset a computer to its start-up state without turning off the power. The Macintosh has two procedures for restart: menu command and the programmer's switch. Also referred to as a warm boot.

Return key. The key located on the right side of the main keyboard. Similar to the Enter key.

ROM. See Read-Only Memory.

Run. To execute a program or an application.
**Sans serif.** (Pronounced “san-serr´-if.”) A typeface that lacks fine cross strokes across the ends of the main strokes. Helvetica and Geneva are examples of sans serif typefaces. See also Serif.

**Save.** To store information on a disk.

**Save As.** To store the current document using a different name or file format.

**Scanner.** A device used to capture graphics and text on paper to a disk format for use in Mac applications. See also Optical Character Recognition.

**Scrapbook.** A desk accessory used to store pictures and text. You access the Scrapbook at any time through the Apple menu. In contrast to the Clipboard, the Scrapbook stores information permanently.

**Screen dump.** A picture of the contents of the screen sent to a file or printer.

**Screen font.** A font used for on-screen display.

**Screen saver.** A utility that prevents image “burn in” by automatically filling the screen with animation during a period of user inactivity.

**Script.** A series of commands written in a programming language.

**Scrolling.** A method of moving within a document. You use the scroll bars located on the right and bottom of the screen, to navigate to view different portions of a window or document.

**SCSI.** See Small Computer System Interface.

**SCSI port.** A port located on the back of the Macintosh that allows the user to connect a SCSI interface cable from a peripheral device to the Macintosh.

**Sector.** On a disk, the smallest continuous physical space for saving data. See also Track.

**Select.** To designate where an action should occur.

**Serial interface.** A form of data transmission in which the bits of each character are transmitted sequentially one at a time over a single channel or wire. The most common serial interface is RS-232.

**Serial port.** A connector on the back of the Macintosh, that allows for the connection of serial devices using a serial interface.

**Serif.** (Pronounced “serr´-if.”) A small crossbar added to a typeface. Courier and Times are examples of serif typefaces. See also Font and Sans serif.
Server. Any device on a network that can be shared by all network users.

Shareware. Copyrighted computer programs that users can try on a trial basis.

Shut down. The process of saving all work, closing all folders and files, ejecting all disks, and turning off the power to the computer.

Single In-line Memory Module (SIMM). A memory module that contains the chips needed to add 256K or 1M of random-access memory to your computer. A SIMM plugs into a motherboard or a logic board.

Size box. A box located in the lower right corner of the active window that contains two overlapping smaller boxes. Drag the box to increase the size of the window, or shrink the window to its previous size.

Slot. The part of an internal board that can hold a card.

Small Computer System Interface (SCSI). Pronounced “scuzzy.” A standard interface that allows the user to connect a peripheral device to the Macintosh.

Software. A generic term for computer programs. Software tells hardware how to perform tasks. Categories of software include systems software, utilities, and specific applications (such as financial programs, spreadsheet programs and word processors).

Spooler. A printer software utility that enables you to send multiple documents to a printer and continue working while the printer receives each spooled document for printing.

Star network. A network with the central processor at the center of the network and a series of nodes surrounding it in a star pattern.

Startup disk. A disk that contains the System files the Macintosh needs to start itself up. A startup disk must contain a System file and a Finder file, and generally contains printer resources and desk accessories. The startup disk is the first disk inserted into a floppy disk system. In a hard disk system, the hard disk becomes the startup disk and automatically boots when you turn on the Macintosh. See also Boot.

Startup screen. The opening screen you see when you boot up your Macintosh. You can customize the startup screen using most paint programs.

Stop bit. A bit of information that indicates the transmission of a byte is completed.

Style. A format variation of a font that includes boldface, italic, shadow, outline, underline, and strike-through, to name a few.

Style sheet. A set of predefined formats and text commands that you can quickly and easily incorporate into a new document.
SYLK (Symbolic Link). A file format developed by Microsoft for spreadsheets and databases. Used for transferring data between applications.

System. A file that contains information the Macintosh uses to operate and start up. The Macintosh will not operate without a System file.

System Folder. The folder that contains the important System and Finder files necessary to boot up and run the Macintosh.

System heap. The area of memory set aside for storing System information about files and resources.

Tab-delimited file. A data file in which tabs separate individual records or data elements.

Telecommunications. Sharing information over phone lines through the use of a modem and communications software. See also Modem.

Template. A document that you create for repeated use. Using the Save As command, you save each file created with a template to a unique name. The original template remains intact for future use.

Terminal emulation. Enables a computer to act like a terminal for use with a host computer such as a mainframe. Terminal emulation software enables you to customize the Macintosh to recognize and use the control codes required to access the host's data.

Text file. A file that contains sequences of bits that represent characters. Also known as an ASCII file. See also ASCII.

Thermal-transfer printer. A dot-matrix printer that uses heated pins to melt dots of pigment on paper.

TIFF (Tagged Image File Format). A file format for scanned images. See also Optical Character Recognition.

Token-ring network. A network in which information passes from one node to another through a ring-like shape. See also Star network.

Toner. A black powder used in laser printers and photocopy machines. The powder serves as an ink in the printing of characters and images. See also Laser printer.

Touch screen. A computer screen that allows the user to touch the screen (rather than use a keyboard or mouse) to activate computer actions and commands.

Track. Concentric circles on the surface of a disk that contain data. One or more tracks make up a cylinder of disk space. See also Sector.
**Trackball.** A pointing device similar to a mouse. A trackball is essentially an inverted mouse; the ball is located on the top of the device, and you move the ball. The device remains stationary. See also *Mouse.*

**Tractor-feed.** A device that advances paper by using pins that fit into formed holes along the edges of fanfold computer paper.

**Trash can.** An icon on the desktop used to discard files, folders, and applications.

**Typeface.** The basic font family design such as Times or Monaco. See also *Font.*

**Type size.** The height in points of the characters in a font. See also *Font* and *Point.*

**Typestyle.** Versions of a typeface that have become known as separate fonts. Examples include *italic* and *boldface.* See also *Font.*

**Typography.** The science and art of designing aesthetically pleasing and readable typefaces.

**UNIX.** An operating system developed by Bell Laboratories. UNIX enables you to run several programs at once and is regarded as a powerful general-purpose operating system. UNIX is a multiple-platform operating system—it runs on different types of computer systems.

**Upload.** A procedure in which you transfer information from your computer to a remote computer.

**User group.** A group of people who have an interest in a particular computer or a particular type of application such as desktop publishing. You find user groups throughout the country. Many groups are based at universities and large corporations.

**Video card.** A circuit board containing a video controller and related components that you connect or plug into your computer to control the video display.

**Video RAM.** A section of RAM devoted to screen information. Video RAM stores a bit-mapped image of the screen display. See also *Random-Access Memory (RAM).*

**Virtual memory.** Available space on your hard disk that your computer uses to increase the RAM available for application use.

**Virus.** A program designed to alter the normal functioning of your computer system. A virus can destroy data, corrupt system files, or lock you out of your computer. In many cases, you may be unaware that a virus exists on your system until it is too late to protect existing data. A virus generally passes from disk to disk and from computer to computer through disk sharing or electronic file transfers from bulletin board systems.
Virus-protection software. A program that checks existing files and applications for the presence of a virus. Some protection programs identify the strain of virus and attempt to eradicate it. Other software just informs you that a virus exists.

Warm boot. Restarting your computer without turning the power off and on. You can restart your Mac by selecting the Restart command from the Special menu, or by pressing the Reset button on the Programmer's Switch. See also Programmer's Switch.

Window. An area on the desktop that displays information.

Word wrap. In word processing, a text-entry feature that automatically advances your cursor to the next line when text reaches the end of a line. Word wrap eliminates the need for pressing the Return key at the end of each line.

WORM (Write Once Read Many) disk. An optical disk that stores large amounts of information. That information, however, can only be accessed—not changed. You cannot write data to a WORM disk.

Write-protect tab. A small plastic switch built into the casing of a disk to prevent you from accidentally erasing or overwriting the contents of that disk. When the switch is closed, the disk is unlocked. You therefore can write data to that disk. If the switch is open (or if there is a hole where the switch should be), the disk is locked. See also Copy protection.

Zoom box. A box located in the upper right corner of the active window. The zoom box enables you to expand and shrink the window.
Index

A

activating
  MultiFinder, 140
  Print Monitor, 156
  windows, 214
After Dark INIT program, 109, 180
alarm clock, 4-5, 32
  changing settings, 4-5, 32
Aldus PageMaker Version 4.0 quick keys, 274-277
alert boxes, 5
  see also dialog boxes
  selecting the default, 6
aliases (System 7), 223-224
aligning
  icons, 210
  margins, 6
alignment, 7
AppleScript programming language (System 7), 225
AppleTalk communications protocol, 144
applications
  copying files from within, 78
  deleting, 50
  installing desk accessories, 89
  installing fonts, 89
  launching, 119-120
  from desktop, 147
  from MultiFinder, 141
locking, 120
opening files from within, 147-148
printing files from within, 75, 159-160
quitting, 165
renaming files from within, 76
switching with MultiFinder, 140-141
troubleshooting, 205
universal quick keys, 268
unlocking, 121
audio signals, 16
  adjusting the volume, 16
  changing, 17
  eliminating, 17
automatic backups, 11
AutoMac INIT program, 109

B

backups, 10-11
  floppy disks (with one floppy drive), 12-13
  from hard disk to floppy disk, 11
  more than one file, 11
  software, 11
Ballon Help System (System 7), 236-237
batteries, 14
  checking, 15
  replacing, 15-16
baud rates (modems), 132
BBS (bulletin board systems), 18
beep sounds, 16
  adjusting the volume, 16
  changing, 17
  eliminating, 17
bit-mapped fonts, 9, 92-93
  jaggies, 93
boing sound, 17
bombs, 42
booting, 24
boxes
  see alert boxes or dialog boxes
brightness, 35-36
bulletin board systems (BBS), 18

C

cache, 167-168
  setting amount of memory, 168-169
calculator, 22
cancelling printing, 160
CDEV (Control Panel Device), 23-24
changing settings, 24
  copying to your system, 24-25
  System 7, 225-226
centering text, 25-26
  uncentering text, 26
changing
  beep sounds, 17
  fonts, 94
  size, 94
  styles, 94
printers, 27-28
characters
  special, 189
  quick keys, 249-267
  viewing, 189-190
Cheshire INIT program, 109
Chooser, 27
  checking settings, 27-28
Claris FileMaker Pro Version 1.0
  quick keys, 270-272
cleaning mouse, 138
clink-clank sound, 17
clip art, 28-30
  copying to scrapbook, 30
Clipboard, 31
  pasting from, 153
  viewing contents, 153
clipboard, 31
clock, 4-5, 14, 32
  setting, 32
close box, 33-34
closing
  active window, 33
  windows, 214
color monitors, 133-134
colors, 24, 34
  brightness, 35-36
  changing on the desktop, 34
  hue, 35-36
  saturation, 35-36
  switching to black and white, 35
commands
  selecting from menus, 130
  undoing, 206-207
comments
  attaching
    to files, 97
    to folders, 97
  compressing files, 67-68
  connectors, 8
  context-sensitive help, 99-100
Control Panel, 14, 36
  changing settings, 37
  mouse settings, 137-138
  setting cache size, 168-169
  System 7, 226-228
Control Panel Devices (CDEVs), 23-24
  changing settings, 24
  copying to your system, 24-25
  System 7, 225-226
converting DOS files into Mac files, 48
Copy command, 38
  copying, 39
  between applications, 39
  CDEVs to your system, 24-25
  clip art to scrapbook, 30
  disks, 11-14
  existing files from desktop, 63
files, 11
  from desktop, 77, 63
  from one disk to another, 76-77
graphics, 38
  multiple files from one disk to
  another, 77
text, 38
  to clipboard, 31
  correcting typographical errors, 40
  crashes, 43-45
  possible causes, 42
cutting, 46-47
  cutting and pasting text, 152-153

D

data conversion, 47
  data recovery, 170-171
Database Access Manager (System
  7), 228
databases, 48
  fields, 48
  records, 48
deactivating INITs, 110
defaults (alert boxes), 6
deleting
  applications, 50
  desk accessories, 90
  files, 49, 78, 199
    accidentally, 50
    multiple files, 199-200
  folders, 199
    multiple folders, 199-200
  fonts, 90
  items from a folder, 86
  items from Scrapbook, 178-179
  locked files, 50
  text, 40-41
density, 60
deselecting objects with mouse, 136-137
desk accessories (DAs), 51
  alarm clock, 4-5
  calculator, 22
  Chooser, 27-28
  Control Panel, 36
  Find File, 81
  installing, 52-53, 87-89, 111-112
    System 7, 235
  Key Caps, 116-117
  Note Pad, 144-145
  removing, 90
  Scrapbook, 177-179
    System 7, 228-229
desktop
  color, 34
  copying files from, 77
  files, 53
copying, 63
duplicating, 63
rebuilding, 54
launching applications, 147
opening files, 74, 147
pattern, 14, 24
placing files upon, 79
printing files, 75, 160
rebuilding, 169-170
renaming files from, 76
storing files, 209
desktop publishing, 9, 55-56
destination disks, 14
dialog boxes, 56-57
directories, printing, 161
disabling MultiFinder temporarily, 143
disk drives, 58
floppy, 58
hard, 58-59
purchasing considerations, 59
speed, 58
disks, 60
copying, 11-14
densities, 60
destination, 14
ejecting, 12-13, 64-65
erasing, 66
floppy, 60-61
hard, 60-61
initializing, 106-108
inserting, 110-111
locking, 120
recovering data, 170-171
reinitializing, 108
saving files to, 75
saving files to alternate disks, 175
source, 12-14
unlocking, 120
DiskTop INIT program, 109
documents
opening automatically with MultiFinder, 141
orientation, 148-150
DOS files, converting into Mac files, 48
dot matrix printers, 157
dots per inch (DPI), 62
double-clicking with mouse, 137
DPI (dots per inch), 62
dragging objects with mouse, 137
draw programs, 62-63, 99
drawing marquees with mouse, 136-137
drives, 48
duplicating
existing files from desktop, 63
files from within an application, 78

e
E-Mail (Electronic Mail), 65
Edit Copy command, 38
editing icons with ResEdit, 172-173
ejecting floppy disks, 12-13, 64-65, 200
Electronic Mail (E-Mail), 65
emptying Trash, 50, 78, 200
System 7, 230
Encapsulated PostScript files (EPS), 29
erasing
desk accessories, 90
disks, 66
fonts, 90
items from a folder, 86
error messages, 67
Excel Version 2.2 quick keys, 269-270
Express INIT program, 109
external modems, 132
f
fields, 48
file servers, 8
FileMaker Pro Version 1.0 quick keys, 270-272
files
attaching comments, 97
compressing, 67-68
copying, 11
from desktop, 63, 77
from one disk to another, 76-77
from one folder to another, 77
from within an application, 78
creating, 72-73
within applications, 73
deleting, 49-50, 78, 199
multiple, 199-200
duplicating
from desktop, 63, 77
from within an application, 78
finding, 81-82
System 7, 231-232
formats, 68-69
opening, 71-72
saving, 72
getting info, 79
labels (System 7), 239
locking, 78-97, 120
moving from one folder to another, 76
names, recovering, 79
opening
from desktop, 74, 147
from within applications, 147-148
System 7, 241
placing on the desktop, 79
printing, 75
from desktop, 75
from within applications, 75
recovering names, 79
renaming
from desktop, 76
from within applications, 76
retrieving from Trash Can, 200
saving, 74, 174
saving as, 80, 175-176
to another disk, 75, 175
to another folder, 74
to folders, 175
screen dumps, 160-161
searching, 82
storing on desktop, 209
troubleshooting, 205
unlocking, 98, 121
viewing, 78, 97, 208-209
System 7, 244-246
FileShare (System 7), 230-231
financial programs, 80-81
Find File desk accessory, 81
Finder, 83
installing, 195-196
mounting, 84
System 7, 233
version numbers, 195
finding files, 81-82
System 7, 231-232
Fkeys, 84
predefined, 84-85
floppy disks, 58, 60-61
backing up, 12-13
hard disks, 11
drives, 58
ejecting, 64-65, 200
initializing, 106-108
inserting, 110-111
locking, 120
reinitializing, 108
troubleshooting, 204-205
unlocking, 120
folders, 85-86
attaching comments, 97
copying files from one folder to
another, 77
deleting, 199
multiple, 199-200
locking, 97
moving, 86
new, 86
opening, 86
placing items in, 86
renaming, 87
saving files to, 74, 175
System 7, 233-234
creating new, 234
renaming, 234-235
unlocking, 98
viewing, 97
Font/DA Mover utility, 87
fonts, 9, 91
bit-mapped, 9, 92-93
changing, 94
size, 94
styles, 94
installing, 87-88
System 7, 235
jaggies, 93
outline, 93
picas, 91
points, 91
removing, 90
screen, 92
System 7, 243-244
type size, 91
viewing, 116-117, 189-190
formatting disks, 106-108
freezing, 42

games, 95-96
Get Info box, 96
graphics
 copying, 38
file formats, 69
programs, 62-63, 98-99
hard disks, 58, 60-61
backing up to floppy disks, 11
drives, 58
installing software, 112-113
installing System 7, 237-238
troubleshooting, 202-204
hardware
 buying, 18-19
 mail order, 127-128
modems, 132-133
maintenance, 128-129
monitors, 133-134
mouse, 134-139
peripherals, 153-154
requirements
 memory, 166
MultiFinder, 140
System 7, 218-219
Index

restarting Macs, 173, 185-186
SCSI devices, 182-183
shutting down Macs, 165
SIMMs, 186-188
telecommunications, 197-198
upgrading, 207
virtual memory, 210-211
heap, 44
help, 99
context-sensitive, 99-100
System 7, 236-237
highlighting text, 101-103
hue, 35-36
HyperCard, 103-104

I

IAC (System 7), 237
icons, 104-105
aligning, 210
editing with ResEdit, 172-173
Image Grabber INIT program, 109
ImageWriter printers, 105, 106
printing active window, 160
printing screen to, 160
initializing disks, 106-108
INITs, 108-109
deactivating, 110
installing, 109-112
System 7, 230
ink jet printers, 158
inserting disks, 110-111
installing
desk accessories, 52-53, 87-89, 111-112
System 7, 235
Finder, 195-196
fonts, 87-88
System 7, 235
INITs, 109-112
SIMMs, 187
software, 111-112
on hard disks, 112-113
System software, 195-196
System 7, 237-238
internal modems, 132
Isobar, 138-139

J

jaggies, 93

K

Key Caps desk accessory
viewing fonts, 116-117
viewing special characters, 189-190
keyboards, 24, 114-116
highlighting text, 103
keyboard shortcuts, 115-116
all applications, 268
Excel Version 2.2, 269-270
FileMaker Pro Version 1.0, 270-272
MacDraw II Version 1.1, 273-274
Microsoft Word Version 4.0, 278-280
PageMaker Version 4.0, 274-277
special characters, 249-267
SuperPaint Version 2.0, 277-278
labels (System 7), 239
landscape orientation, 148-150
laser printers, 158
LaserWriter printers, 118
printing screen to, 161
launching applications, 119-120
from desktop, 147
from Multifinder, 141
Layout Manager (System 7), 240
letter-quality printers, 105-106
local area networks
see networks
locking
files, 78-97, 120
deleting locked files, 50
floppy disks, 120
folders, 97
locking up, 42

M

Mac Tools Deluxe utility programs, 170
MacDraw II Version 1.1, 273-274
macros, 126-127
Macintosh computers
choosing, 18-19
Mac Classic, 125
converting DOS files into Mac files, 48
Mac II, 122
Mac IICi, 125
Mac IICx, 124
Mac IIfx, 125
Mac IIci, 126
Mac IIx, 122
Mac LC, 125-126
Mac Plus, 121
Mac Portable, 124
Mac SE, 121
Mac SE/30, 122-124
maintenance, 18-19
peripherals, 18-19
shopping for, 18-19
upgrading, 18-19
mail, electronic, 65
mail order
buying hardware, 127-128
buying software, 127-128
maintenance, 18-19
hardware, 128-129
mouse, 138
margins, aligning, 6
marquee, drawing with mouse, 136-137
memory, 44-45, 165
allocation for MultiFinder, 142
PMMU (Paged Memory Management Unit), 154
RAM cache, 167-168
setting, 168-169
requirements, 166
SIMMs, 186-188
virtual, 154, 210-211
System 7, 246-247
menus, 129-130
changing blinking rate, 37
moving between, 130-131
selecting commands, 130
messages, 18
Microsoft Excel Version 2.2 quick keys, 269-270
Microsoft Word Version 4.0 quick keys, 278-280
modems, 18, 132-133, 197-198
buying, 132-133
monitors, 24, 133-134
color, 24
monochrome, 133-134
switching from color to black and white, 35
monkey screech sound, 17
monochrome monitors, 133-134
mouse, 24, 134
cleaning, 138
deselecting objects, 136-137
double-clicking, 137
dragging objects, 137
drawing marquees, 136-137
Isobar, 138-139
mouse pads, 139
optical mouse, 138-139
pointing to objects, 135
repeat rate, 137-138
selecting objects, 136
multiple objects, 136
shift-clicking, 136
trackballs, 138-139
tracking rate, 137-138
moving
between menus, 214
calculator computed value, 23
files from one folder to another, 76
folders, 86
windows, 214
MultiFinder INIT program, 109
MultiFinder, 143
activating, 140
disabling temporarily, 143
hardware requirements, 140
launching applications on startup, 141
memory allocation, 142
opening documents automatically, 141
switching applications, 140-141
System 7, 240

networking, 8, 144
Norton Utilities for the Macintosh utility program, 170-171
Note Pad desk accessory, 144-145
removing text, 145
replacing text, 145
turning pages, 145

OCR (Optical Character Recognition), 146
opening
documents automatically with MultiFinder, 141
files
from desktop, 147
with applications, 147-148
file formats, 71-72
folders, 86
windows, 33, 214
operating systems
see System
Optical Character Recognition (OCR), 146
scanning, 176-177
optical mouse, 138-139
orientation, 148-150
outline fonts, 92-93

page orientation, 148-150
Page Setup command, 149-151
Paged Memory Management Unit (PMMU), 154
Index

PageMaker Version 4.0 quick keys, 274-277
paint programs, 98
paper sizes, 151-152
parameter RAM (PRAM), 14
pasting, 39, 46-47
  items from Scrapbook, 178
text, 152-155
  from Clipboard, 153
  from the Scrapbook, 153
  into the Scrapbook, 153
peripherals, 18-19, 154
Personal LaserWriter NT printer, 119
Personal LaserWriter SC printer, 118
picas, 91
placing
  files, 79
  items in folders, 86
PMMU (Paged Memory Management Unit), 154
pointing to objects with mouse, 135
points, 91
portrait orientation, 148-150
PostScript, 155
  see also fonts
  Encapsulated PostScript (EPS)
  files, 29
  fonts, 10, 92
  printers, 155
PRAM (parameter RAM), 14
predefined keys, 84-85
Print Monitor program, 156
printers
  changing, 27
dot matrix, 157
  ImageWriter, 105-106
  ImageWriter LQ, 105-106
ink jet, 158
laser, 158
LaserWriter IINT, 118
LaserWriter IINTX, 118
LaserWriter SC, 118
letter-quality, 105-106
  page orientation, 148-150
  paper size, 151-152
Personal LaserWriter NT, 119
Personal LaserWriter SC, 118
PostScript, 155
printer drivers, 158-159
QuickDraw, 163-164
  selecting, 27, 159
test pages, 161
troubleshooting, 161-162, 205-206
printing
  active window, 160
cancelling, 160
directories, 161
files from desktop, 75
files from within an application, 75
from an application, 159-160
from desktop, 160
list of files, 161
multiple files, 75
Page Setup command, 149-151
paper size, 151-152
Print Monitor, 156
print screen
  ImageWriter, 160
  LaserWriter, 161
print spooler, 156-157
printer drivers, 158-159
QuickDraw, 163-164
screen dump files, 160-161, 179
selecting printers, 159
troubleshooting, 161-162
Programmer’s Switch, 45, 163
programs
draw, 62-63, 99
financial, 80-81
graphics, 62-63, 98-99
paint, 98
Pyro! INIT program, 180

Q

quick keys
  all applications, 268
Excel Version 2.2, 269-270
FileMaker Pro Version 1.0, 270-272
MacDraw II Version 1.1, 273-274
Microsoft Word Version 4.0, 278-280
PageMaker Version 4.0, 274-277
special characters, 249-267
SuperPaint Version 2.0, 277-278
QuickDraw, 163-164
System 7, 241-242
quitting applications, 165

R

RAM (Random Access Memory), 44-45, 165
allocation for MultiFinder, 142
PMMU (Paged Memory Management Unit), 154
RAM cache, 167-168
setting, 168-169
requirements, 166
SIMMs, 186-188
virtual memory, 154, 210-211
System 7, 246-247
rebuilding
desktop files, 54
desktop, 169-170
records, 48
recovering
data, 170-171
file names, 79
reinitializing disks, 108
removing
desk accessories, 90
fonts, 90
items from a folder, 86
text from Note Pad desk accessory, 145
renaming
files from desktop, 76
files within an application, 76
folders, 87
System 7, 234-235
repeat rate (mouse), 137-138
replacing
batteries, 15-16
text with Note Pad desk accessory, 145
ResEdit program, 171-173
editing icons, 172-173
resizing windows, 214
resolution, 62
restarting Macs, 173
setting startup, 184-185
retrieving files from Trash can, 200
scrolling, 181-182
scroll bars, 181-182
scroll box, 181-182
windows, 214
SCSI (Small Computer System Interface) devices, 182-183
searching and replacing text, 183-184
searching for files, 82
System 7, 231-232
selecting
commands from menus, 130
defaults in alert boxes, 6
from Control Panel, 17
printers, 27-28, 159
objects with mouse, 136
multiple objects, 136
Set Startup, 184-185
setting alarm clock, 4-5, 32
shift-clicking with mouse, 136
shutting down Mac, 165, 185-186
Silicon Beach Software SuperPaint
Version 2.0 quick keys, 277-278
SIMMs (Single In-Line Memory Modules), 186-188
installing, 187
speed, 186
size box, 188
Small Computer System Interface (SCSI) device, 182-183
software
buying, 20-21
database programs, 20-21
desktop publishing, 20-21
financial programs, 20-21
installing, 111-112
launching applications, 119-120
locking, 120
OCR, 146
Print Monitor, 156
spreadsheets, 192-193
System, 194-195
version numbers, 195
telecommunications, 197-198
trojan horse programs, 211-213
unlocking, 121
utility programs, 20-21, 208
viruses, 211-213
word processing programs, 20-21, 215
sounds
beep, 17
boing, 17
clink-clank, 17
monkey screech, 17
saturation, 35-36
saving files, 74, 174
file formats, 71
saving as, 80, 175-176
to another disk, 75, 175
to folders, 74, 175
scanners, 176-177
OCR, 146
Scrapbook desk accessory, 177-179
deleting items, 178-179
pasting items from, 178
pasting text from, 153
pasting text into, 153
storing items, 178
screen dumps, 160-161
printing, 179
saving, 179
System 7, 242-243
screen fonts, 92
screen saver programs, 180
After Dark, 180
Pyrol!, 180
source disks, 12-14
speaker volume bar, 17
special characters, 189
quick keys, 249-267
viewing, 189-190
spooler (printing), 156-157
spreadsheet programs, 192-193
startup, 24
screen, 193-194
setting, 184-185
storing
files on desktop, 209
items in Scrapbook, 178
SUM II utility programs, 170
SuperClock INIT program, 109
SuperPaint Version 2.0 quick keys, 277-278
switching applications with
MultiFinder, 140-141
System, 194-195
installing, 195-196
multiple Systems, 196
version numbers, 195
System 7
aliases, 223-224
Apple menu, 224
AppleScript programming
language, 225
CDEV's, 225-226
compared to System 6, 220-222
Control Panels, 226-228
Database Access Manager, 228
desk accessories, 228-229
FileShare, 230-231
Finder, 233
finding files, 231-232
folders, 233-234
creating new, 234
renaming, 234-235
fonts, 243-244
hardware requirements, 218-220
help, 236-237
IAC, 237
INITs, 230
installing, 237-238
desk accessories, 235/fonts, 235
labels, 239
Layout Manager, 240
MultiFinder, 240
new features, 217-218
opening files, 241
QuickDraw, 241-242
screen dumps, 242-243
System Folder, 243
Trash Can, 230
TrueType, 243-244
viewing files, 244-246
virtual memory, 246-247
systems
crash, 42
crashes, 43-45
heap, 44
T

tall orientation, 148-150
telecommunications, 197-198
modems, 132-133
text
centering, 25-26
copying, 38
cutting and pasting, 152-153
deleting, 40-41
formats, 70
highlighting, 101-103
searching and replacing, 183-184
uncentering, 26
time setting, 14
trackballs, 138-139
tracking rate (mouse), 137-138
training, 19
Trash Can, 13, 198-199
deleting files, 199
multiple files, 199-200
deleting folders, 199
multiple folders, 199-200
ejecting floppy disks, 200
ejecting, 49-50, 78, 200
retrieving files, 200
System 7, 230
trojan horse programs, 211-213
troubleshooting, 19, 201
applications, 205
floppy disks, 204-205
hard disks, 202-204
lost files, 205
printers, 161-162, 205-206
TrueType (System 7), 243-244
Type Reunion INIT program, 109
typographical errors, correcting, 40
U

undoing operations, 206-207
unlocking
files, 98, 121
floppy disks, 120
folders, 98
upgrading Macs, 18-19, 207
utility programs, 208
v

version numbers, 195
viewing
  Clipboard, 153
  files, 97, 208-209
  folders, 97
  fonts, 189-190
    Key Caps desk accessory, 116-117
  list of files, 78
  special characters, 189-190
  Virex INIT program, 109
  virtual memory, 154, 210-211
    System 7, 246-247
  viruses, 211-213
  volume, 16, 24
  volume bar, 17

w

warranties, 16, 19
wide orientation, 148-150
windows
  activating, 214
  closing, 33-34, 214
  moving, 214
  opening, 33-34, 214
  resizing, 214
  scrolling, 214
  size box, 188
  Zoom box, 216
word processing programs, 215
Word Version 4.0 quick keys, 278-280

z

Zoom box, 216
THE LITTLE MAC BOOK

Gain instant access to all important Macintosh fundamentals with The Little Mac Book from Que! Compact and easy-to-use, this guide is the perfect Macintosh companion. You'll also find keyboard shortcuts, a look at System 7, and an alphabetical glossary of Macintosh terms!

Regardless of which Macintosh computer you use, The Little Mac Book is the perfect portable resource for:

- Step-by-step procedures for common tasks
- Timesaving keyboard shortcuts
- Improving Macintosh skills

Put Macintosh information at your fingertips with The Little Mac Book from Que!

Features
alphabetical topic listings for quick learning!

1262
$12.95 USA
$16.95 CAN
£11.95 U.K.

INFO CENTER
BEG  INT  ADV
HOW TO REFERENCE
IBM COMPATIBLE MAC
HARDWARE
COVERS ALL MAC MODELS